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CHAPTER 1

Introduction

Cisco Application-Oriented Network (AON) is a technology foundation for a new class of Cisco
products that embed intelligence into the network to better meet the needs of application deployment.
AON complements existing networking technologies by providing a greater degree of awareness of what
information is flowing within the network and helping customers to:

e Integrate disparate applications by routing information to the appropriate destination, in the format
expected by that destination

e Enforce security policies for information access and exchange

e Optimize the flow of application traffic, both in terms of network bandwidth and processing
overheads

e Provide increased manageability of information flow, including monitoring and metering of
information flow for both business and infrastructure purposes

AON provides this enhanced support by understanding more about the content and context of
information flow. As such, AON works primarily at the message-level rather than at the packet level.
Typically, an AON node terminates a TCP connection to inspect the full message, including the
“payload” and all headers. AON also understands and assists with popular application-level protocols
such as HTTP, IMS, and other de facto standards.

This chapter introduces the concepts necessary for configuring and administering an
application-oriented network. It includes the following topics:

e AON Devices, page 1-1
e AON Features, page 1-3
e AON Setup Summary, page 1-4

AON Devices

An application-oriented network consists of the following devices:
e Management Tools
e Nodes

e Other Entities
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Management Tools

Nodes

Other Entities

AON Management Console (AMC)

AMC is the tool that enables centralized management of the application-oriented network. This includes:
¢ Configuring, managing, and monitoring AON nodes
¢ Deploying global and node-level properties

e Managing certificates and keypairs

AON Development Studio (ADS)

ADS is the tool for developers to create message-level logic using a graphical user interface (GUI). ADS
provides a set of preconfigured functions, called Bladelets, that are used to construct Policy Execution
Plans (PEP). Additionally, ADS includes functionality that enables developers to upload custom
Bladelets to perform business functions unique to different environments.

AON Services Modules on Catalyst 6500 Series Switches

This is the AON form factor available as a single-slot services module for the Catalyst 6500 Series
Switches. Typically this node is used in a data center.

AON Network Modules on Cisco 2600, Cisco 2800, Cisco 3700, and Cisco 3800 Series Routers

This is the AON form factor available as a single-slot network module for several different Cisco
modular access routers. Typically this type of node is used in a branch office. See Release Notes for
Cisco Application-Oriented Networking for a detailed list of supported router platforms.

Depending on the configuration of your network and the needs of your business, your
application-oriented network may include any of the following devices:

Database

When a database policy is configured, AON can store specified data in a Sybase or Oracle database.

LDAP server

Can be used to perform user authentication for both the AMC application and on individual messages
traversing the application-oriented network.

Java Messaging Service (JMS)
AON devices can be configured to exchange messages between clients and JMS queues.

AON Installation and Administration Guide
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AON Features W

AON Features

Explicit and Transparent Interception

An AON node resides in the network as an inline application-aware device. The device acts as an
intelligent intermediary gateway that can either be explicitly addressed by applications or as a
passthrough proxy that is transparent to applications.

Access Methods and Adapters

AON understands various application access methods and provides adapters that can natively interface
with the protocols. The key protocols that AON supports include:

e HTTP v1.0/vl.1 and HTTPS
e MQ Native Adapter
e JMS
Additionally, custom protocols are supported through the AON software development kit (SDK).

Protocol Translation

AON nodes can act as protocol gateways between multiple applications—an example of this would be
the node receiving an application message through JMS and sending the same message to another
application as an HTTP post.

Transformation

AON supports both XML and non-XML transformation through an open transformation architecture.
AON an XSLT based transformation engine. You can add your own Java transformation engine to
execute custom transformations.

Security

AON provides a series of intelligent services which enable message-level access and control to meet
application security needs within the network. These security services include authentication,
authorization, nonrepudiation, data integrity, data confidentiality, and centralized key management.

Service Virtualization

AON has the capability to act as proxy to create an abstraction layer for endpoint applications and apply
policies across all of these services—in a centralized configuration manner with distributed enforcement
in the network. Service virtualization functionality enables customers to execute content-based routing,
workload balancing, and message distribution operations.

Schema Validation
AON provides the ability to validate XML documents against schemas you create.

Reliable Messaging

AON provides a reliable delivery semantic across all supported protocols. Based on the level of support
required, AON can ensure exactly once delivery, at least once delivery, or at most once delivery.

Optimization Services

AON has the capability to cache or compress messages to allow for optimization of message traffic, thus
enabling reduced application response time and the conservation of network bandwidth.
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External Data Access

AON provides the capabilities to access or notify other applications in parallel to handling the main
message flow. External access is currently available using HTTP and Java Database Connectivity
(JDBC).

Message Logging

AON can capture application messages for logging either synchronously for auditing purposes or
asynchronously.

AON Setup Summary

The process for implementing an application-oriented network is divided into two chapters:
e Chapter 2, “Configuring AON Devices”

This chapter describes the procedures you need to perform when you add AON devices to your
network. You will perform most of the procedures in the this chapter the first time you implement
application-oriented networking.

e Chapter 3, “Managing Nodes”

This chapter describes basics about managing nodes from AMC. You need to set up and configure
nodes during your initial AON deployment. The procedures include steps that will help you ensure
that your installation of AMC and AON devices is functioning properly.

This section summarizes the procedures detailed in these chapters:

1. Install all switches, routers, and related AON modules and ensure they are configured for basic IP
networking. Refer to documentation related to your switch or router for detailed configuration
instructions.

2. Establish a relationship with a well-known certificate authority and generate a Java keystore. See
the “Generating a Java Keystore” section on page 2-1.

3. Install AMC on a Linux server. See the “Getting Started with AMC” section on page 2-1.

4. Configure AON nodes to register with AMC. See the “Performing Initial Node Configurations”
section on page 2-7.

5. Install the AON Development Studio (ADS) on a Windows PC. See the AON Development Studio
User Guide for detailed installation instructions.

Advanced AON Configuration

Depending on the requirements of your applications and network, you may need to:

e Configure nodes. See Chapter 3, “Working with Nodes” to create and configure nodes and to
configure virtual clusters and WCCP. This chapter covers node deployment and node monitoring.

¢ Configure properties. See Chapter 4, “Managing AON Properties” to configure global- and
node-level properties.

¢ Configure security. See Chapter 5, “Managing AON Security” to configure and manage
security-related features in AON.

AON Installation and Administration Guide
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CHAPTER

Configuring AON Devices

This chapter includes the following sections:
e Getting Started with AMC, page 2-1

e Performing Initial Node Configurations, page 2-7

Getting Started with AMC

This section describes how to install the AON Management Console (AMC). It includes the following
sections:

e Generating a Java Keystore, page 2-1 (required)
¢ Installing and Upgrading AMC, page 2-4 (required)
e Stopping, Starting, and Restarting the AMC Daemon, page 2-6 (optional)

Generating a Java Keystore

Step 1

Before installing or upgrading AMC, you must obtain a certificate. This certificate must be in the form
of a Java Keystore (.jks) file and be compatible with JDK 1.4.2 or later release. Additionally, AMC
accepts only the well-known certificate authorities included in the Java Runtime Environment (JRE) 1.4
truststore.

Prerequisite

e Install the Java Runtime Environment and add the /bin directory to your path.

To generate the key type the following on the command line of a Linux workstation:

[root@linux opt]# keytool -genkey -alias <name> -keyalg <algorithm> -keysize <size>
-validity <days> -keystore <filename> -storepass <password>

This command requires you to provide the following variables:

— name = Select an alias name for your keystore.

algorithm = Specify either RSA or DSA. We recommend that you use RSA.

size = Specify the size of the key in bits. This value must be a multiple of 64 between 512 and
1024.

days = Specify the number of days your key will be valid.
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Step 2

Note

Step 3

Note

- filename = Specify the location and filename where you want your keystore file to be generated.
- password = Specify he password used to protect your keystore file.

The following is a sample entry using the above variables:
[root@linux]# keytool -genkey -alias test -keyalg rsa -keysize 512 -validity 365

-keystore teststore -storepass password

After pressing RETURN, you are prompted for information related to your organization and location.
Enter the appropriate data. The values that follow are for illustrative purposes only:

When prompted for your first and last name, enter the hostname for the server on which AMC is to be
installed.

What is your first and last name?
[Unknown]: aon.hostname.com
What is the name of your organizational unit?
[Unknown]: Application-Oriented Networking
What is the name of your organization?
[Unknown]: Cisco Systems
What is the name of your City or Locality?
[Unknown]: San Jose
What is the name of your State or Province?
[Unknown]: California
What is the two-letter country code for this unit?
[Unknown]: US
Is CN=aon.hostname.com, OU=Application-Oriented Networking, 0O=Cisco Systems, L=San Jose,
ST=CA, C=US correct?
[no]: yes
Enter key password for <test>
(RETURN if same as keystore password) :

Enter the following command to view the details of your keypair.

[root@linux opt]l# ./keytool -list -v -keystore teststore -storepass password
Keystore type: jks
Keystore provider: SUN

Your keystore contains 1 entry

Alias name: test
Creation date: April 20, 2005
Entry type: keyEntry
Certificate chain length: 1
Certificatel[l]:
Owner: CN=aon.hostname.com, OU=Application-Oriented Networking, 0O=Cisco Systems, L=San
Jose, ST=California, C=US
Issuer: CN=aon.hostname.com, OU=Application-Oriented Networking, O=Cisco Systems, L=San
Jose, ST=California, C=US
Serial number: 42768483
Valid from: Mon May 02 12:50:27 PDT 2005 until: Tue May 02 12:50:27 PDT 2006
Certificate fingerprints:
MD5: 8E:C8:62:5F:30:3F:DE:47:80:75:9A:84:6D:B6:0E:EF
SHAl: 28:0E:76:86:13:EC:B0:8D:B0:1E:73:A4:7D:87:D0:0F:55:81:E5:63

At this point, you do not have a keystore file with your keypair. Your keypair contains a self-signed
certificate, which cannot be used with AMC until it is registered with a certificate authority.

AON Installation and Administration Guide
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Step4  Generate a certificate signing request (CSR) for your keypair by entering the following command:
[root@linux]# keytool -certreq -v -alias <alias_name> -file <outputfile> -keystore
<keystore> -storepass <storepassword>
This command requires you to provide the following variables:

— <alias_name> = The alias you created in Step 1.

— <file> = The name of the file where the CSR is to be stored.

— <keystore> = The name of the keystore file you created in Step 1.
— <storepassword> = The password for the keystore file.

[root@linux]# keytool -certreq -v -alias test -file testcert -keystore teststore
-storepass password

Certification request stored in file <testcert>

Submit this to your CA

Step5  Submit the CSR file (testcert in the above example) to your certificate authority. On successful
submission, the CA will provide you with a .cer file that contains your production certificate.

Step6  Import the .cer file from your CA into the keystore created in Step 1.

[root@linux]# keytool -import -v -alias <alias> -file <cer file> -keystore <keystore_file>
-storepass <keystore_password>

This command requires you to provide the following variables:
— <alias> = Alias created in Step 1.
— <cer_file> = Path to the .cer file you received from CA.
— <keystore_file> = keystore file created in Step 1.
— <keystore_password> = The keystore password.

After you enter this command, information similar to the following is displayed:

Owner: CN=aon.hostname.com, OU=Application-Oriented Networking, O=Cisco Systems, L=San
Jose, ST=California, C=US

Issuer: OU=Secure Server Certification Authority, O="RSA Data Security, Inc.", C=US
Serial number: 3a7a57a56046cce564ce7cc500995b21

Valid from: Sun Feb 06 16:00:00 PST 2005 until: Tue Feb 07 15:59:59 PST 2006
Certificate fingerprints:

MD5: 8E:C8:62:5F:30:3F:DE:47:80:75:9A:84:6D:B6:0E:EF

SHAl: 28:0E:76:86:13:EC:B0:8D:B0:1E:73:A4:7D:87:D0:0F:55:81:E5:63

Trust this certificate? [nol: yes

Certificate was added to keystore

[Saving ./CreateKeystore/teststore.jks]

Note  Note the name and location of the .jks file. You will need it each time you install or upgrade AMC.

AON Installation and Administration Guide
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Installing and Upgrading AMC

Cisco distributes the AMC application in two formats, a package that installs a fresh copy of AMC, and
a package that upgrades an AMC but preserves the existing database of nodes, properties, logs, and other
settings. The instructions that follow assume installation in the /opt/amec directory. However, you can
install AMC in any directory of your choosing.

Requirements
¢ You must install AMC on a local disk. AMC cannot run on a network file system.

¢ You must obtain a certificate from a certificate authority before installing or upgrading AMC. The
keystore information must be in the Java Keystore format with a .jks extension. See the “Generating
a Java Keystore” section on page 2-1 for instructions. AMC accepts only the well-known certificate
authorities included in the Java Runtime Environment (JRE) 1.4 truststore.

e It is possible to install multiple instances of AMC on a single server if each AMC uses a unique set
of TCP ports. We recommend that this be done only in testing or training environments. A given
node cannot be managed by more than one AMC, and We recommend that a production AON
include no more than one AMC.

e If you are upgrading AMC, be sure to deactivate any active nodes.
¢ You must have root-level permission on the server on which AMC is to be installed.

A

Caution  If you are upgrading AMC, be sure to read the latest AON Release Note before running the upgrade
package. The new release note may contain critical upgrade procedures beyond those described below.
Failure to follow the procedure described in the release note may result in data loss or corruption.

Step 1 Download the installation file and use the chmod command to make it executable.

[root@linux opt]# chmod +x aon-amc_<version>_lnx.bin

Step2  Execute the installer.
[root@linux opt]# ./aon-amc_<version>_lnx.bin

Preparing to install...

Step3  Enter the directory in which AMC is to be installed. The /opt/amc directory is the default, although any
directory is acceptable.

Enter the directory to install the AMC to [/opt/amc]:
Directory "/opt/amc" does not exist - create? [y|n]:y
Extracting archive.

Configuring paths.

Configuring the ports that the AMC will listen on

If you are installing more than one AMC, these values
must be unique to each installation.

Step4  Enter the port on which AMC will listen for HTTP requests. 7015 is the default.

Enter a port for http [7015]:7015

Step5  Enter the port on which AMC will listen for HTTPS requests. 7010 is the default.

Enter a port for https [7010]:7010

Step6  Enter the port on which AMC will listen for traffic from nodes. 7011 is the default.

Enter a port for communication with AON nodes [7011]:7011

AON Installation and Administration Guide
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Step 7

Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

Step 14

Getting Started with AMC

Enter the port on which AMC will listen for shutdown signals. 7025 is the default.

Enter a port for server shutdown signals [7025]:7025

Enter the port on which AMC will listen for database transactions. 2638 is the default.

Enter a port for the database [2638]:2638

Enter the logging level to be used while AMC runs.

Enter AMC logging level (DEBUG |INFO|WARN|ERROR|FATAL) [INFO]:error

AMC can use one of the following log levels:

- DEBUG—Logs explicit debug messages, plus informational, warning, error, and fatal
messages.

- INFO—Logs informational messages, plus warning, error, and fatal messages.
- WARN—Logs warning messages, plus error and fatal messages.
- ERROR—Logs error messages and fatal messages.

— FATAL—Logs only fatal messages.

~

Note In production environments, we recommend that only ERROR or FATAL log levels be used.
More verbose log levels can have an adverse affect on the performance of AMC.

Enter the size of the log file in kilobytes. When the log size is exceeded, AMC saves it as a backup and
generates a new log file.

Enter log file rollover threshold size (KB) [1024]1:1024

Enter the number of backup logs to keep. When the number of backup logs is exceeded, AMC discards
the oldest file.

Enter number of backup logs to keep [5]:5

AMC uses a keystore file for communication with AON nodes. Enter the path and filename for this
keystore.

The AMC requires a keystore file and password
to communicate with the AON node.
Enter the path to the keystore file:/root/amcKeystore.test.cisco.com.jks

~

Note  The path to amcKeystore shown above is for illustrative purposes. You must provide the path to
an actual Java keystore in order to complete the installation.

If the keystore file has multiple keypairs, enter the name for the pair you want to use.

You may optionally enter a keyname within the keystore.
Enter a keyname, otherwise enter none [none]:none

Enter the password associated with the keystore.

Enter a password for this keystore:
AMC_HOME is /opt/amc and /opt/amc

Using existing ciscoamc group

Using existing ciscoamc user

Setting permissions for AMC installation
Configuring AMC service to start at boot...
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Step15 Enter y to start AMC now or n to start it later.

Would you like to run the AMC now? [y|n]:y

Starting AMC Database...Done.

Starting AMC...Done.

Installation successful.

To uninstall, run '/opt/amc/bin/amcSetup uninstall'.

Step16 Use a Web browser to navigate to the AMC log-in page to confirm that the installation was successful.
The URL is https://hostname:7010/amc. Replace hostname in this URL with the name or IP address for
the server running AMC.

Note  For best results, we recommend you use Microsoft Internet Explorer 6 or later with AMC.

Figure 2-1 shows the AMC log-in page.

Figure 2-1 AON Management Console Log-on Screen

Gisco Sysvems

ON Management Console

Log on

Username: |aonsadmin

Password: I*********

Log on using: IAMCLDcaI j

Submit

S

Note  The default user name and password are aonsadmin.

Stopping, Starting, and Restarting the AMC Daemon

During the installation process, the AMC daemon (amcd) is configured to run when the server on which
it is installed starts up, and it stops when the server is shut down. You might, however, have need to stop,
start or restart the AMC daemon independently of the server. The examples that follow show how to do
this.

Example 2-1  Shutting Down AMC

[root@linux]# /opt/amc/bin/amcd stop
Stopping AMC...waiting for services to complete...Done.
Stopping AMC Database...Done.

AON Installation and Administration Guide
| 26 | |



| Chapter2 Configuring AON Devices

Performing Initial Node Configurations

Example 2-2  Starting AMC

[root@linux]# /opt/amc/bin/amcd start
Starting AMC Database...Done.
Starting AMC...Done.

Example 2-3 Restarting AMC

[root@linux]# /opt/amc/bin/amcd restart

Stopping AMC...waiting for services to complete...Done.
Stopping AMC Database...Done.

Starting AMC Database...Done.

Starting AMC...Done.

Performing Initial Node Configurations

A

AON nodes have no direct console access, so the first configuration task for an AON service module

(AON-SM) or AON network module (AON-NM) is to define IP address and subnet masks for the AON

interface. See the following sections for configuration tasks for AON nodes. Each task in the list is
identified as either required or optional.

e Configuration Prerequisites, page 2-7 (required)

¢ Configuring a Cisco 8300 Series AON Appliance, page 2-8 (required)

¢ Configuring Networking Parameters on a Catalyst 6500 Series Switch, page 2-10 (required)
e Configuring Network Parameters on a Cisco Modular Access Router, page 2-12 (required)
e Configuring Nodes to Use SSH, page 2-13 (optional)

e Configuring Nodes to Register with the AMC, page 2-14 (required)

e Upgrading Nodes, page 2-15 (optional)

Caution

AON modules do not support online insertion and removal. Always power off the router or switch before

inserting or removing a module.

Configuration Prerequisites

This guide assumes that your switch, router, or AON appliance is properly installed. Additionally,

switches and routers that will house AON nodes must be configured for basic IP communications and

have their AON modules installed. See the following platform documentation if necessary:
e Cisco 8300 Series AON Appliance Hardware Installation Guide
http://1bj.cisco.com/targets/ucdit/cc/td/doc/product/aon/aonmod/8300/8300hig/index.htm
e (Catalyst 6500 Series Switch Installation Guide
http://www.cisco.com/univercd/cc/td/doc/product/lan/cat6000/6000hw/inst_aug/index.htm
e (Catalyst 6500 Series Switch Module Installation Guide
http://www.cisco.com/univercd/cc/td/doc/product/lan/cat6000/6000hw/mod_inst/index.htm

¢ Cisco Modular Access Routers
http://www.cisco.com/univercd/cc/td/doc/product/access/acs_mod/index.htm
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e (Cisco Network Modules Hardware Installation Guide
http://www.cisco.com/univercd/cc/td/doc/product/access/acs_mod/cis2600/hw_inst/nm_inst/nm-d
oc/index.htm

Configuring a Cisco 8300 Series AON Appliance

A Cisco 8300 AON Appliance arrives from the factory with AON software preinstalled. In order to
configure an appliance, you must connect a terminal server to the serial port on the rear of the appliance.
For instructions on connecting a terminal server, see the Cisco 8300 Series AON Appliance Hardware
Installation Guide. This section includes the following topics:

¢ Configuring Networking Parameters, page 2-8

e Disabling Cisco Discovery Protocol, page 2-9

Configuring Networking Parameters

Perform the following steps to configure networking parameters:

Step1  With your terminal server connected, power on the appliance and allow it to boot. When the appliance
is ready for configuration, a Password : prompt is displayed. Enter the default password of aonsadmin.

Welcome to Cisco AON Engine
(Version: 1.1.0.189)

Fri Nov 4 03:24:41 PST 2005
AON boot: hit RETURN to set boot flags: 0002

Available boot flags (enter the sum of the desired flags):
0x0000 - exit this menu and continue booting normally
0x2000 - disable login security

[AON boot - enter bootflags (type '-' to exit)]: 0x0000
You have entered boot flags = 0x0

Boot with these flags? [ves]: vy

Boot with these flags? [yes]: yes

* ok ok ok ok kkk ok ok rc.aesop Kk hkkhkhkhkhkkkhkkkkkkkxk
Setting timezone: No timezone configured
Loading Tarari Drivers...

SUCCESS: Loaded Tarari Drivers

Loading Cisco WCCP module

wcep: v1.00 (20000327), debug=0

Kernel IP routing table

Destination Gateway Genmask Flags MSS Window irtt Iface
Serial Number: 99C7523

Reading Manifest...done.

Doing Certificate Check

Certificate Check Done

INIT: Entering runlevel: 2

* ok k ok ok ok kk ok ok rc'post_install *khkhkkkhkhkkkkhkkkhkkkkx
INIT: Switching to runlevel: 4

INIT: Sending processes the TERM signal

waiting 51
Password :

Step2  Enter configuration terminal mode.
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Step 3

Note

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Step 11

Note

Step 12

Performing Initial Node Configurations W

defaulthost> configure terminal
Enter configuration commands, one per line. End with exit.

Enter interface configuration mode for Gigabit Ethernet Interface 1

defaulthost (config)> interface gigabitethernet 1

The appliance includes three gigabit ethernet connectors, however, only Gigabit Ethernet 1 is supported
in AON version 1.1.

Enter the IP address and subnet mask to be used by the appliance, then exit interface configuration mode.

defaulthost (config-interface)> ip address 192.168.56.106 255.255.255.0
WARNING!!! Changing interface IP address will disrupt connectivity and traffic!
defaulthost (config-interface)> exit

SYSTEM ONLINE

Configure the default gateway to be used by the appliance.

defaulthost (config)> ip default-gateway 192.168.56.1

Configure the domain name to be used by the appliance.

defaulthost (config)> ip domain-name cisco.com

Configure the domain name servers to be used by the appliance.

defaulthost (config)> ip name-server 192.168.168.183 192.168.226.120

Configure the NTP server to be used by the appliance.

defaulthost (config)> ntp server 192.168.156.11

Configure the hostname to be used by the appliance.

defaulthost (config)> hostname aon-appliance

Enable secure shell (SSH) access for the appliance.

aon-appliance(config)> ssh enable

Change the default password.

aon-appliance(config)> login password unencrypted mypassword

For a detailed description of SSH and login passwords, see the “Configuring Nodes to Use SSH” section
on page 2-13.

Exit configuration mode, and save the new configuration.

aon-appliance(config)> exit
aon-appliance> write memory

Disabling Cisco Discovery Protocol

Cisco Discovery Protocol (CDP) is primarily used to obtain protocol addresses of neighboring devices
and discover the platform of those devices. CDP is enabled by default, and the appliance sends CDP
Version-1 (CDPv1) advertisements. It receives both CDPv1 and CDPv2 advertisements. Example 2-4
shows CDP being disabled.
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Note

~

Note

If you do not need CDP, you should disable it.

Only the Cisco 8300 Series AON Appliance supports CDP at this time.

Example 2-4 Disabling CDP

aon-appliance> configure terminal

Enter configuration commands, one per line. End with exit.
aon-appliance(config)> no cdp run

aon-appliance(config)> exit

aon-appliance> write memory

You can use cdp run to enable CDP again if necessary.

Configuring Networking Parameters on a Catalyst 6500 Series Switch

You must configure a VLAN for the AON-SM, then assign an IP address to it. These tasks are covered

in the following sections:

e Configuring a VLAN under the Catalyst Operating System, page 2-10 (required for Catalyst

operating system)
e Configuring a VLAN under Cisco 10S, page 2-11 (required for Cisco 10S)
e Assigning IP Addresses to the AON-SM Interface, page 2-11 (required)

Configuring a VLAN under the Catalyst Operating System

Step 1

Step 2

You must configure a VLAN for the AON-SM by completing the following steps:

Create a VLAN to be used by the AON node.

Router> (enable) set wvlan 100

VTP advertisements transmitting temporarily stopped,
and will resume after the command finishes.

Vlan 100 configuration successful

Assign the VLAN to the AON node.

Router> (enable) set vlan 100 5/2
VLAN 100 modified.

VLAN 1 modified.

VLAN Mod/Ports

Vlan 100 is active.
Router> (enable)
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Configuring a VLAN under Cisco 10S

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

You must configure a VLAN for the AON-SM by completing the following steps:

Enter configuration terminal mode.

MSFC# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

Create a VLAN to be used by the AON node.

MSFC (config)# vlan 100

Make the VLAN active, then exit configuration terminal mode.

MSFC (config-vlan) #state active
MSFC (config) # exit

Assign the VLAN to the AON-SM.

MSFC (config)# AON module 6 vlan 100

Enter interface configuration mode for the VLAN.

MSFC (config)# interface vlan 100

Assign an IP address and subnet mask to the VLAN.

MSFC (config-if)# ip address 192.168.22.36 255.255.255.0

Assigning IP Addresses to the AON-SM Interface

~

Note

Step 1
Step 2

Step 3

To assign IP addresses to the AON service module running in a Catalyst 6500 series switch, perform the
following steps:

During start up, the AON-SM retrieves the system time from the switch. Ensure that NTP is configured
on the switch before you configure the AON-SM.

If this is an active node for which you are assigning a new IP address, use AMC to deactivate it.

Open a session to the AON-SM, then enter configuration terminal mode.

Router# session slot number processor number

The default escape character is Ctrl-», then x.

You can also type 'exit' at the remote prompt to end the session
Trying 127.0.0.31 ... Open

Welcome To Cisco AON Engine

aon-node> enable
aon-node# configure terminal

Select an interface to configure.

aon-node (config)# interface GigabitEthernet 2
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Note

Step 4

Step 5

Step 6

Step 7

At this time, AON supports only the GigabitEthernet 2 interface.

Specify the IP address for the interface, then exit interface configuration mode.
aon-node (config-interface) #ip address 192.168.3.11 255.255.255.0

aon-node (config-interface) #end

Specify the IP address for the default gateway, then exit configuration terminal mode.

aon-node (config) #ip default-gateway 192.168.3.1
aon-node (config) #end

Save the configuration in NVRAM.

aon-node# write memory

Proceed to the “Configuring Nodes to Register with the AMC” section on page 2-14 to continue
configuring the AON-SM.

Configuring Network Parameters on a Cisco Modular Access Router

~

Note

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

To assign IP addresses to the AON network module running in a router, perform the following steps:

During start up, the AON-NM retrieves the system time from the router. Ensure that NTP is configured
on the router before you configure the AON-NM.

If this is an active node for which you are assigning a new IP address, use AMC to deactivate it.

Enter configuration mode for the AON network module interface.

Router (config)# interface AONS-engine 1/0

Specify that FastEthernet 0/0 interface is unnumbered.

Router (config-if)# ip unnumbered FastEthernet 0/0

Configure an IP address for the interface used by the AON network module.

Router (config-if)# service-module ip address 10.4.1.184 255.255.255.0

Specify the default gateway used by the AON network module.

Router (config-if)# service-module ip default-gateway 10.4.1.183

Bring up the AON network module interface.

Router (config-if)# no shutdown

Exit configuration mode.

Router (config-if)# exit

Configure IP routing on the router.

Router (config)# ip routing

Define a static IP route to the AON network module.
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Step 10

Step 11

Step 12
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Router (config)# ip route 10.4.1.184 255.255.255.255 AONS-Enginel/0

Define a static IP route to the default gateway.

Router (config)# ip route 0.0.0.0 0.0.0.0 10.4.1.1

Exit configuration mode.

Router (config) # exit

Save the configuration in NVRAM.

Router# write memory

Configuring Nodes to Use SSH

Step 1

Step 2

Step 3

Step 4

Note

Using the default configuration, you connect to a node’s command-line interface using telnet or a serial
interface. AON nodes running release 1.1 and later versions can be configured to use secure shell (SSH).
When SSH is used, all traffic between the node and your SSH client is encrypted. Additionally, SSH
enables users to configure a node without providing access to the switch or router command-line
interface. To configure a node to use SSH, perform the following steps:

In the node’s configuration terminal mode, use the ssh enable command to enable ssh.

aon-node (config)> ssh enable

~

Note  Until you complete Step 2, the default password to gain secure access to a node is aonsadmin.

Use the login password command to configure a password for SSH access. This command accepts either
encrypted or plaintext passwords.

¢ To enter a plain text password:

aon-node (config)> login password unencrypted cisco

e To enter an MD5 encrypted password

aon-node (config)> login password encrypted $1$7v.0l130F$xGo.LUNGt0eYXWTCZ/McQ

Exit configuration terminal mode and save the configuration.

aon-node (config)> exit
aon-node> write memory

Verify the configuration by using an SSH client to connect to the IP address assigned to the node.

[root@linux root]# ssh admin@10.4.1.92

The authenticity of host '10.4.1.92 (10.4.1.92)' can't be established.
RSA key fingerprint is 50:fa:d4:7e:46:e3:7b:2f:17:0d:e6:9f:d0:bd:1e:d5.
Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '10.4.1.92' (RSA) to the list of known hosts.
admin@10.4.1.92's password:

The only username permitted to connect to an AON node is admin.
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Configuring Nodes to Register with the AMC

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Step 9

In order to register with the AMC, the AON node must be configured with connection details for both
itself and the AMC. To complete this task, perform the following steps:

Enter configuration terminal mode on the AON node, then create an AON configuration ID. A
configuration ID can be any combination of letters and numbers.

AON-node (config)# AON config abc create

Configure the hostname or IP address of AMC. This is used by the AON node to communicate with
AMC.

AON-node (config)# AON config abc amc host 10.1.1.1

Assign an IP address to the AON management agent.

AON-node (config)# AON config abc ama host 10.1.1.2

Activate the AON configuration.

AON-node (config)# AON config abc activate

Specify a network time protocol (NTP) server that the node can use to maintain accurate time.

AON-node (config)# ntp server 10.1.1.10

Specify the domain name of the node.

AON-node (config)# ip domain-name cisco.com

Specify the DNS server to be used by the node.

AON-node (config)# ip name-server 10.1.10.10

Exit configuration terminal mode. When AON asks to restart, enter n.

AON-node (config)# exit
CAUTION!! Configuration changed. Need to restart AON.
Confirm restart[yl]l? n

Use the write memory command to save the AON configuration to nonvolatile memory, then restart
AON.

AON-node> write memory

AON-node> AON restart force

' ICAUTION!! Restarting all processes right away.
Are you sure[n]? y

Start counting down before restart

This may take a while longer...

After the AON restart is complete, the node attempts to register with the AMC. The AMC ignores these
attempts until a node with the proper credentials has been added.
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Step10 Use the show version command to obtain the module serial number (highlighted below). You need this
information when you create a new node in AMC.

AON-node> show version

CPU Model: Pentium III (Coppermine)
CPU Speed (MHz): 498.675

CPU Cache (KByte): 256

Chassis Type: C2691

Chassis Serial: 12345678901

Module Type: NM-AON-K9

Module Serial: FOC082313YY

AON: 0.0.0.409

AMA: 0.0.0.409

Step11  Use the write memory command to save the configuration

AON-node> write memory

Upgrading Nodes

Upgrade instructions are now located in the following stand-alone document:

e Upgrading to Cisco Applicaiton-Oriented Networking Version 2.1
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CHAPTER

Working with Nodes

This chapter includes the following topics
e Managing Nodes, page 3-1
e Managing Virtual Clusters, page 3-12
e Managing WCCP Servers, page 3-11
e Configuring Recovery, page 3-21
e Deploying to Nodes, page 3-22
e Viewing Logs, page 3-24
e Viewing Events, page 3-24

Managing Nodes

Nodes are the individual devices that process messages in an AON environment. After being configured
for basic network connectivity, a node must be configured to register with an AMC. On receipt of proper
credentials, the AMC assumes control of the node.

From the perspective of the AMC, nodes exist in one of the following states.

¢ Unregistered—Node created in the AMC, but no successful establishment of a trust relationship
with AMC.

¢ Registered—Node successfully established a trust relationship with AMC.

e Active—Node activated by the administrator. Active nodes are able to receive deployment requests
and process messages.

¢ Inactive—Formerly active node that has gone offline.

¢ Replaced—Node replaced by another node. During replacement, the new node assumes all
processing responsibilities of the node being replaced. Replaced nodes cannot be activated again,
nor can they be further configured by an administrator.

This section covers the following topics:
e Creating Nodes, page 3-2
e Configuring WCCP for Traffic Redirection, page 3-5
e Editing Nodes, page 3-6
e Deleting Nodes, page 3-7
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e Replacing Nodes, page 3-8
e Exporting Nodes, page 3-9

Creating Nodes

This section describes the procedure for creating a new AON node. To complete this procedure, you need
access to the command-line interface of the node you are adding, and you need administrator access to
AMC.

Prerequisites

¢ AMC must be installed and running, and you must have appropriate privileges to create network
nodes.

¢  Your node must be configured for basic IP network connectivity.

Step 1 Connect to the command-line interface of the AON node. Use the show version command to obtain the
module serial number (highlighted below).

aon-node> show version

CPU Model: Pentium III (Coppermine)

CPU Speed (MHz) : 498.675

CPU Cache (KByte): 256

Chassis Type: C2691

Chassis Serial: 12345678901

Module Type: Cisco 2600/3700/ISR AON Module (NM-AON-K9)
Module Serial: FOC082313YY

AON: 2.1.0.135

AMA: 2.1.0.135

Note the module serial number in bold text above. You will need this number to complete Step 3.

Step2 Login to AMC and go to Network > Network Nodes > Manage to load the Manage Network Nodes
page. Click the New button to load the New Network Node page, shown in Figure 3-1.

Figure 3-1 Create a Network Node
_ Metwork ] Properties T Deploy T Monitor T Keystores T Admin -
Network Nodes MNetwork = Metwork Nodes = Manage > New
M.
Tt New Network Node
Configure
Activate /Deactivate
Yirtual Clusters * Mame: I
WCCP Servers * Serial Number: I

Description:

Enable Mode Palling: € ves & yo

Agent Hostname:

Agent Port: I

Save Cancel

AON Installation and Administration Guide
[ 32 | |



| Chapter3 Working with Nodes

Managing Nodes

Step3  Complete the entries on this page as described in Table 3-1.

Table 3-1 New Network Node Entries

Entry Description

Name Name of your choosing for this node.

Serial Number Enter the serial number obtained in Step 1.

Description Optional entry.

Enable Node Enable polling when AMC a firewall is between AMC and the node. Rather than
Polling waiting for the node to contact AMC, AMC will initiate contact with the node.
Agent Hostname |Name or IP address of the node.

Agent Port Port used by node for management traffic.

Step4  Click Save to create the network node. Figure 3-2 shows the Manage Network Nodes page with the new
node in the Unregistered state. The node remains in this state until you configure the AON module to
communicate with the AMC in the next step.

Figure 3-2 Unregistered Network Node
MHetwork Properties Deploy Monitor Keystores Admin
Network Nodes Netweork = Metwork Nodes = Activate/Deactivate
Manage . .
o Activate/Deactivate Network Nodes
onfigure
» Activate /Deactivate # Mame Serial Humber State Virtual Cluster  Description
virtual Clusters 1 & aon-node FOCO823137Y Unregistered
WCLCP Servers RewsPage| 10 [EY rage[ 171 [ 4 4 b b

Activate Deactivate

Step5 In Configuration Terminal mode on the AON module, create an AON configuration. This configuration
enables the AON node to register with the AMC.

aon-node> configure terminal

Enter configuration commands, one per line. End with exit.

aon-node (config)> aon config configuration_id create

aon-node (config)> aon config configuration_id ama host module_IP_address
config)> aon config configuration_id amc host AMC IP_address
config)> aon config configuration_id activate

aon-node
aon-node
aon-node (config)> exit

CAUTION!! Configuration changed. Need to restart AONS.
Confirm restart[yl? ¥

graceful restart(yl]? n

Start counting down before restart

(
(
(
(

This may take a while longer...

Step6  After the module restarts, use the write memory command to save the configuration.

aon-node> write memory
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Step 7

"o

Step 8

Note

In your browser window, click the browser’s Reload button to refresh the Manage Network Nodes page.
The new node should now be registered, as shown in Figure 3-3.

Figure 3-3 Registered Network Node
Metwork Properties Deploy Monitor Keystores Admin
Network Nodes Netweork = Metwork Nodes = Activate/Deactivate
Manage ; ;
o Activate/Deactivate Network Nodes
onfigure
» Activate /Deactivate # Mame Serial Humber State Virtual Cluster  Description
virtual Clusters 1 & aon-node FOCO823137Y Registered
WCCP Servers RewsPage| 10 [FY rage[ 171 [ M 4P M

Activate Deactivate

If your network node remains unregistered, verify that the serial number is entered exactly as described
in Step 3. The AMC will not establish trust with a node if this information is incorrect.

Click the Activate/Deactivate link to load the Activate/Deactivate Network Nodes page, then click the
radio button for the registered node. Click the Activate button.

When the state changes to Active, as shown in Figure 3-4, the node is ready for configuration
deployment.

Figure 3-4 Activate a Network Node
Metwork Properties Deploy Monitor Keystores Admin
Network Nodes Metwork > Network Modes > Manage
* Manage
. Manage Network Nodes
onfigure
Activate /Deactivate # Mame Serial Humber State Description
i 1 @ aon-node FOCO323137Y Active
WCCP Servers RewsPage| 10 [EY rage[ 171 [ M 4Pp M
Hew Show Edit Replace Delete

You can make configuration changes to a node in the registered or unregistered state, however, you
cannot deploy those configuration changes until the node becomes active.
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Configuring WCCP for Traffic Redirection

AON nodes can be configured to use WCCP for traffic redirection. When this feature is configured, a
node can intercept messages using a specific port, then redirect them to another destination for further
processing.

How to Get There

e Go to Network > Network Nodes > Configure. Select a node, then click the WCCP for Traffic
Redirection button and click New.

Figure 3-5 shows the New WCCP Service Group page.
Figure 3-5 New WCCP Service Group

Network Properties Deploy Monitor Keystores Admin

Metwork Nodes Network = Network Nodes > Configure > WCCP for Traffic Redirection
Honage New WCCP Service Group
» Configure

Activate/Deactivate

*® o .
it Service Group ID: |51

WCCP Servers * Multicast Address: (10 .o |13 i

Authentication Password: |eesss
Confirm Authenticaticn Password: (esees
* Port Map: |80

* Listener Port: |8080

Add Servers ACLiClassifier Save Cancel

Table 3-6 shows the entries available on the New WCCP Service Group page.

Table 3-2 New WCCP Service Group Entries

Entry Description

Service Group ID Unique number for each service group. Range is 51 — 99.

Multicast address IP address to be used by members of this service group.

Authentication Password by members of this service group for authentication.

password

Port map Comma-delimited string of destination ports to be redirected.

Listener port Comma-delimited string of ports at which an adapter is listening for traffic.
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Editing Nodes

The AMC enables you to edit the name and description of any node. If a node is unregistered, you can
also change the serial number.

How to Get There
Go to Network Nodes > Manage then select a node and click the Edit button. See Figure 3-6.

Figure 3-6 Edit a Network Node
Metwork Properties Deploy Monitor Keystores Admin
Network Nodes Metwork > Network Modes > Manage > Edit
F Manage
5 Edit Network Node
onfigure

Activate /Deactivate
Yirtual Clusters * Mame: IaDn-nDde
WCCFP Servers * Serial Number: FOCO82Z313TY

Description: I

Save Cancel

Actions to Take

You can take one of the following actions:

e Make changes to the Name or Description. If a node is unregistered, you can also make changes to
the serial number.

¢ Click the Save button to preserve your changes.

¢ Click the Cancel button to return to the Manage Network Nodes page.
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Deleting Nodes

You can delete any node, regardless of its state. If a node is active, the AMC instructs the node to stop
message processing before it is deleted.

How to Get There
Go to Network Nodes > Manage, then select a node and click the Delete button. See Figure 3-7.

Figure 3-7 Delete a Network Node
Metwork Properties Deploy Monitor Keystores Admin
Network Nodes MNetwork > Metwork Modes > Manage > Delete
* Manage
. Delete Network Node Confirmation
onfigure

Activate /Deactivate
Yirtual Clusters Name: aon-node
WCCP Servers Serial Number: FOCO823137T

State: Registered

Description:

Do you want to delete this node? Yes Ho

Actions to Take

You can take one of the following actions:
e Click the Yes button to delete the node.

¢ Click the No button to cancel deletion and return to the Manage Network Nodes page.
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Replacing Nodes

You can replace a registered node with another registered node. Active and unregistered nodes cannot
be replaced, nor can they serve as replacements. After a node has been replaced, you can no longer
change its configuration in the AMC, nor can you activate it for message processing. The replacement
node inherits the exact configuration of the node being replaced, and you are then able to activate it for
message processing.

How to Get There

Go to Network Nodes > Manage. Click the radio button for the node you want to replace, then click the
Replace button. See Figure 3-8.

Figure 3-8 Replace a Network Node
Network Properties Deploy Monitor Keystores Admin
Metwork Nodes Network > Network Nodes > Manage
¥ Manage
: Replace Node

Configure
Activate/Deactivate Select the node that should replace Nodea

e i # Mame Serial Number State Virtual Cluster  Description

1 ¢ aon-node FOCO823137Y Reqistered
WCCP Servers
RomsrPage| 10 [ Page[ 144 G | 44 0 M
Activate Deactivate

Actions to Take

You can take one of the following actions:

¢ Click the radio button for the node that is to serve as the replacement, then click the Submit button
to save your change.

¢ Click the Cancel button to discard your change and return to the Manage Network Nodes page.
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Exporting Nodes

S

Note

Note

AMC provides the ability to export the configuration data from a node so that it can be imported by
another AMC. Enter a unique name for the checkpoint label.

AMC:s involved in exporting and importing nodes must be running the same version of software.

How to Get There
Go to Admin > Node Migration, then click Export. See Figure 3-9.

Figure 3-9 Export a Network Node
Network Properties Deploy Monitor Keystores Admin
Licensing Admin > Node Migration > Export
Users Export Nodes
AMC Security # Name Type Status
e 1 aon-node Network Node
Mode Migration Rows/Page| 10 m Fages 111 m 4 4 0 P
* Export
Import Specify a Checkpoint Label: |aon-node-export

Export

Actions to Take

You can take the following action:

e Select a node, enter a checkpoint label, and click the Export button to prepare the file for download.

The export process takes several seconds to complete. On completion, the Export button is grayed out,
and the Download File button is active.

Figure 3-10 shows the Export Node page after the file has been prepared and is ready for download.

Figure 3-10 Download File for Exported Network Node

Network Properties Deploy Monitor Keystores Admin
Licensing Admin > Mode Migration > Export
Users Export Nodes
AMC Security # Name Type Status
Extensions 1 aon-node Network Node Exported
Node Migration e 10 m Page| 1//1 m 4 Pbk M
* Export
Import 3 Download File

Actions to Take
You can take the following action:
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¢ Click the Download File button to begin the download.

Importing Nodes

After a node has been exported, you can import it to another AMC. Figure 3-11 shows the Import

Network Node page.
Figure 3-11 Import a Network Node
Network Properties Deploy Monitor Keystores Admin
Licensing Admin > Node Migration > Import

Users  ypload New Configuration File

AMC Security

Extensions Select Configuration File: |C\Configuration dat

Mode Migration

st Upload

¥ Import

Actions to Take

You can take the following action:
¢ Enter the location and name of the configuration file, then click the Upload button.
¢ Click the Browse button to navigate to the appropriate file, then click the Upload button.

After the file has been uploaded, you can apply the configuration to an existing network node, as shown
in Figure 3-12.

Figure 3-12 Apply an Imported Configuration

Network Properties Deploy Monitor Keystores Admin

Licensing Admin > Node Migration > Import

Users Source

AMC Security File Creation Date: Wed Apr 27 17:05:12 PDT 2005

Extensions Number of Node Configurations: 1

Nade Hiaration Source AMC: AMCHost

Export
S Lot Select a Node: | aon-node |
Destination
# Name Type Status
1 ® acn-node Network Node
Rows/Page| 10 m Page| 1|/1 m 4 4 0 M

Conflict Resolution
(O Source overrides Destination Cenfiguration
(O Destination overrides Source Cenfiguration

(3) User Selects Cenfiguration

Import
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Actions to Take
You can take the following actions:

¢ Select source node from the drop-down list.
e Select a destination node.
e Select how to resolve any conflicts.

e Click the Import button to apply the configuration to the destination node.

Managing WCCP Servers

A WCCP server is a router that redirects traffic to an AON node. A WCCP Server can also be used for
load balancing. By configuring a WCCP server, you provide the AMC with the information that it uses
to contact the server and configure it for traffic redirection or load balancing.

This section covers the following topics

e Creating WCCP Servers, page 3-11

Creating WCCP Servers

How to Get There

Go to Network > WCCP Servers > Define WCCP Servers, then click the New button. Figure 3-13
shows the New WCCP Server page.

Figure 3-13 New WCCP Server

_ Network ] Properties T Deploy T Monitor T Keystores T Admin -

Network Nodes Network > WCCP Servers > Define WCCP Servers > New

Virtual Clusters New WCCP Server

WCCP Servers
» Define WCCP Servers * 1P address: |10 0 10 13

User name: |admin

* Password: esees

* Confirm password: eesse

* Enable password: |esses

* Confirm enable password: |esses

* Access method: | Secure Shell |ines

Save Cancel
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Table 3-3. shows the entries available on the New WCCP Server page.

Table 3-3 New WCCP Server Entries

Entry Description

IP Address IP address of the device being configured.

User name Username required to configure device.

Password Password required to gain access to device.

Enable password Enable password required to access privileged EXEC mode.

Access method If the device is configured for SSH, select secure shell. Otherwise select
telnet.

Managing Virtual Clusters

A virtual cluster is a set of identically configured network nodes. After nodes are added to a virtual
cluster, you can update the entire clustered group by changing a single set of configuration parameters.
Virtual clusters can be configured for the following:

¢ High availability—Nodes in a cluster can function as a single node. When a node is taken out of
service, the other nodes in that virtual cluster assume the messaging processing responsibilities of
the missing node.

¢ Load balancing—Nodes in a cluster can share workload, meaning no single node becomes
overloaded with network traffic.

This section covers the following topics:
e Creating a Virtual Cluster, page 3-12
e Changing Nodes Within a Virtual Cluster, page 3-14
e Configuring WCCP for Cluster Management, page 3-14

Creating a Virtual Cluster

A virtual cluster consists of two or more AON nodes that are configured to share workload and ensure
redundancy. The first node you choose for a cluster is called the master node. Other nodes that you add
to the cluster will receive duplicate configurations to that of the master node. After the virtual cluster
has been created, all nodes are equal, meaning no node is a master node.

Prerequisites

¢ You need at least two registered nodes. Nodes cannot be unregistered while they are being added to
a virtual cluster. The master node can be active, however, the nodes being added must be in the
registered state.

e All nodes in a cluster must be running on the same type of hardware. You cannot combine an
AON-SM and AON-NM into a virtual cluster.

Step1  Go to Network > Virtual Clusters > Create. This loads the Create Virtual Cluster page, as shown in
Figure 3-14.
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Step 2

Step 3
Step 4

Managing Virtual Clusters

Figure 3-14 Create a Virtual Cluster
Network Properties Deploy Monitor Keystores Admin
Network Nodes Network > Virtual Clusters > Create
Virtual Clusters Create Virtual Cluster
AR Select the master node for the new virtual cluster.
Manage
T # Name Serial Humber State Description
onfigure
1 (O NodeA FOCO82313YY Registered
WCCP Servers
2 (O NodeB FOCO08380BSK Registered
Rows/Page| 10 m Page| 1|/1 m 4 4 ¢ M
Next >

Select a master node (the node whose configuration will be duplicated on the other nodes in the cluster)
and click the Next button. This loads the Create Virtual Cluster page, as shown in Figure 3-15.

Figure 3-15 Create a Virtual Cluster

Network Properties Deploy Monitor Keystores Admin

Network Nodes Network > Virtual Clusters > Create

Virtual Clust -
e Create Virtual Cluster

* Create
Manage

Confi
ek b Lk virtual Cluster Name: |Clustert

WCCP Servers

Description:
Comprised of Nodes: Name Serial Number State
NodeB  FOCOB2313vY Registered
Sheould the Selected Nodes be Load-balanced? &) vee O no

Virtual Cluster IP Address: |10.1.13.2

< Back Finish Cancel

Complete the entries as appropriate for your network and select the other nodes to be added to the cluster.

Click the Finish button to save your changes, then go to Network > Virtual Clusters > Manage to
verify that the cluster was configured. Figure 3-16 shows the Manage Virtual Clusters page.

Figure 3-16 Manage Virtual Clusters
Network Properties Deploy Monitor Keystores Admin

Network Nodes Network > Virtual Clusters > Manage
Virtual Clusters Manage Virtual Clusters

treate # Name Description

* Manage
Configure 1 (& Clusterl
WCCP Servers Bomsltiane) 10 m e | m 4 4Pb M

Show Add Hodes Remove Nodes Delete
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Step5  Goto Network Nodes > Activate/Deactivate to make the nodes in the cluster Active. Figure 3-16 shows
the Activate / Deactivate Network Nodes page after the nodes in the virtual cluster have been activated.

Figure 3-17 Activate/Deactivate Network Nodes
_ Network I Properties T Deploy T Monitor T Keystores T Admin _
Network Nodes Network > Network Nodes > Activate/Deactivate
M . :
anags Activate/Deactivate Network Nodes
Configure
b Activate/Deactivate # Name Serial Number State Virtual Cluster Description
@ i =
e e 1 (& NodeA FOC082313YY Active Clusterl
it 2 (O NodeB FOC08380B9K Active Clusterl
Rows/Page| 10 m Page| 1[/1 m 4 4 ¢ M
Activate Deactivate

Changing Nodes Within a Virtual Cluster

After a virtual cluster is configured, you can perform any of the following actions:

¢ Add Nodes—When you add additional nodes, the new nodes receive identical configuration to that
of the existing nodes in the cluster.

e Remove Nodes—If you remove a node from a cluster, it is returned to the registered state.
Remaining nodes in the cluster continue to operate in the absence of the removed node. The
configuration of a node that is removed from a cluster is restored to the factory default when that
node is activated outside of the cluster.

e Delete—If you delete a cluster, all member nodes are returned to the registered state, and their
configurations are restored to the factory default. Network > Network Nodes.

Configuring WCCP for Cluster Management

Virtual clusters use WCCP to detect when a member of a cluster goes offline. If this happens, other
members of the cluster assume the missing node’s message processing workload.

Prerequisites

¢ You must have a WCCP server available to add to the virtual cluster before beginning this
configuration. See the “Managing WCCP Servers” section on page 3-11 to configure a WCCP
server.

Step 1 Go to Virtual Clusters > Configure. Select a cluster and click the WCCP for Cluster Management
button, then click the New button.
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Figure 3-18 shows the New WCCP Service Group page.

Figure 3-18 New WCCP Service Group

Network Properties Deploy Monitor Keystores Admin
Metwork Nodes Network > Virtual Clusters > Configure
Yirtual Clusters New WCCP Service Group
Create
Manage
* Configure * Service Group 1D: |51
WCCP Servers * Multicast Address: |10 2 .10 8

Authentication Password: | esses

Confirm Authentication Password: esess

Add Servers Save Cancel

Table 3-6 shows the entries available on the New WCCP Service Group page.

Table 3-4 New WCCP Service Group Entries

Entry Description

Service group ID Unique number for each service group. Range is 51 — 99.
Multicast address IP address to be used by members of this service group.
Authentication password Password by members of this service group for authentication.

Step2  After completing the entries, click the Add Servers button. This loads the a page that lists available
WCCP servers, as shown in Figure 3-19.

Figure 3-19 Add WCCP Servers

Network Properties Deploy Monitor Keystores Admin
Network Nodes Network > Virtual Clusters > Configure
Yirtual Clusters Add WCCP Servers
Create
# IP Address
Manage
» Configure 1 [ 10.0.0.45
WCCP Servers 2 10.0.0.45
Add Cancel

Step 3 Choose one or more servers, then click the Add button. The servers are added to the WCCP service
group, as shown in Figure 3-20.
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Step 4

Step 5

Figure 3-20 New WCCP Service Group

Network Properties Deploy Monitor Keystores Admin
MNetwork Nodes Network > Virtual Clusters > Configure
Yirtual Clusters New WCCP Service Group
Create
Manage
* Configure * Service Group ID: |51
WCCP Servers * Multicast Address: |10 .12 . |10 e

Authentication Password: |eesss

Confirm Authentication Password: esess

Server List

Select IP Address
® 10.0.0.46
Add Servers Remove Server Configure Interfaces
Save Cancel

Click the Configure Interfaces button to specify the interface to be used by the WCCP server. This loads
the Server Interfaces page, as shown in Figure 3-19.

Figure 3-21 Server Interfaces

Hetwork Properties Deploy Maonitor Keystores Admin

Network Nodes Metwork > Network Modes > Configure > WCCP for Traffic Redirection > Edit > Configure Interfaces

Manage

Server Interfaces
* Configure

Activate /Deactivate * Redirect In Interfaces: Service-Engine1/m ;I
Yirtual Clusters
YWCCP Servers _|
* Group Listen Interfaces: Service-Engine1/m ;I
Save Cancel

Enter the names, such as Service-Enginel/0, of the interfaces to be used by members of the service
group, then click the Save button. After you are returned to the New WCCP Service Group page, click
the Save button to save the entire service group configuration.
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Configuring WCCP for Traffic Redirection

Step 1

Virtual clusters use WCCP to for traffic redirection and load balancing. You can configure nodes to
redirect messages based on the IP address or port.

Prerequisite

e If traffic redirection is to be based on source or destination IP addresses, you must configure an
ACL/Classifier for the cluster. See the “Configuring ACL/Classifiers” section on page 3-19 to
specify IP address parameters for traffic redirection.

Go to Virtual Clusters > Configure. Select a cluster and click the WCCP for Traffic Redirection
button, then click the New button.

Figure 3-22 shows the New WCCP Service Group page.

Figure 3-22 New WCCP Service Group

Network Properties Deploy Monitor Keystores Admin

MNetwork Nodes Network > Virtual Clusters > Configure

¥irtual Clusters New WCCP Service Group
Create

Manage

» Configure * Service Group ID: |54

WCCP Servers * Multicast Address: |10 I | . |53

Authentication Password: |sess
Confirm Authentication Password: eses
* Port Map: |80

* Listener Port: |80

Add Servers ACLiClassifier Save Cancel

Table 3-5. shows the entries available on the New WCCP Service Group page.

Table 3-5 New WCCP Service Group Entries

Entry Description

Service group ID Unique number for each service group. Range is 51 — 99.

Multicast address IP address to be used by members of this service group.

Authentication password Password by members of this service group for authentication.

Port map Comma-delimited string of destination ports to be redirected.

Listener port Comma-delimited string of ports at which an adapter is listening
for traffic.
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Step2  Complete the entries as appropriate for your network, then click the Add Servers button. This loads a
page that lists available WCCP servers, as shown in Figure 3-23.

Figure 3-23 Add WCCP Servers

Network Properties Deploy Monitor Keystores Admin
Network Nodes Network > Virtual Clusters > Configure
Yirtual Clusters Add WCCP Servers
Create
# IP Address
Manage
» Configure 1 [ 10.0.0.45
WCCP Servers 2 10.0.0.45
Add Cancel

Step 3 Choose one or more servers, then click the Add button. The servers are added to the WCCP service
group, as shown in Figure 3-24.

Figure 3-24 New WCCP Service Group

Network Properties Deploy Monitor Keystores Admin
MNetwork Nodes Network > Virtual Clusters > Configure
¥irtual Clusters New WCCP Service Group
Create
Manage
» Configure * Service Group 1D: |54
WLLCP Servers * Multicast Address: |10 L3 |0 .53

Authentication Password: |esss
Confirm Authentication Password: (eees
* Port Map: |80
* Listener Port: |80

Server List

Select IP Address
® 10.0.0.48
Add Servers Remove Server Configure Interfaces
ACLIClassifier Save Cancel

Step4  Click the Configure Interfaces button to specify the interface to be used by the WCCP server. This loads
the Server Interfaces page, as shown in Figure 3-25.

] AON Installation and Administration Guide



| Chapter3 Working with Nodes

Step 5
Step 6

Step 7
Step 8

Configuring ACL/Classifiers

Figure 3-25 Server Interfaces
Network Properties Deploy Monitor Keystores Admin
MNetwork Modes Network > Virtual Clusters > Configure
¥irtual Clusters Server Interfaces
Create
Manage

* Redirect In Interfaces:

» Configure fastethernet 1/0

WCLCP Servers

* : 3 -
Group Listen Interfaces: fastethemst 1/1

Save Cancel

Enter the name of the interfaces to be used by members of the service group, then click the Save button.

After you are returned to the New WCCP Service Group page, click the ACL/Classifier button. On the
next page, click the Add Entries button to load the page that lists the available ACL/Classifiers, as
shown in Figure 3-26.

Figure 3-26 Select ACL/Classifier Entries

Network Properties Deploy Monitor Keystores Admin

Metwork Nodes Network > Virtual Clusters > Configure

Virtual Clusters Select ACL/Classifier Entries
Create
Maroge Name Source IP Source Wildcard Bits  Destination IP  Destination Wildcard Bits

F Configure Clusterl 255.255.255.255 255,255.255.255 10.10.14.10 0.0.0.0
WCCP Servers
Select Cancel

Choose an ACL/Classifier, then click the Select button to associate it with the WCCP service group.

Click the Save button to save your changes and return to the New Service Group page. From there click
the Save button to complete the configuration.

Configuring ACL/Classifiers

Step 1

An ACL/Classifier contains an ordered list of access control entries. Each entry contains a source and
destination IP address that are matched against the contents of a packet to determine if messages are to
be redirected by WCCP. ACL/Classifiers are also used for message classification.

Use one of the following navigation paths:

e For network nodes; Network > Network Nodes > Configure. Select a node, then click the
ACL/Classifier button.

e For virtual clusters: Network > Virtual Clusters > Configure. Select a cluster, then click the
ACL/Classifier button.
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This loads the New ACL/Classifier Entry page, as shown in Figure 3-27.

Figure 3-27 New ACL/Classifier

@cm Management Console Logout | Help | About

Metwork Properties Monitor Keystores Admin
k= k Modes > Configure » ACL/Classifier > New
New ACL/Classifier Entry
i * Mame: |
1 * Source IP: |0 .. ] 2|0 . [0 Port
* Source Wildcard Bits: |255 255 | |255 | |285
* Destination IP: |0 .. ] .. [o .. [o Port
* Destination Wildcard Bits: |255 255 255 L2845

Step2  Complete the entries as required by your environment, taking the following into consideration:

¢ A0 (zero) wildcard bit equates to “only”

e A 255 wildcard bit equates to “any”

For the configuration depicted in Figure 3-27, a match is found for any traffic that has source IP

10.22.47.* and a destination 10.22.48.99.

Step3  Click the Save button to save your changes.
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Configuring Recovery

The AMC enables you to control the recovery parameters of network nodes and virtual clusters.
Watchdog is a process that runs on an AON node and verifies that the AON application on that node is
operating normally. When watchdog detects a failure, it can attempt to restart AON and WCCP.

How to Get There
e Network node: Go to Network Nodes > Configure. Select a node and click the Recovery button.

e Virtual cluster: Go to Virtual Clusters > Configure. Select a node and click the Recovery button.

Figure 3-6 shows the Recovery Properties page.

Figure 3-28 Recovery Properties

Metwork Properties Deploy Monitor Keystores Admin

Network Nodes k> k Modes > Configure > Recovery

Manage

bl o it Recovery Properties: AONSNODEFORKPLUS

Activate /Deactivate
Yirtual Clusters ACHN Heartbeat Interval (Seconds): IB
WCCP Servers A40M Startup Delay (Seconds): |120

Watchdog Recovery Action: IREStarTADnS and WCCP j

WCCP "Here T Am" Interval (Seconds): |1D

Enable watchdog: |true j

Watchdog Failure Detection Interval (Seconds): ISD

Save Cancel = Back
Table 3-6. shows the entries available on the Recovery page.
Table 3-6 Recovery Entries
Entry Description
AON Heartbeat Interval Rate at which the AON process sends heartbeats to the watchdog
process.
AON Startup Delay Number of seconds watchdog waits for the AON process to start
up before attempting to restart.
Watchdog Recovery Action Action to be taken when a watchdog timer expires.
WCCP “Here I Am” Interval Interval at which WCCP clients send the “Here I Am” message.
Enable Watchdog Drop-down list to select if watchdog is enabled or disabled.
Watchdog Failure Detection Interval |Time that will elapse before watchdog detects that AON is down.
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Deploying to Nodes

Step 1

Step 2

When a configuration is changed within the AON network, usually this change requires deployment to
AON nodes. Deployment requests consist of two types:

¢ Global Deployment Request—A change, such as a global policy, that applies to all nodes in the AON
network.

¢ Node Deployment Request—A change, such a new PEP or message type, that applies only to an
individual node.

Changes made to the configuration of an AON node must be explicitly deployed to the node. These
include those made in AMC those uploaded from the AON Development Studio. Whenever a
configuration change is made, it appears in a deployment request (DR). There are two types of
deployment requests:

¢ Global Deployment Request—contains changes, such as a global properties, that apply to all nodes
in the AON network.

¢ Node Deployment Request—contains changes, such a new PEPs or message types, that apply to an
individual node.

Go to Deployment > Manage Staging to view the deployment requests waiting in the Open and Staged
state. Figure 3-29 shows the Manage Staging page.

Figure 3-29 Manage Staging

_ Metwork T Properties | Deploy ] Monitor T Keystores T Admin -

Deployment Requests Deploy > Deployment Requests > Manage Staging
* Manage Staging

Manage Staging

Manage Deployment

Summary Open Global Deployment Requests
# Mame State Deployment Error
1 ¢~ Global Deployment Request: Jun 16, 2005 21: Open
Romxsa’PageI N Go | Pagel 11 [ 44 Pp M

Details Stage Unstage Delete

Mo Mode Deployment Requests Available

Click the radio button for the deployment request, then click the Stage button. This changes the state to
Staged, which is the last stop before deployment.
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Step3  Click the Manage Deployment link, which loads the Manage Deployment page, as shown in Figure 3-30.

Figure 3-30 Manage Deployment

Hetwork Properties Deploy Monitor Keystores Admin

Deployment Requests Deploy > Deploy t Requests » Manage Deploy
Manage Staging

* Manage Deployment Manage Deployment

Summary Staged Global Deployment Requests
# Mame State Deployment Error
1 & Global Deployment Request: Jun 16, 2005 21: Staged
31:07
RomxsiPagelT m Page|—1.l’1 m 44 0 M

Details Unstage Deploy
Mo Mode Deployment Requests Available

Step4  Click the radio button for the deployment request, then click the Deploy button. The AMC deploys the
request to the AON node.

Step5  Click the Summary Link to verify that the request was successfully deployed. Figure 3-30 shows the
Deployment Summary page.

Figure 3-31 Deployment Summary
Hetwork Properties Deploy Monitor Keystores Admin
Deployment Requests Deploy > Deployment Requests > & ¥
Manage Staging
Manage Deployment Summary
¥ Summary All Global Deployment Requests
# Name State Deployment Error

1 & Global Deployment Request: Jun 16, 2005 21:  Deployed

RomxsiPagele Page|_1.l’1 m I‘ ‘ ’ ’I

Details

Mo Mode Deployment Requests Availahle
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Viewing Logs

After configuring the Message Log Domain Policy at Properties > Application > Node > Message Log
Domain, you can retrieve these logs with the page shown in Figure 3-32.

How to Get There
Go to Monitor > Logs, then select a node and click the View Logs button.

Figure 3-32 View Logs

_ Hetwork ‘1 Properties T Deploy | Monitor ] Keystores T Admin -

Network Nodes Monitor = Metwork Modes = Logs > Show Logs

Events

wh e Logs for: aon-node

Yirtual Clusters

Message Log Policy: | mklog v
Message Entry Time: ..»‘\ITy' v
Message Class: | Any v
Destination: .An:['_ v

Source: | Any ||
Other Condition(s):
Show Logs

Source Destination Message Entry Time Protocol Message Class Flow Name

Rows/Page| 100 m Fage 1A m l‘ ‘ ’ 'I

Viewing Events

After configuring the Monitoring Policy at Properties > Monitoring, you can retrieve these events with
the page shown in Figure 3-33.

How to Get There
Go to Monitor > Events, then select a node and click the View Events button. See Figure 3-33

Figure 3-33 View Events
_ Hetwork ‘I Properties 1 Deploy ) Monitor ] Keystores 1 Admin -
Network Nodes Monitor = Metwork Nodes = Events
F Events
s Network Nodes: Events
gs
# Mame Serial Humber State Description
¥irtual Clusters
1 g aon-node 5AD08320735 Active
Romxsa’Pagel E Go | Pagel 101 [ 44 b M
View Events Clear Events
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WCCP protocol is used for transparent traffic redirection to AON nodes. AON uses WCCP control plane
with multicast signaling. The code uses an IP TTL of 3 for Volant based AON nodes and a TTL of 1 for
all other AON platforms. This is not a protocol restriction though.

The manifestation of this mandated it that the appliance be Layer 2 adjacent to the WCCP server
(Cat6k/router). But this is not a practical deployment for Olympus as this artificially limits deployment
to direct (1 hop) co-location with router/switch. This is a major drawback since the administrators may
want to deploy the appliance in the datacenter along with the application servers.

This feature increases the TTL for multicast control messaging for appliance WCCP clients to a value
of 8 (no specific reason). It also changes the default data forwarding behavior to use GRE tunneling.
Appliance negotiates GRE tunneling (default behavior is for the WCCP client to propose L2
forwarding).

The CLI command "forward layer2" is introduced under the "wccp <service-group #> command. This
command is available for Olympus only (command does not show up in parse tree for K+ and Volant).

This command cannot be enabled/disabled via AMC - it is a CLI only feature.

This command should be turned on when the appliance is directly connected to a Cat6k with Sup-II card.
Without this command, appliance will negotiate GRE forwarding with Sup-II. Sup-II does GRE
forwarding in software which can severely degrade the switch performance.

When connected directly with a Cat6k with Sup-720, this command may or may not be turned on.
Sup-720 does GRE forwarding in hardware, but the performance is not at par with L2 forwarding on
Sup-720. Thus, even for Sup-720, when directly connected, turning on this command gives better
performance.

aon-apl> configuration terminal

Enter configuration commands, one per line. End with exit.
aon-apl (config)> wececp 51

aon-apl (config-wccp)> forward layer2

aon-apl (config-wcecp) > exit

aon-apl (config)> exit

aon-apl> write memory
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CHAPTER I

Managing AON Properties

Properties control how messages are processed in an Application-Oriented Network. Properties can be
applied globally to the entire AON installation, or they can be applied only to individual nodes.

Note  This chapter covers most properties that appear on the Properties tab of the AMC. Additional AMC
properties related to security, authentication, and authorization are in Chapter 5, “Managing AON
Security.”

This chapter includes the following sections:
e Monitoring Activity, page 4-2
e Adjusting Quality and Performance, page 4-6
e Working with Message Content, page 4-10
e Controlling Message Delivery, page 4-13
e Working with Adapters, page 4-20
e Working with Message Transport, page 4-23
e Connecting to Databases, page 4-49
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Monitoring Activity

Bladelet Monitoring Property

The Bladelet Monitoring Property configures which events are stored for retrieval using the screen at
Monitor > View Events. You can configure this property globally, or you can apply it to individual
nodes.

How to Get There
Go to Properties > Monitoring.

Figure 4-1 shows the Monitoring Property page.

Figure 4-1 Bladelet Monitoring Property
Adapter Properties > Monitoring > Global > Edit

Application Bladelet Monitoring: Edit Property Set

Authentication & Authorization

IMS * Mame: Default

Monitori i
onitoring * Authenticate Events: |true
¥ Global

Node

* Authorize Events: |true

ADN Security * Sign Events: [true

MNode Management Security

* VerifySignature Events: |true
Service Profiles

* Encrypt Events: |true

* Decrypt Events: |true

* Identify Events: |true

* Verifyldentity Events: |true

* Transform Events: |true

* Find Events: |true

* Content Validation Events: |true

CH I T K O KT K K

* MIME Events: |true

Submit Cancel

To configure the Monitoring Property, change events that you want monitored to True, then click the
Submit button.

Message Log Domain

AON nodes are able to capture application log messages and store them in a database for later retrieval.
This functionality requires you to complete the following tasks:

1. Create a Message Log Database—This is the Oracle or Sybase database in which log messages are
to be stored.

¢ Configure Message Log Domain Property—This defines within AMC the database configuration
details to be used to store log messages.
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Upon completion of these steps, ADS users will be able to use the Log Bladelet to store messages in the

database.

Create a Message Log Database

If you enable AON message logging, you can configure an external Oracle or Sybase database to store
log messages. An existing Oracle database can be used for message logging. However, a Sybase database
must have a specific configuration to be compatible with AON. For this reason, we recommend that you

create a new database.

Step1  Create a database and a user (for logins). Grant the user database privileges to create, query, delete,
update, and insert.

Use one of the following for the Message Log Database:
e Oracle 91 (9.2)
You can create a separate Oracle 91 database for AON Message Logging.

e Sybase 12.5.1

You should create a separate Sybase 12.5.1 Adaptive Sever (database) for AON message logging,
The requirements for this external database are summarized below.

— Page size >= 8K
— Procedure cache size - 100000
— Max memory 131072 (in 2k units, i.e. 131072 * 2k = 256MB)

S

Note  See Oracle or Sybase documentation for specific database configuration instructions.

Step2  Run the appropriate script to create the Message Log schema in your database. See Appendix A,
“Message Log Schemas” for Sybase and Oracle scripts.
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Configure Message Log Domain Property

After a database as been configured, you can configure Message Log Domain Property. This is a device
level property.

How to Get There
¢ Go to Properties > Application > Node. Select a node, then click the Edit Properties button.

Figure 4-2 shows the Message Log Domain Property page.

Figure 4-2 Message Log Domain Property

Hetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Node > Edit Properties > Edit

Application Message Log Domain: Edit Property Set
Global
* Node
= .
Authentication & Name: mklog

Authorization
Enabled: |true v

JMS
Sub-protocol: | oraclethin w
Monitoring

E User ID: |beta
ADN Security

Node Management Security Password: |esss
Service Profiles Database Alias: @jdgou-u5:1521:aonsmlog
Driver: | oracle jdbc.OracleDriver w

Max Queue Size: [10000

Submit Cancel

Data to Enter
The Message Log Domain Property page includes the entries described in Table 4-1.

Table 4-1 Message Log Domain Property Entries

Entry Description

Name Name of your choosing for this property.

Enabled Select true to enable, false to disable.

Sub-protocol oracle.thin for Oracle. sybase.Tds for Sybase.

User ID User ID required to log on to the database. The user must have permission to

create, read, write, update, and query the database.

Password The password to gain access to the database.
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Table 4-1 Message Log Domain Property Entries (continued)

Entry Description

Database alias Alias pointing to the database. This value depends on the configuration of the
database. The format for this entry is </P address> : <port> : <name of
database>

The following are examples:
e Oracle—@10.1.1.1:1521:aonmlog
¢ Sybase—10.1.1.2:5000/aonmlog

The last part in the alias is the name of the database instance. The message log
schema should be provided by your database administrator.

Driver The JDBC driver name. AON supports the following two drivers:
e Oracle—oracle.jdbc.OracleDriver

¢ Sybase—com.sybase.jdbc2.jdbc.SybDriver

Max Queue Size ~ Maximum size of the Message Log queue.

Adaptive Load Balancer

Adaptive Load Balancer is used to change the adaptive load balancing algorithm used by AON.
Figure 4-3 shows the Adaptive Load Balancer Property page.

Figure 4-3 Adaptive Load Balancer Property
Network Properties Deploy Monitor Keystores Admin
Adapter Properties > Application > Global > Edit
Application Adaptive Load Balancer: Edit Property Set
¥ Global

Node

* i
Authentication & Name: default

Authorization 5 .
Maximum Request Discard: |30

JMS

Maximum response Samples: |50
Monitoring

I Retry Interval: |50
ADN Security
Mode Management Security Submit Cancel

Service Profiles

Data to Enter
The Adaptive Load Balancing property page includes the entries described in Table 4-2.
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Table 4-2 Entries on Adaptive Load Balancer Property

Entry Description

Name Name of your choosing for this property.

Maximum Request Number of requests to wait before discarding a server's average response time

Discard data.

Maximum Number of samples used for determining the most responsive server.

Response Samples

Retry Interval Time in seconds to wait before retrying a server that was deemed to be
inaccessible.

Adjusting Quality and Performance

AON allows you to measure and control runtime control quality and performance for message types that
you specify.

Caching

AON includes a built-in cache engine that can be used as a proxy cache or reverse proxy cache depending
on where and in which administrative domain the cache is placed. Use the Caching Property to configure
how the AON cache engine operates. This is a device-level property, and it is used in conjunction with
PEPs that include the CacheData and RetrieveCache bladelets.
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Figure 4-4 shows the Caching Property page.

Figure 4-4 Caching Property
Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Application > Node > Edit Properties > Edit
Application Caching: Edit Property Set
Global
* Node

Authentication &
Authorization

JMS

Monitoring

AON Security

Node Management Security

Service Profiles

Data to Enter

* Name: caching

Owerride no-cache Response Directive: | false v
Owverride no-store Response Directive: |false 5l
Owerride private Response Directive: |false v
Override no-cache Request Directive: |false v
Owverride no-store Request Directive: |false v
Override Pragma:no-cache Request Directive: |false 5l

Response Cache Default TTL: (86400
Variable Cache Default TTL: 86400
Max Objects Variable Cache: 1000

Max Objects Security Cache: 100

Response Cache Replacement Algorithm: | LRU v
“ariable Cache Replacement aAlgorithm: | LRU v
Security Cache Replacement Algorithm: | LRU v

Loadbalancing Cache Replacement Algorithm: | LRU 5l
Cache Server : | localhost v
Cache Server Port: | 60606 v

Connection Timeout: |5
Queue Size: [1000
Folling Interval: |G0
Pending Message Queue Timeout: |20

Timed-out Message Count: 500

Submit Cancel

The Caching Property page includes the entries described in Table 4-20.

Table 4-3 Entries on Caching Property

Entry

Description

Override no-cache Response Directive

If this value is set to true, the HTTP “no-cache” response directive is ignored.

Override no-store Response Directive

If this value is set to true, the HTTP “no-store” response directive is ignored.

Override private Response Directive

If this value is set to true, the HTTP “private” response directive is ignored.

Override no-cache Request Directive

If this value is set to true, the HTTP “no-cache” request directive is ignored.

Override no-store Request Directive

If this value is set to true, the HTTP “no-store” request directive is ignored.
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Table 4-3

Entries on Caching Property (continued)

Entry

Description

Override Pragma:no-cache Request Directive

If this value is set to true, the HTTP “Pragma:no-cache” request directive is
ignored.

Response Cache Default TTL

Default time to live (TTL) to be used for response caching.

Variable Cache Default TTL

Default TTL to be used for variable caching.

Max Objects Variable Cache

Determines the number of objects to store in the variable cache before
replacement algorithms are activated.

Max Objects Security Cache

Maximum number of objects to be cached in the security cache before
replacement algorithms are activated.

Response cache replacement Algorithm

This value must be set to LRU. This is the replacement algorithm to be used
for response caching.

Variable Cache Replacement Algorithm

This value must be set to LRU. This is the replacement algorithm to be used
for variable caching.

Security Cache Replacement Algorithm

Must be set to LRU. This is the replacement algorithm to be used for security
caching.

Cache Server

Host name or IP address of the caching server. Must be set to localhost.

Cache Server Port

Port on which the caching server listens. Must be set to 60606.

Connection Timeout

Determines how long a request will wait for a response

Queue Size

The pending message queue contains references to messages that are awaiting
response from the server. If a message remain in this queue beyond the
timeout value, the server is assumed to be down. Typically set for

20-30 seconds.

Polling Interval

Determines the number of seconds the client will wait before checking if a
failed server has returned to service.

Pending Message Queue Timeout

Determines the size of the client’s sending queue.

Timed-out Message Count

Determines how many failed messages are required for a server to be
considered down.

Reliable Messaging

The Reliable Messaging property is used to configure the parameters that control reliable messaging.
Reliable messaging enables an AON device to ensure that messages are delivered to their destination
regardless of how many hops are involved. Reliable Messaging is a Global property. Figure 4-5 shows
the Reliable Messaging Property page.

] AON Installation and Administration Guide



| Chapter4 Managing AON Properties

Adjusting Quality and Performance

Figure 4-5 Reliable Messaging Property

HNetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Global > Edit

Application Reliable Messaging: Edit Property Set

¥ Global
Node
* .
Authentication & s UERCLTS
Authorization .
Resend Check Period: | 10000
JMS
Time To Abort: 120000
Monitoring
5 Time To Resend: |20000
ADN Security
MNode Management Security Submit Cancel

Service Profiles

Data to Enter
The Reliable Messaging Property page includes the entries described in Table 4-4.

Table 4-4 Entries on Reliable Messaging Property

Entry Description

Property Name Name of your choosing for this property.

Resend Check Number of milliseconds to wait before checking whether the end point received
Period the message.

Time To Abort Number of milliseconds to wait before aborting sending of message.

Time To Resend Number of milliseconds to wait before resending a message.

Application Q0S

The Application QOS feature enables AON to prioritize message processing based on the Differentiated
Services Code Point (DSCP) contained in the IP header. Use the QoSMapping page in AMC to define
appropriate DSCP values for the following categories (listed in priority order):

e Bulk data transfer

e Default

e Mission critical

e Network management
e Transactional data

These categories are available to PEP developers who use the Application QOS bladelet.

AON Installation and Administration Guide
| ==



Chapter4 Managing AON Properties |

I Working with Message Content

How to Get There
Go to Properties > Application > Global, then select QoSMapping.

C1sco SYSTEMS \
) AON Management Console Codsit [THEIE [ Hbsit

Metwork Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Global

Application Application: Global Properties
» Global
Node

Categories QoSMapping Property Sets
Authentication & 7 1
Authorization  ~dapter Listener Domain J # Name Scope

Adaptive Load Balancer

1 (O Bulk Data Transfer

IMS  Content Parser . o

2 .
S Content Validation 2 (O Default &

Database — —

; _ 3 () Mission Critical &

ADN Security Reliable Messaging &
Transformation 4 (O Metwork Management &

Mode Management Security .

QusHapping 5 (O Transactional Data &

T L ITIIT Fastpath (FEF optimization)

J JJ Edit

Actions to Take

Click the radio button for the property set you want to change, then click the Edit button. On the screen
that follows, enter the new DSCP value and click the Submit button.

Working with Message Content

AON allows you to work with the content of your messages based on properties that you set.

Content Parser

The content parser property specifies a Java class that implements a content parser to use for reading an
input content and converting it to an equivalent XML content. This property can also specify a Java class
to use to perform the transformation instead of using XSLT-based transformation. Figure 4-6 shows the
Content Parser Property page.
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Figure 4-6 Content Parser Property

Hetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Node > Edit Properties > New

Application Content Parser: Add New Property Set

Global
* Node
*N -
Authentication & e
Authorization . : =
Transformation Factory: |com.cisco.aons.semnvice transform XSLTTransforme
JMS
Parser Class Name:
Monitoring
) MName of Package:
ADN Security
MNode Management Security Submit Cancel

Service Profiles

Data to Enter
The Content Parser Property page includes the entries described in Table 4-5.

Table 4-5 Entries on Content Parser Property
Entry Description
Name Name of the Content Parser property.

Transformation This parameter specifies the class name that implements a custom transformer.
Factory

Parser Class This parameter specifies the name of Java class that is used to parse the input
Name message content and convert it to equivalent XML content.
Name of Specifies the name of the transform package.
Package
Content Validation

A Content Validation application property imposes an external schema on an XML message that contains
no predefined grammar declarations. This property is used when input XML does not contain any
grammar declaration (XSD or DTD) but is expected to conform to a receiver point schema. It is also used
when Input XML is transformed within AON and is expected to conform to a target schema. Figure 4-6
shows the Content Validation Property page.
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Figure 4-7 Content Validation Property

h
Network Properties I Deploy T Monitor T Keystores T Admin -

Adapter

Properties > Application > Node > Edit Properties > New

Application Content Validation: Add New Property Set
Global

* Node

*N -
Authentication & gl

Authorization
Target Schema Name:

JMS
Target Namespace:
Monitoring
ADN Security Submit Cancel
MNode Management Security

Service Profiles

Data to Enter
The Content Validation property page includes the entries described in Table 4-6.

Table 4-6 Entries on Content Validation Property

Entry Description

Name Name of the Content Validation property.

Target Schema  Target schema to be imposed on XML messages running a particular PEP.
Name

Target Namespace for the target schema named above.

Namespace

Working with XSL Transformation

This property configures AON to perform XSL transformation (XSLT). The Transformation property
determines the document style sheet, target content type, and transformation package. This property can
be configured globally or for individual nodes.

How to Get There
¢ Go to Properties > Application > Node. Select a node, then click the Edit Properties button.

Figure 4-8 shows the Transformation Property page.
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Figure 4-8 Transformation Property
Adapter Properties > Application > Node > Edit Properties > New

Application Transformation: Add New Property Set
Global

* Node
*N -
Authentication & sl

Authorization
Name of X5LT Stylesheet:

JMS
Target Content Type:
Monitoring

r Transformation Factory: | XSLT_1.0_With_Extension )
ADN Security e

MNode Management Security Name of Package:

Service Profiles Submit Cancel

Data to Enter

The Transformation page includes the entries described in Table 4-7.

Table 4-7 Transformation Property Entries
Entry Description
Name Name of the Transformation property.

Name of XSLT  Specifies the name of the transform file to use. The file must be present in the
Stylesheet Transform Bundle specified by the parameters below.

Target Content  This is used to set the content type of the target content when the input content is
Type stream content and its type is not known.

Transformation Choose an XSLT transformer to be used.
Factory

Name of Bundle Specifies the name of the transform package.

Controlling Message Delivery

Message delivery properties define the delivery characteristics associated with a message type. All
message types have a default delivery property, which is specified when you create the message type in
the ADS. After a message is classified, the delivery properties of that message are dictated by the
delivery property associated with that message type. Message delivery properties must be configured in
the following order:

1. Configuring Delivery Connection.

2. Configuring Delivery Notification.

3. Configuring Delivery Semantics.

4. Binding Message Delivery Properties to a Message Type.

After you configure delivery properties, synchronize the ADS with the AMC to begin using the new
delivery properties with message types.
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Configuring Delivery Connection

The Delivery Connection property specifies how long a message type should wait for a timeout.

How to Get There
e Go to Properties > Application > Node. Select a node, then click the Edit Properties button.

Figure 4-9 shows the Delivery Connection Property page.

Figure 4-9 Delivery Connection Property
.
I o eroverves | oepioy 1 montor | Keystores 1o NN
Adapter Properties > Application > Node > Edit Properties > Edit

Application Delivery Connection: Edit Property Set
Global

* Node

= ;
Authentication & Name: DC1

Authorization :
Request Timeout: | 15000

JMS
Monitoring Submit Cancel
ADN Security

MNode Management Security

Service Profiles

Data to Enter
The Delivery Notification property page includes the entries described in Table 4-8.

Table 4-8 Delivery Connection Property Entries

Entry Description

Name Name of the Delivery Connection property.

Request Length of time to wait for a response from the endpoint for a timeout, measured
Timeout in milliseconds.

Configuring Delivery Notification

The Delivery Notification property defines how to handle delivery failure notification.

~

Note  You must configure Configuring Delivery Connection before configuring this property.

How to Get There
¢ Go to Properties > Application > Node. Select a node, then click the Edit Properties button.
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Figure 4-10 shows the Delivery Notification property.

Figure 4-10 Delivery Notification Property

Hetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Node > Edit Properties > Edit

Application Delivery Notification: Edit Property Set

Global
* Node
*N : DN1
Authentication & bt
Authorization i B
Delivery Notification Type: |Log w
JMS
Monitoring Submit Cancel

ADN Security
Mode Management Security

Service Profiles

Data to Enter
The Content Validation property page includes the entries described in Table 4-9.

Table 4-9 Delivery Notification Property Entries

Entry Description

Name Name of the Delivery Notification property.
Delivery Log is the only supported option.
Notification

Type
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Configuring Delivery Semantics

The Delivery Semantics property specifies delivery properties for a message type. Use this property, in
conjunction with the Delivery Connection and Delivery Notification properties, to configure the reliable
and ordered delivery of messages.

Note  You must configure Configuring Delivery Connection and Configuring Delivery Notification before
configuring this property.

How to Get There
e Go to Properties > Application > Node. Select a node, then click the Edit Properties button.

Figure 4-11 shows the Delivery Semantics property.

Figure 4-11 Delivery Semantics Property

Hetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Node > Edit Properties > Edit

Application Delivery Semantics: Edit Property Set

Global
* Node
Authentication & iCE e
Authorization : : 1
I= Reliable Delivery: |false K
JMS .
I= Ordered Delivery: |false w
Monitoring =
i Time To Live: 30000
ADN Security
Node Management Security Expire Treatment: | Motify Expired K
Service Profiles Retry Timeout: [10000
Delivery Notification: | DN1 v
Connection Policy: |DC1 v
Submit Cancel
Data to Enter
The Delivery Semantics page includes the entries described in Table 4-10.
Table 4-10 Delivery Semantics Property Entries
Entry Description
Name Name of your choosing for this property.
Is reliable delivery Choose true or false to enable reliable delivery.
Is ordered delivery Choose true or false to enable ordered delivery. Ordered message delivery is
guaranteed to a single destination, not multiple destinations.
Time to live How long either request message or response message can stay in the system
Specified in milliseconds.
Expire treatment Specify what is to happen if TTL expires. reliable messaging global ttl. time
to abort
Retry timeout Specified in milliseconds. takes precedence over global timeout
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Table 4-10 Delivery Semantics Property Entries (continued)

Entry Description

Delivery Notification  Select an available Delivery Notification Property.

Connection Property Select an available Delivery Connection Property.

Actions to Take

Use the Edit List button to choose a delivery notification and connection property.

Binding Message Delivery Properties to a Message Type

After you configure message delivery properties in the AMC, the property is available to ADS users

when they configure message types. Figure 4-12 shows the ADS Message Type Properties window with
the Delivery Properties drop-down list highlighted.

Figure 4-12 MDS Drop-Down List

| Message Type Definition

Specify the rules for classifying messages. Rules can be based on ACLs, LRI, C g
ParametersiMame-‘alue Pairs), Headers (Mame-Yalue pairs) and Message Content IS0 SYSTEMS
[XPath or RegEx). The OK button iz enabled if & unigue name is specified.

Mame: InvoiceDelivery

From &MC: - (locally crested)

Message Classifier: v

URE [ #

| Parameter Rules | Header Rules | Cortert Rules

Tritn trailing and leading spaces in the values specified in each line

Palicies -

pEP: |

Encoding, _ = e v
< ______p)
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After you configure an Encoding profile, it is available to ADS users when they configure a message

type. See Figure 4-13.

Figure 4-13

| Message Type Definition

@

Specify the rules for classifying messages. Rules can be based on ACLs, LRI, CISCO SYSTEMS

ParametersiMame-‘alue Pairs), Headers (Mame-Yalue pairs) and Message Content
[XPath or RegEx). The OK button iz enabled if & unigue name is specified.

Mame: StockQuote

From &MC: - (locally crested)

Message Classiter. | |

URE |

| Parameter Rules | Header Rules | Cortert Rules

Tritn trailing and leading spaces in the values specified in each line

Palicies -

e P =

Cancel

Binding an Encoding Property to a Message Type

Next Hop Domain

~

Note

Next Hop Domain Property enables a device to forward all traffic using a specified protocol to a

designated AON node. Next Hop Domain is a device-level property.

In a two-node scenario, configure this property on the client proxy with the configuration details

necessary to route messages to the server proxy.

How to Get There

¢ Go to Properties > Application > Node. Select a node, then click the Edit Properties button.

Figure 4-14 shows the Next Hop Domain Property page.
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Figure 4-14 Next Hop Domain Property Entries

Network Properties Deploy Monitor Keystores Admin

Adapter Properties > Application > Node > Edit Properties > New

Application Next Hop Domain: Add New Property Set
Global
F Node
* & ~
Authentication & Name: hostname:8080

Authorization
Address: |hostname

IMS
Port: |8080
Monitoring ]
i Protocol: | hitp w
ADN Security —
Mode: | clear K

MNode Management Security

Service Profiles Submit Cancel

Data to Enter
The Next Hop Domain Property page includes the entries described in Table 4-11.

Table 4-11 Entries on Next Hop Domain Property
Entry Description
Name Use the hostname or IP address of the destination and the port on which the host is

listening for messages.

ip_address:port or hostname:port

Address IP address or hostname for next hop device.
Port Port on which device is listening for next hop traffic.
Protocol One of the following protocols:
e http
e aonp
Mode Choose secure for encrypted or clear for unencrypted.

Node Capabilities

The Node Capabilities property enables you to configure reliable messaging on a node. Node
Capabilities is a device level property.

~

Note  If message delivery persistence is to be stored in a database, you must configure two databases before
you configure this property. See the *”’ section on page 4-6 for information on configuring a database.

How to Get There
¢ Go to Properties > Application > Node. Select a node, then click the Edit Properties button.

Figure 4-15 shows the Node Capabilities Property page.
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Figure 4-15 Node Capabilities Property

Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Application > Node > Edit Properties > Edit
Application Node Capabilities: Edit Property
Global
* Node
* :
Authentication & Name:ioetult
Authorization . . . 1
Message Delivery Semantics Persistence: | off |l
MSs
WCCP Service Group: |51
Monitoring
i Wait Timeout: | 10000
ADN Security
Node Management Security Message Store Database: MessageStoreDE Edit List
Service Profiles Multi-Blade Database: MultiBladeDB Edit List
Submit Cancel

Data to Enter
The Node Capabilities property page includes the entries described in Table 4-12.

Table 4-12 Node Capabilities Property Entries

Entry Description

Name Name of your choosing for this property.

Message Delivery Semantics ~ Choose off to disable Message Delivery Semantics Persistence.

Persistence Choose database to enable

WCCP Service Group Enter the WCCP service group for the virtual cluster configured for
multiblade ordered message delivery.

Wait Timeout Specified in milliseconds.

Message Store Database Click the Edit List button to choose an available Database. See the *”

section on page 4-6 to configure a database.

Multi-Blade Database Click the Edit List button to choose an available Database

Working with Adapters

You can use AMC to control how adapters function within your AON implemetation. You can also
configure additional properties and extensions for each adapter. For more details about adapters,
properties, and extensions, see the AON Programming Guide.

Adapter Registry

The Adapter Registry page enables you to manage the properties of both built-in and custom adapters.
You can activate or deactivate an adapter, change the start-up mode, and change the protocol to be used
by the adapter.
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How to Get There
Go to Properties > Adapter.

Figure 4-16 shows the Adapter Registry page.

Figure 4-16 Adapter Registry
Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Adapter > Global > Edit
* Global
e Adapter Reqgistry: Edit Property Set

Application

Authentication &
Authorization

IMS

Monitoring

ADN Security

Mode Management Security

Service Profiles

Adapter Listener Domain

* Mame

Class:

Pratocol:

Description:

Bundle:

Type:!

Is Active:

Startup Mode:

Qrigin:

Receiver Handler Class:
Send Handler Class:
Outbox Handler Class:
Configuration File:
Attribute Domains:
Mative Libraries:
Listener Info:

Protocol Aliases:
Extension Types:

Extension Info:

: aonp

com.cisco.aons.adapter.stream.aonp AONPAdapter

annp
Ernbedded

Itrue j
|Lenient j
Built-in

com.cisco.aons.adapter.strearn.aonp AONPReceiveHandler

com.cisco.aons.adapter.strearm.aonp AONP SendHandler

annp Edit List

Submit Cancel

Adapter Listener Domain enables you to configure the listening parameters of an adapter. You can
specify the port on which the adapter listens, and you can choose either clear or secure communication.
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How to Get There
Go to Properties > Application > Adapter Listener Domain.

Figure 4-17 shows the Adapter Listener Domain page. For more information about adapters, see the AON
Programming Guide.

Figure 4-17 Adapter Listener Domain
Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Application = Global = Edit
Application Adapter Listener Domain: Edit Property Set
» Global
Node

* Name: aonp
Authentication &

Authorization Port: I????

- Mode: [clear =l

Monitoring

AON Security Submit Cancel

Mode Management Security

Service Profiles

Service Profiles for Adapters

Service Profiles are used in conjunction with the development of custom bladelets and custom adapters.
Available services include the following:

e Compression

¢ Content Lookup

¢ Content Validation
e Encryption

e Signature

Developers can create profiles, which are sets of attributes that describe how the services listed above
are implemented in custom bladelets or adapters. Profiles contain multiple named contexts for a service,
and these profiles must be created in AMC in order for developers to access these contexts by name.

For more details about custom bladelets, custom adapters, and external services, see the AON
Programming Guide.
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How to Get There
Go to Properties > Service Profiles.

Figure 4-18 shows the Service Profile page.

Figure 4-18 Service Profiles
Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Service Profiles > Global
Application Service: Global Properties

Authentication &
Authorization

Categories

Juls Compression

Content Lookup

Content Validation

ADN Security Encryption

Signature Select a property category from the list on the left,

Monitoring

Mode Management Security

This will display all the instances of the
Service Profiles selected property category here,

* Global

Working with Message Transport

Encoding

The Encoding property enables you to configure AON nodes to compress outgoing traffic. Figure 4-19
shows the Encoding property page. After you configure an encoding property, that property is available
to ADS users. When message types are configured, each message type can be associated with an
encoding property.

Figure 4-19 Encoding Property
HNetwork Properties I Deploy T Monitor T Keystores T Admin -
Adapter Properties > Application > Node > Edit Properties > Edit

Application Encoding: Edit Property Set
Global

*N = B dingPoli
Authentication & clis Gk

Authorization

Request Encoding: | no gzip w
JMS
Response Encoding: | gzip w
Monitoring
ADN Security Submit Cancel

MNode Management Security

Service Profiles
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Data to Enter

The Encoding property page includes the entries described in Table 4-13.

Table 4-13 Encoding Property Entries

Entry Description

Name Name of your choosing for this property.

Request Encoding Choose the encoding for the request portion of the PEP.

Response Choose the encoding for the response portion of the PEP.
Encoding

Configuring JMS Properties

Use JMS properties to configure the way AON nodes handle JMS messages. You must configure JMS
properties in the following order:

1. JMS Destination Property, page 4-24
JMS Source Property, page 4-25

JMS Reply To, page 4-26

JMS Connections Property, page 4-27

a2 W DN

JMS Naming Property, page 4-28

JMS Destination Property
The JMS Destination Property enables you to specify a new destination for JMS messages.

How to Get There
¢ Go to Properties > JMS > Node. Select a node, then click the Edit Properties button.

Figure 4-20 shows the JMS Destination Property page.

Figure 4-20 JMS Destination Property

hd
Hetwork Properties I Deploy T Monitor T Keystores T Admin -

Adapter Properties > JM5 = Node > Edit Properties > Edit

Application Destinations: Edit Property Set

Authentication &
Authorization

* Name: JMSDestinationl
JMS

* Node Destination Name:

Monitoring Delivery Mode: | PERSISTEMNT i

ADN Security . s
Time To Live:
MNode Management Security
Priority:
Service Profiles

Submit Cancel
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Data to Enter

The JMS Destination Configuration page includes the entries described in Table 4-14.

Table 4-14 JMS Destination Configuration Entries

Entry Description

Name Name of your choosing for this configuration.

Destination name Name of the destination JMS broker.

Delivery Mode Choose PERSISTENT or NON_PERSISTENT as appropriate.

Time To Live Use the value specified by the JMS broker. This entry is required.

Priority Use the value specified by the JMS broker. This entry is required.
JMS Source Property

The JMS Source Property Page enables you to specify a new source for JMS messages. It requires you
to specify a JMS Destination, which you should have configured in the previous section.

How to Get There
¢ Go to Properties > JMS > Node. Select a node, then click the Edit Properties button.

Figure 4-21 shows the JMS Source Property page.

Figure 4-21 JMS Source Property

b
Network Properties I Deploy T Monitor T Keystores T Admin -

Adapter Properties > JM5 > Node > Edit Properties > Edit

Application Sources: Edit Property Set

Authentication &
Authorization

* Name: JMSSourcel

JMS
* Node Source Name:
Monitoring Batch Size:
AON Securit: " 8 1
v Ordering: | Required ]

MNode Management Security

Message Selector:
Service Profiles

Reliable Delivery: | Required K
Delivery Failure Policy: |Rollback & stop this source [v]
Destination: JMSDestinationl Edit List
Submit Cancel

Data to Enter
The JMS Source Configuration page includes the entries described in Table 4-15.

Table 4-15 JMS Source Configuration Entries

Entry Description

Name Name of your choosing for this configuration.
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Table 4-15 JMS Source Configuration Entries (continued)
Entry Description
Source Name Name of the source sending JMS messages.
Batch Size Default is zero.
Ordering Choose Required if ordered message delivery is required.
Message Selector Enter a header entry or property reference that is to be used to identify
messages of interest.
Reliable Delivery Specify if reliable delivery is required.
Delivery Failure Select the appropriate action to take if messages fail to be delivered.
Property
Destination Click the Edit List button to choose an available JMS Destination property.

JMS Reply To

The JMS ReplyTo property enables you to specify a new reply queue to be used by JMS clients.

How to Get There

¢ Go to Properties > JMS > Node. Select a node, then click the Edit Properties button.

Figure 4-22 shows the JMS Reply To Property page.

Figure 4-22 JMS Reply To Property

Network Properties Deploy Monitor Keystores Admin
Adapter Properties > JM5 > Node > Edit Properties > Edit
Application ReplyTos: Edit Property Set
Authentication &
Authorization
* Name: JMSReplyTol
JMS DV
» Node ReplyTo Name:
Monitering Definition Type: | Template v
AON Securit: . . % ]
Y Reliable Delivery: | Required R
MNode Management Security .
Ordering: | Required w
Service Profiles o
Batch Size:
Number of Queues:
Submit Cancel

Data to Enter
The JMS Reply To Property page includes the entries described in Table 4-16.

Table 4-16 JMS Reply To Property Entries

Entry Description
Name Name of your choosing for this property.
ReplyTo Name Name of the ReplyTo.
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Table 4-16 JMS Reply To Property Entries (continued)

Entry Description

Definition Type Choose Template or Static.

Reliable Delivery Specify if reliable delivery is required.

Ordering Choose Required if ordered message delivery is required.
Batch Size Size of batch count.

Number of Queues Enter number of queues.

JMS Connections Property

How to Get There
¢ Go to Properties > JMS > Node. Select a node, then click the Edit Properties button.

Figure 4-22 shows the JMS Connection Property page.

Figure 4-23 JMS Connection Property

Hetwork J Properties I Deploy Monitor Keystores Admin

Adapter Properties > JM5 > Node > Edit Properties > Edit

Application Connections: Edit Property Set

Authentication &
Authorization

* Name: JMSConnectionsl

JMS
¥ Node Source Name:
Monitoring Type: | Topic =
ADN Security
User:
MNode Management Security
Password:
Service Profiles
Wendor Name: | MGQ R

Dead Letter Destination:

Transaction Queue:

ReplyTo List: JMSReplyTol Edit List
Destination List: JMSDestinationl Edit List
Source List : JMSSourcel Edit List

Destination Batch Size:

Destination Batch Interval:

Submit Cancel

Data to Enter
The JMS Connection Property page includes the entries described in Table 4-17.

Table 4-17 JMS Connection Configuration Entries
Entry Description
NAME Name of your choosing for this connection configuration.
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Table 4-17 JMS Connection Configuration Entries (continued)
Entry Description
Source Name Name of the JMS broker.
Type Choose Topic or queue.
User Enter the user name if one is required by the JMS broker.
Password Enter the password if one is required by the JMS broker.
Vendor Name Choose MQ or Tibco from the drop-down list.
Dead Letter Destination Specify the queue where AON can store undeliverable messages.
Transaction queue Specify the transaction queue.
Reply To List Click the Edit List button to make a selection.
Destination List Click the Edit List button to make a selection.
Source List Click the Edit List button to make a selection.
Destination Batch Size Size of the batch at the destination broker.
Destination Batch Interval Specified in milliseconds.

JMS Naming Property

Figure 4-22 shows the JMS Naming Property Page.

~

Note  Before configuring this property, go to Admin > Extensions > JMS Resources to upload a JMS
resource file. See the AON Programming Guide for information on creating a JMS resource file.

AON Installation and Administration Guide
| 4-28 | |



| Chapter4 Managing AON Properties

Working with Message Transport ||

Figure 4-24 JMS Naming Property

Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > JM5 > Node > Edit Properties > New

Application Naming: Add New Property Set
Authentication &
Authorization

* Name:
JMS

» Node Naming Service: | Remote ¥
T ) IMS Resource File: IMSResourcel Edit List

ADN Security
Initial Context Factory:
MNode Management Security

Service Profiles Provider URL:
Security Protocol:
Security Authentication:
Authoritative:

URL Package Prefixes:
State Factories:
Language:

Batch Size:

Security Principal:
Object Factories:
Referral:

Security Credential:

DNS URL:

Connection List: JMSConnections1 Edit List

Submit Cancel

Data to Enter
The JMS Naming Property page includes the entries described in Table 4-18.

Table 4-18 Entries on JMS Naming Property

Entry Description

Name Name of your choosing for this property.

Naming Service Choose remote or local.

JMS Resource File Click the Edit List button so select the file you have uploaded to
AMC.

Initial Context Factory Constant that holds the name of the environment property for
specifying the initial context factory to use.

Provider URL Constant that holds the name of the environment property for
specifying configuration information for the service provider to
use.

Security Protocol Constant that holds the name of the environment property for

specifying the security protocol to use.
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Table 4-18 Entries on JMS Naming Property (continued)

Entry

Description

Security Authentication

Constant that holds the name of the environment property for
specifying the security level to use

Authoritative

Constant that holds the name of the environment property for
specifying the authoritativeness of the service requested.

URL Package Prefixes

Constant that holds the name of the environment property for
specifying the list of package prefixes to use when loading in
URL context factories.

State Factories

Constant that holds the name of the environment property for
specifying the list of state factories to use.

Language Constant that holds the name of the environment property for
specifying the preferred language to use with the service.
Batch Size Constant that holds the name of the environment property for

specifying the batch size to use when returning data via the
service's protocol.

Security Principal

Constant that holds the name of the environment property for
specifying the identity of the principal for authenticating the
caller to the service.

Object Factories

Constant that holds the name of the environment property for
specifying the list of object factories to use.

Referral

Constant that holds the name of the environment property for
specifying how referrals encountered by the service provider are
to be processed.

Security Credentials

Constant that holds the name of the environment property for
specifying the credentials of the principal for authenticating the
caller to the service.

DNS URL

Constant that holds the name of the environment property for
specifying the DNS host and domain names to use for the JNDI
URL context.

Connection List

Click the Edit List button to choose a JMS Connections property.

Configuring Cisco AON Promiscuous Mode

Promiscuous mode (PMode) enables out-of-band message processing using a Cisco AON node. It
provides the capability to receive and process messages without introducing latency in the flow of inline
network traffic, supporting out-of-band monitoring and analysis.

Prerequisites for Promiscuous Mode

e Ensure that AMC and all AON nodes are correctly configured and running.

¢ Ensure that any nodes to be used in this procedure are active on AMC.

¢ Ensure that you have available a valid framing extension. HTTP framing extensions, in addition to
FIX extensions, are available for download with other AON software.
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e Ensure that the switch or router that hosts any node using PMode meets the requirements in

Table 19.
Table 19 PMode Operating System Requirements
Platform Required Operating System
AON-SM with Supervisor Engine 2 Catalyst OS Release 8.5(3) recommended
Note  Minimum requirement is Catalyst OS Release
8.4(2a).
AON-SM with Supervisor Engine 720 PMode not supported
AON-NM Cisco IOS Release 12.3(14)T1

Information About Promiscuous Mode

Promiscuous mode allows for message traffic monitoring without affecting traffic flow. When
promiscuous mode is enabled, message packets are duplicated in the node and forwarded, in the form of
framed application messages, to a third-party application. The forwarded messages can be analyzed or
otherwise processed. Figure 25 shows a sample runtime topology where an AON node is using PMode
to forward traffic to a traffic analyzer.

Figure 25 Promiscuous Mode Sample Topology
AON node configured
for Pmode
A A—
O o R — =]
— —
Client Server
|
a)
y 4
D GREEEED > Message traffic Traffic 3
analyzer S

<—> Duplicate traffic

The sample topology shown in Figure 25 requires the following runtime components:

¢ Client—sends traffic to the server. The client is configured with a default gateway IP address that
is assigned to an interface on the router hosting the AON node.

e Server—receives traffic from the client through the AON node. The server is configured with the
default gateway IP address of the router interface into which it connects.

¢ AON node—the router or switch, configured with IP addresses and port numbers for the traffic to
be captured. The node makes copies of this traffic and passes it to AON. AON in turn processes these
messages, packages them into AON monitoring messages (AMM), and sends them to the analyzer.
Depending on the node’s location in the network, the AON node requires a specific IP and VLAN
configuration to perform this function.

e Traffic analyzer—receives duplicate traffic from the AON node. The analyzer is a third-party or
customer-provided component. It is not part of the AON product.
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Pmode Deployment Options

Note

Note

You can run promiscuous mode both on AON-NM and on AON-SM.

When you use AMC to deploy PMode on an AON-NM, PMode is enabled, by default, on the external
interface—with the option of changing to an internal monitoring interface. You can choose to use either
of the interfaces, or set up a deployment that uses both interfaces simultaneously. For information on
changing to an internal monitoring interface, see the section Enabling the Internal Interface on an
AON-NM, page 4-32.

When you use AMC to deploy PMode on an AON-SM, PMode is enabled on Gigabit Ethernet 3, a
deployment for which you must configure either SPAN or VACL for forwarding the traffic.

For copying traffic to AON, you can select from the following options:
e Configure RITE (Router IP Traffic Export) at the router.
e Use SPAN or VACL in a switch to capture and direct traffic to AON.

When using RITE, AON can reside in the same router as that you configure for RITE, or it can reside in
a separate router—if in a separate router it must be within the same VLAN.

To configure RITE, see the following:

e http://www.cisco.com/en/US/products/ps6350/products_configuration_guide_chapter09186a008045
5b94.html

To configure either SPAN or VACL see the following:
e SPAN—http://www.cisco.com/warp/public/473/41 . html
¢ VACL—http://www.cisco.com/univercd/cc/td/doc/product/lan/cat6000/122sx/swcg/vacl.htm

Use either SPAN or VACL, but not both.

For information on SPAN and on VACL configurations, see the following documents:
e SPAN—http://www.cisco.com/warp/public/473/41.html
¢ VACL—http://www.cisco.com/univercd/cc/td/doc/product/lan/cat6000/122sx/swcg/vacl.htm

How to Configure Promiscuous Mode

PMode configuration involves the following:
¢ Enabling the Internal Interface on an AON-NM, page 4-32 (optional)
¢ Configuring PMode Adapter on AMC, page 4-33 (required)

Enabling the Internal Interface on an AON-NM

Step 1

This optional procedure is required only if you are enabling PMode on the internal interface of an
AON-NM. To configure this, complete the following steps.

Establish a session to the AON-NM and enter configuration terminal mode.

aon-nm> configuration terminal
Enter configuration commands, one per line. End with exit.
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Step2  Use the aon monitoring interface command to enable the internal interface.

aon-nm(config)>aon monitoring interface internal

Step3  Exit configuration terminal mode.

aon-nm(config)>exit

Configuring PMode Adapter on AMC

Activate the Cisco AON PMode adapter by performing the following steps.

Step 1 Click the Properties tab in the top menu of AMC.

Step2  Click Global in the Adapter menu on the left side of the window. The global properties of each
registered adapter are displayed as shown in Figure 26.

Step3  Make sure PMode adapter is checked. On the bottom part of the window, click Edit to display the Edit
Property Set window.

Figure 26 Enabling the PMode Adapter: Properties
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Adapter Properties » Adapter > Global
¢ s:::l Adapter Registry: Global Properties
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Service Profiles
Edit Properties Extensions

U
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Step4  In the Is Active field, choose true as shown in Figure 27.
Figure 27 Enabling the PMode Adapter: Edit Property Set
Cigco SysTEms
. AON Management Console
Network Properties | Moniter HKeystores
Adapter Properties > Adapter > Clebal » Bdit
* Glabal
Adapter Registry: Edit Property Set
Mode
Application
Authentication & i
Authorization MName: priode
Ms Class: com.cisco,aons.adapter. pmode.
PriadeStandaloneadapter
Maonitoring
" AON ‘)ccurltrﬂ Protacol: pmade
Mode Management Security Desciiation:
service Profiles
Bundle: Prmodeadapter
Type: Standalone
® Is Active: |tue ~
* Startup Mode: | Strict w
Crigin: Built-in
Receiver Handler Class:
Send Handler Class:
Outbox Handler Class: com.cisco.aons.adapter, pmode.
ProdeCutboundDispatcher
Configuration File:
Attribute Domains: com.cisco.aons.policies.adapter.PmodeAdapter;
com.cisco, aons. policies. adapter.PmodeAdapterExtension
Native Libranes:
Listenar Info: Edit List
Protocol Aliases:
Extension Types: Destination
Extension Info: FIX-FRAMING-EXTN-1
Su%il Cancel
Step5  Click Submit.

Configuring the PMode Adapter

To configure the PMode adapter and deploy the changes to the node, perform the following steps:

Step 1 Click on the Properties Tab in the top menu of AMC.
Step2  Select the Adapter menu in the left pane.
Step3  Select the sub-menu Global under Adapter.

AON Installation and Administration Guide




Chapter 4

Managing AON Properties

Working with Message Transport ||

Stepd  Select PMode.
Step5  Click the Properties button, as shown in Figure 28.

Figure 28  Configuring the PMode Adapter: Global Properties

ON Management Console
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Step6  Select PmodeAdapter under Categories.
Step7  Click on New, as shown in Figure 29.

Figure 29  Configuring the PMode Adapter: Creating New Property Set

@ou Management Console Logout about

Netwerk Properties | Meniter | HKeystores | Admin
Adapter Properties > Adapter » Global > Properties > Edit Properties
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Monitoring
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Step8  Enter the name as default.

A

Warning If you enter a name other than “default,” the configuration will fail.
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Step9  Enter the Default Destination port as 5011 for our example.
Step 10  Enter the Default Destination IP as the IP address of the analyzer.
Step11  Click Submit.

Figure 30  Configuring the PMode Adapter: Configuring New Property Set
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Service Profiles :

Step12  Click the Deploy Tab in the top menu of AMC.
Step13  Click Manage Staging on the menu in the left window.

Step 14  Notice a Global Deployment Request. Select the Global deployment request and click Stage as shown
below.

Figure 31  Configuring the PMode Adapter: Staging New Property Set

C1sco SYSTEMS
e ON Management Console Logout | Help | ahout
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Deployment Requests Deploy > Deployment Requests > Manage Staging
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Details Stage {b Unstage Delete

s Mo Mode Deployment Requests Awvailable

Step15  Click on Manage Deployment in the menu in the left window.

Step16  Select the Global deployment Request and click Deploy.
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Figure 32  Configuring the PMode Adapter: Deploying New Property Set
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Once deployed, a message ‘Successfully deployed all configurations to the node’ displays.

Loading the HTTP Extension

To load the HTTP extension, perform the following steps:

Step1  Click Admin tab on the top right of the window of AMC.
Step2  On the left side window, click Adapter Extension Packages in the Extensions menu.

Step3  Click Upload as shown below.

Figure 33  Loading HTTP Extension: Uploading Package
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Step 4

Step 5

In the Package to Upload field, browse to the location of the HTTPAdapterExtPackage.jar file, then
click the Upload button.

Figure 34

Loading HTTP Extension: Uploading Extension
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Click Register on the Upload and Register Package window.

Figure 35

Loading HTTP Extension: Registering Extension
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The AON HTTP Extension is registered, as shown in Figure 36.

Figure 36  Loading HTTP Extension: Registering Package
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Enabling the HTTP Extension

To enable the HTTP Extension, perform the following steps:

Step 1 Click the Properties tab on the top of the window.
Step 2 On the left hand side of the window, click Global in the Adapter menu.

Step 3 Select the PMode radio button, then click the Extensions button, as shown in Figure 37.

Figure 37  Enabling HTTP Extension
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The PMode Adapter Extensions: Global Properties window displays.
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Step4d  Select the HTTP-FRAMING-EXTN-1 radio button, then click the Edit button as shown in Figure 38.

Figure 38  Enabling HTTP Extension: Editing Extension

G150 SYSTEMS

ON Management Console Logout | Help |
Network Properties Monitor Keystores
Adapter Properties » Adapter » Global = Extensions
» Global ; _
kg pmode Adapter Extension: Global Properties
Application # Name Scope
Authentication & i = = -
iy b e e 1 #% HTTRP-FRAMING-EXTN-1 &
IMS RonsPage [ 10 [FY Page[ 141 [E 44 b M
Monitoring
Edit Properties
ADN Security \(b L

Node Management Security

< Back

Service Profiles

Step5 The Adapter Extension Registry: Edit Property Set window displays. In the Is Active field choose
True, then click the Submit button, as shown in Figure 39.

The adapter extension is now activated.

Figure 39  Enabling HTTP Extension: Editing Extension
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Configuring HTTP Extension

To configure the HTTP Extension, perform the following steps:

Step1  Click on the Properties Tab.

Step2  Make sure that Global is selected under Adapter menu in the left hand pane. Select the PMode radio
button, then click the Properties button, as shown in Figure 40.

Figure 40  Configuring HTTP Extension: Selecting PMode Adapter
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Adapter Properties > Adapter > Global
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Edit Properies Extensions

Step3  Select PmodeAdapterExtension and click the New button.

Figure 41  Configuring HTTP Framing Extension: Creating New Property Set
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Step4  Enter a name for this extension, then click the Edit List button.
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Step 5

Figure 42

Configuring HTTP Framing Extension: Creating New Extension
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Select HTTP-FRAMING-EXTN-1, click the Save button, then click the Submit button.

Figure 43
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Figure 44  Configuring HTTP Framing Extension: Creating New Extension

C1sco SysTEMS
mm AON Management Console Logout | Help | about
Netweork Properties Deploy Meniter Keystores
Adapter Properties > Adapter > Global > Properties > Edit Properties > Edit
* Global
N:d: PmodeAdapterExtension: Edit Property Set
Application
Authentication & i
Authorization RN
IMs * Extensionlink: HTTP-FRAMING-EXTH-1 Edit List
Monitoring
Submit Cancel

ADN Security

Node Management Security

Service Profiles

Step6  Click the Deploy Tab in the top menu of AMC.
Step7  Click Manage Staging on the menu in the left window.

Step8  Notice a new Global Deployment Request. Select the Global deployment request and click Stage as
shown below.

Figure 45  Configuring the PMode Adapter: Staging New Property Set
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Step9  Click on Manage Deployment in the menu in the left window.

Step10  Select the Global deployment Request and click Deploy.
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Figure 46  Configuring the PMode Adapter: Deploying New Property Set
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Once deployed a message ‘Successfully deployed all configurations to the node’ is displayed.
Step 11  Click the Properties tab on the top right window of AMC.
Step12  Ensure that the Adapter menu is selected on the left pane.
Step13  Click on the Node sub-menu under Adapter.
Step14  Select the AON node for which to configure the connection.
Step15 Click on Edit Properties button.

Figure 47  Configuring HTTP Framing Extension: Edit Node Adapter Properties
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Step16  Select the PMode property from the list of Node Properties for the AON node.
Step17  Click on the Extensions button.
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Figure 48  Configuring HTTP Framing Extension: Edit Node Adapter Properties
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Step18 Select HTTP-FRAMING-EXTN-1 and then click the Properties button.

Figure 49  Configuring HTTP Framing Extension: Edit Node Adapter Properties
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Step 19

Step 20
Step 21
Step 22
Step 23

Step 24

Under Categories select HTTPExtension and click New.

Figure 50
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Configuring HTTP Framing Extension: Edit Node Adapter Properties
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For Name, enter a name for the connection—Connectionl in the example

For Monitored IP, enter the IP address of the Server machine—10.221.1.14 in the example.
For Mask, enter 255.255.255.255

For Monitored Port, enter the value of the port to monitor—while 9000 is used in the example below,

the default value is 80.

Click the Edit List button next to AdapterExtPolicyLink.

Figure 51

Configuring HTTP Framing Extension: Edit Node Adapter Properties
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Step25 Select the HTTP_EXTN and click Save.

Figure 52  Configuring HTTP Framing Extension: Edit Node Adapter Properties
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Step26 Review your entries and click the Submit button.

Figure 53  Configuring HTTP Framing Extension: Edit Node Adapter Properties
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Step 27  Select the Deploy Tab.
Step28 Notice a listing under Open Node Deployment Requests. Stage the request by clicking Stage.
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Figure 54  Configuring HTTP Framing Extension: Staging Deployment Request
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Step29 Select Manage Deployment in the left hand window and select the deployment request, then deploy it
by clicking Deploy.

Figure 55  Configuring HTTP Framing Extension: Deploying the Request
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Once the request is successfully deployed, a message ‘Successfully deployed configuration to node’
displays.

Step30 Establish a session to the AON node and restart it as follows:

aon-node> enable

aon-node# aon restart force

CAUTION! Stopping all AON processes!
Are you sure[nl? y

Note  The PMode configuration will take affect once the node is restarted.

To validate that the extension is successfully deployed, check the AON log files. For instructions on
viewing logs, see Chapter 3, “Viewing Logs”.
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Connecting to Databases

Database properties enable AON to read and write to databases. For example, PEPs that use the Log
bladelet need a database property that tells AON where to write log data. This is a global property.
Figure 4-56 shows the Database Property page.

Figure 4-56 Database Property

b
Hetwork Properties I Deploy T Monitor T Keystores T Admin -

Adapter Properties > Application > Global > New
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Node
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Service Profiles Submit Cancel

Data to Enter
The Database Property page includes the entries described in Table 4-20.

Table 4-20 Entries on Database Property

Entry Description

Name Name of your choosing for this database property

User ID User ID required to log on to the database. The user must have permission to create,

read, write, update, and query the database.

Password Password required to log on to the database

JDBC URL Location of database. This entry must use one of the following formats:\
Oracle: jdbc:oracle:thin: @ip_address:port:database_name

Sybase: jdbc:sybase:Tds: ip_address:portldatabase_name

Database One of the following:
fame e Oracle
e Sybase

Actions to Take
After completing the entries, you can take one of the following actions:

¢ Click Submit to save your changes.

Click Cancel to discard your changes and return to the previous screen.

AON Installation and Administration Guide B



Chapter4 Managing AON Properties |

I Connecting to Databases

AON Installation and Administration Guide
| 4-50 | |



Managing AON Security

This chapter describes AON functions relating to security, authentication, and authorization. It includes
the following topics.

e Managing AON Users, page 5-1
e Managing Keystores, page 5-10
e Configuring Security Properties, page 5-20

e Configuring Authentication and Authorization Properties, page 5-24

Managing AON Users

AMC users fall into one of the following categories:
e Local users—these users are created and managed within AMC.

e External users—these users are created on and managed by an external LDAP server.

Note A new installation of AMC includes five local users with aonsadmin as their default password. To
ensure that only authorized personnel have access to the AMC, change the default passwords or delete
unneeded users.

Managing Local Users

Local users are created and managed by the AMC. You can use the Manage Local Users page to perform
the following tasks:

e Add and delete users
e Display information about users
e Edit a user’s information, including privileges.

¢ Change a user’s password

AON Installation and Administration Guide
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How to Get There
Go to Admin > Users > Manage Local Users. Figure 5-1 shows this page

Figure 5-1 Manage AMC Local Users
- - h| o
Licensing Admin > Users > Manage Local Users
Users Manage Local Users

* Manage Local Users _ 0

# Login ID First Name Last Name
Manage External Users
1 @ acnsadmin AONS Adrministrator
AMLC Security
2 designer ACNS Designer
Extensions o = &
Node Migration 3 ¢ netadmin ACNS Netddmin
4 e secadmin AONS SecurityAdmin
5 e appadmin AONS AppAdmin
RewsPage| 10 [E Page[ 171 [ 4 4 p M
Hew Show Edit Password Delete

Actions to Take
Click one of the following buttons:
e New—creates a new users. See Creating New Users, page 5-3
e Show—displays information on the selected user. See Displaying Information on Users, page 5-4
e Edit—changes information about the selected user. See Editing Users, page 5-5
e Password—changes the password of the selected user.

¢ Delete—removes the selected user from the system.
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Creating New Users

AMC enables you to create new local users.

How to Get There
Go to Admin > Users > Manage Local Users, then click the New button. Figure 5-2 shows the New
User page.
Figure 5-2 New User
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage Local Users > New
Users Mew User

* Manage Local Users

Manage External Users

Login ID: |U88r1
AMC Security
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Password: quu
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Roles: [ipplicationAdministrator

ApplicationDesigner
We mini or

Submit Cancel

Actions to Take

Enter the appropriate information for the user and select a role. Use Control+click to select multiple
roles. For description of available roles, see Assigning Roles to Users, page 5-5.

After completing the entries, click the Submit button to save your changes.
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Displaying Information on Users

You can use AMC to display information on a selected user, including name, email address, and roles
assigned.

How to Get There

Go to Admin > Users > Manage Local Users, then select a user. Click the Show button to display the
information. Figure 5-3 shows the Show User Details page.

Figure 5-3 Show User Details
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage Local Users = Show
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AMC provides the ability to edit the properties of local users.

How to Get There

Go to Admin > Users > Manage Local Users, then select a user. Click the Edit button. Figure 5-4 shows
the Edit Local User page.

Figure 5-4 Edit Local User
_ Hetwork 1 Properties 1 Deploy T Monitor 1 Keystores Admin _
Licensing Admin > Users > Manage Local Users > Edit
Users Edit User

* Manage Local Users

Manage External Users

Login ID: aonsadmin
AMC Security

. First Name: IAONS
Extensions

Node Migration Last Name: IAdminiStratDr

Email Address: I

Roles:

Submit Cancel

Actions to Take

Make changes as necessary, then click the Submit button to save your changes.

Assigning Roles to Users

AMC users can be given roles based on their need to perform certain actions on AMC. Each role grants
specific privileges within AMC. For example, the Application Designer role can only upload extensions
to the AMC, however, a Network Administrator can access functions related to managing and monitoring
nodes. To give a user full access to AMC, assign all four roles to that user. Table 5-1 shows the roles
available in AMC, and the sections on each tab these roles can access.

Table 5-1 AMC User Roles
Role Network Tab Properties Tab Deploy Tab |Monitor Tab |Keystores Tab Admin Tab
Application — e Adapter e All e All — e All
Administrator « Application

e JMS

e Monitoring

e Service Profiles
Application — — — — — e Extensions
Designer
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Table 5-1 AMC User Roles (continued)
Role Network Tab Properties Tab Deploy Tab |Monitor Tab |Keystores Tab Admin Tab
Network e All e Monitoring — e All — —
Administrator
Security — e Authentication — e Al e All e Users
Administrator and Authorization e AMC

e Security Security

To assign roles to a user, see one of the following sections:
e Creating New Users, page 5-3

e Editing Users, page 5-5

e Assigning Roles to External Users, page 5-8

Managing External Users

AMC provides the ability to use an existing LDAP server for user management. To do this, complete the
following tasks in the order specified:

1. Creating an LDAP Profile, page 5-6
2. Assigning Roles to External Users, page 5-8

3. Creating an Authentication Realm, page 5-9

Creating an LDAP Profile

An LDAP profile provides the information needed by AMC to retrieve user data from an existing LDAP
server.
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How to Get There

Go to Admin > Users > Manage Local Users > LDAP, then click the New button. Figure 5-5 shows the
LDAP page.

Figure 5-5 LDAP Property Set
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users » Manage External Users = New
Users LDAP: Add New Property Set

Manage Local Users

» Manage External Users

* Mame: I
AMLC Security

Extensions Primary LDAP Server: I

Node Migration Backup LDAP Server: I

Connection Maximurn Retry: I

Connection Timeout (in seconds): I

Server Port: I

Authentication Type: Isimple j

Connect DR I

Connect Password: I

UID Attribute: |

Base DM I

User Object Class: I

Submit Cancel

Actions to Take

Complete the entries as appropriate for the LDAP server being used. Contact your LDAP administrator
for details.
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Assigning Roles to External Users

How to Get There

Go to Admin > Users > Manage Local Users > Role Mapping, then click the New button. Figure 5-6
shows the Role Mapping page.

Figure 5-6 Role Mapping
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage External Users > New
Users Role Mapping: Add New Property Set

Manage Local Users

* Manage External Users

* Mame: I
AMC Security

) LDAP Attribute Name: |
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LDAP Attribute Value: |

Aszsign Roles: Edit List

Submit Cancel
Data to Enter
Table 5-2 shows the entries of the Role Mapping page.
Table 5-2 Role Mapping Entries
Entry Description
Name Name of your choosing for this property set.
LDAP Attribute Name The LDAP attribute that is to be used to specify the AMC role.
Condition Operator Choose one of the following from the drop-down list:

e equals—information retrieved from LDAP server must match exactly
with LDAP attribute value specified below.

e contains—information retrieved from LDAP server must contain
LDAP attribute value specified below.

e defineRoles—information retrieved from LDAP will define the role of
the user.

LDAP Attribute Value The value for the attribute specified above.

Assign Roles Click the Edit List button to choose roles that are to be assigned to users
who match the LDAP attribute. See “AMC User Roles”

Actions to Take

After completing the entries, click the Submit button to save your changes.
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Creating an Authentication Realm

The LDAP Authentication Realm binds the LDAP information specified in the “Creating an LDAP
Profile” section on page 5-6 with the role mapping information specified in “Assigning Roles to External
Users” section on page 5-8.

How to Get There

Admin > Users > Manage Local Users > Authentication Realm, then click the New button. Figure 5-7
shows the Authentication Realm page.

Figure 5-7 Authentication Realm
Hetwork Properties Deploy Maonitor Keystores Admin
Licensing Admin > Users > Manage External Users > New
Users Authentication Realm: Add New Property Set

Manage Local Users

F Manage External Users

* Mame: I
AMLC Security

N Realm Mame: I
Extensions

MNode Migration LDAP Connection Profile: I j

Role Mapping Palicies; Edit List

Submit Cancel

Data to Enter
Table 5-3 dispalys definitions for the editable properties displayed on the Authentication Realm page.

Table 5-3 Authentication Realm

Entry Description

Name Name of your choosing for this property set.
Realm Name Name of your choosing for the realm.

LDAP Connection Choose an available LDAP profile from the drop-down list. See the “Creating an

Profile LDAP Profile” section on page 5-6 to create a new profile.
Role Mapping Click the Edit List button to select from the available Role Mapping property sets.
Policies See the “Assigning Roles to External Users” section on page 5-8 to create a new

property set.

Actions to Take

After completing the entries, click the Submit button to save your changes. Once you completed this
task, the LDAP configuration appears in the drop-down list on the AMC log-in page.
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Managing Keystores

The Keystore tab is used for managing the keypairs, trustpoints, and root certificates used in the AON
network. See the following sections:

e Configuring a Keystore Passphrase, page 5-10
e Managing Keypairs, page 5-10
e Manage Public Certificates or Root Certificates, page 5-18

Configuring a Keystore Passphrase

When AMC is started for the first time, the global keystores used by AMC are automatically created with
the passphrase aonsadmin. To ensure the security of the keystores, it is recommended that you
immediately change this password.

Managing Keypairs
Keypairs are the public and private keys used by devices in the AON network to encrypt messages. Most

keypair management tasks are performed in the Active Repository. AMC also includes a keypair archive,
for expired or revoked keypairs.

How to Get There

Go to Keystores > Keypairs > Active Repository. This opens the Keypair Active Repository (see

Figure 5-8).
Figure 5-8 Keypair Active Repository

Keypairs Keystores > Keypairs > Active Repository

¥ Active Repository . . .
Keypair Active Repository

Archive
Alias Type Mot Valid Before Mot Valid After Actions
Public Certificates
arnc-test b2 Apr 1, 2005 Apr 1, 2015 Shaw | Archive
Root Certificates
Romxsa’PageI N Go | Pagel 101 [ 440 M

Configuration

(%) Key, :i] Certificate

Upload PKCS#12 MPKI Keypair Self-Signed Keypair SSL Certificate Import Keystore

Actions to Take

You can perform any of the following actions:
e Upload a PCKS#12 file. See the “Upload PKCS#12” section on page 5-11.

e Generate and register a MPKI Keypair. See the “Generate and Register a New Key” section on
page 5-12.

e Generate a self-signed keypair. See the “Generate a Self-Signed Keypair and Certificate” section on
page 5-13.
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e Add an SSL Certificate. See the “Generate an SSL Certificate” section on page 5-14.

e Import a keystore from another source. See the “Import a Keypair or Keystore” section on page 5-17.

PKCS#12 is a standard for securely storing private keys and certificates. You can upload a PKCS#12 file
(with a .pfx file extension) containing this information.

How to Get There
Go to Keystores > Keypairs > Active Repository > Upload PKCS#12. See Figure 5-9.

Figure 5-9 Upload a PKCS#12 File

Hetwork Properties Deploy Monitor Keystores m

Keypairs Keystores > Keypairs > Active Repository > Upload PKCS#12
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Upload PKCS# 12 File (.pf:x)

Archive

Public Certificates
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PKCS#1Z File: B
Configuration e I TOWEE |

Password: I

Submit Cancel

Data to Enter
The Upload PKCS#12 File page includes the entries described in Table 5-4.

Table 5-4 Upload PKCS#12 File Entries
Entry Description
Alias Name of your choosing for this key.

PKCS#12 file Full path and file name. Click the Browse button to locate the file to be imported. The
file must have a .pfx extension.

Password Password used to secure the key.

Actions to Take
After completing the entries, you can take one of the following actions:
¢ Click Submit to save your changes and upload the file.

¢ Click Cancel to discard your changes and return to the previous screen.
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Generate and Register a New Key

If you have a managed public key infrastructure (PKI) account with Verisign, you can use AMC to
generate and register a new key.

How to Get There
Go to Keystores > Keypairs > Active Repository > MPKI Keypair. See Figure 5-10.

Figure 5-10 Generate and Register a New Key
Keypairs Keystores > Keypairs > Active Repository > MPKI Keypair
F Active Repository .
Archive %‘rlmgn'

Public Certificates Generate and Register Key

Register a generated key in your Managed PKI account. Any registered keys can be validated by your

Root Certificates business partners.

Configuration

Managed PKI Information

Contact your Managed PKI administrator for key name and passcode,

Key Name:

vour Key Mame will look similar to this: http:f fakms.verisign.comfkeyname?
jurisdiction=d7ea68c518b2602ca4bbc....
Cut and paste the entire string into the Key Name field,

Passcode:

Description

Key alias: I (Lawer-case characters only)

Revocation Password: I

Confirm Revocation Password: I

®KMS Service: & praduction  pilat

Submit Cancel

What to Enter
The Generate and Register Key page includes the entries described in Table 5-5.

Table 5-5 Generate and Register Key Entries

Entry Description

Key name The key name is provided by your managed PKI administrator. It looks similar to the
following:

http://xkms.verisign.com/keyname?jurisdiction=d7ea68c518b2602ca4bbc....

Passcode The passcode is provided by your managed PKI administrator.
Key alias Name of your choosing for this key. Lower case characters only.
Revocation Enter a password to be used should this key need to be revoked.
password

XKMS service Click Pilot for pre-production environments. Click Production for production
environments.

AON Installation and Administration Guide
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Generate a Self-Signed Keypair and Certificate

If you do not need a key validated by third parties or business partners, AMC can generate a key without
a managed PKI account.

How to Get There
Go to Keystores > Keypairs > Active Repository> Self-Signed Keypair. See Figure 5-11.

Figure 5-11 Generate a Self-signed Keypair and Certificate
Hetwork Properties Deploy Monitor Keystores m
Keypairs Keystores > Keypairs > Active Repository > MPKI Keypair > Self-Signed Keypair

F Active Repository

kb Generate Self-signed Keypair and Certificate

Public Certificates

Alias I
Root Certificates

T T Modulus Length |1024 'l

Algorithm |MDSwithRSA 4|
Validity |365 (days)
Common Mame {CH) I {e.q. my.host.name}
Organizational Unit {OU) I {e.g. Human Resources)
Organization (0} I {e.q. Cisco Systems)
Location (L) I {e.g. San Jose)
State (ST I {e.q. California)
Country (C) l— {e.g. US)
Ernail I

Submit Cancel

Data to Enter

Complete the entries as required for your organization and click the Submit button.
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Generate an SSL Certificate

AMC includes the ability to submit a Certificate Signing Request (CSR) to Verisign. This request can be
for a free trial certificate valid for 14 days, or if you are a MPKI SSL customer, it can be for a permanent

certificate.
How to Get There
Go to Keystores > Keypairs > Active Repository > SSL Certificate. This page is shown in
Figure 5-12.
Figure 5-12 Generate a Key for an SSL Server ID
Keypairs Keystores > Keypairs > Active Repository > 551 Certificate > Next
F Active Repository
Archive %‘I’iSign'

Public Certificates Generate Key for SSL Server ID

Root Certificates The fields below will comprise the subject of the ¥.509 SSL certificate.

Configuration

Keystore: ProdkeyStore

Alias:

Type: @ Tyial  praduction

rou may obtain a free 14-day trial S5L Server ID or purchase a production
SE5L Server ID, If you are an MPKI for SSL custormner, select production, The
enrollment process will direct you to your MPEI for S5L enrollment form.

Common Mame {CH) {e.q. my.host.name}

Organizational Unit {OU) {e.q. Human Resources)

Location (L) {e.q. San Jose)

3
3
Organization (0): | {2.0. Cisco Systems)
1
1

State (ST {e.q. California)

Country (C: I {e.g. US)

= Back Submit

Data to Enter

Complete the entries as required for you organization and click the Submit button. AMC generates the
server certificate and displays it on the Add SSL Server ID page.
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Figure 5-13 shows the Add SSL Server ID Page.

Actions to Take

Use the mouse to select and copy the entire Certificate Signing Request. You will paste this certificate
into the appropriate form at the Verisign.

Figure 5-13 Add SSL Server ID

Hetwork Properties Deploy Monitor Keystores m

Keypairs Keystores > Keypairs > Active Repository > 551 Certificate
¥ Active Repository
Archive %;I-lsign'
Public Certificates Add SSL Server ID
Tert o os et e Enroll for a VeriSign Server ID for S5L. The Server ID you obtain from VeriSign can be used for securely
accessing this console and for enabling transport security (SSL/TLS).
Configuration ¥ 1. Generate an SSL key for S5L Server ID

Enter information about your machine and the entity to whom the certificate will be issued. An S5L
key with a temporary issuer will be generated.

2. Submit Certificate Signing Regquest (CSR) to VeriSign

A CSR for the server key you created in step (1) will be displayed below. Copy this CSR. By
zelecting Next, you will be directed to VeriSign's Server ID enrollment pages, where you will submit
this CSR by pasting it into the appropriate form. 14-day trial Server ID's arrive immediately.
Production certificates arrive after you have been properly authenticated by VeriSign.

CSR: |___BEGIN NEW CERTIFICATE REQUEST——
MIIBrDCCARUCAQAWBDELMAKGA1UEBRMCYVMXCzABgNVBAGTAKNBMREWDWYDVQQ
HEwhTYW4gSm3z
ZTEWMBQGATUEChMNQ2IzY28gU31zdGVtczENMASGATUECXMEdGYzdDEWMBQGATUE
AxMMNYWS3uLmNp

2N mNvbTCBnzANBgkqhkiGIwIBAQEFAAOBQAWGYkCgYEAMMCBTIJaSJ+y6FREP1fVg)|
JATR/KW
\RDj2KIQ3VjyE4QShLEFrSYGvb00Jq7GCDdI+kfuletUKVEMVTE JwescoHmLSYWq3iGC Sex
mkQV
niiS3x+0hKgOTyMqN10GEGUTpvydNId5TQ4eSLIZGOL/Pfo 1KbUGjtTikF 2GiUmdECAWEAASA
A T
MAOGCSqGSIb3DQEBBAUAALGBAF0ZR2xZHO4j+ DyiPI0KJxtBRHeioe2SsoKUyBdJ3dR 7Kkt
peqnt

DkUZmxpk1e3nibZphyYlylS45shLwFAETBQWthezVGZhP INRV64abKIKnweKuvr3g531tpAd [

|~

Finish Hext =

3. Install the certificate you receive from VeriSign

After you receive your SSL Server certificate in an email from VeriSign, you replace the
temporary certificate created in step 1, above.

AON Installation and Administration Guide B



Chapter5 Managing AON Security |

Bl Managing Keystores

After copying the CSR and clicking Next, a new browser window opens and loads the Verisign where
you complete the process for registering your SSL server ID.

Figure 5-14 Shows the Verisign enroll for an SSL certificate. Complete the enrollment process to register
the certificate generated by AMC.

Figure 5-14 Verisign SSL Certificate Enrollment

Flr: | |
. ENROLL FOR A TRIAL SSL
%(HSlgn CERTIFICATE

7'M

WELCOME TECHNICAL ENTERCSR VERIFYCSR ORDER SUMMARY  FINISH
\ I,

* 1

Welcome

Product: TRIAL SSL CERTIFICATE

Includes: Free 550 Trial S5L Certificate, 14 days validity period.

Enrolling for a certificate includes the following steps:

Step 1. Enter your Technical Contact information.

Step 2. Identify your server platform and enter your Certificate Signing Request (CSR).
Step 3. Verify your CSR and enter a challenge phrase for this certificate.

Step 4. Confirm and submit your order.

Step 5. Install the Test CA Root.

Step 6. Receive (via e-mail) and install yvour Trial S5L certificate.

After completing the process at Verisign, return to the Active Repository in AMC and click the Pending
link for your new certificate, as shown in Figure 5-15.

Figure 5-15 Active Repository with Pending Entries

Metwork Properties Deploy Monitor Keystores m

Keypairs Keystores > Keypairs > Active Repository

* Active Repository " " o
Keypair Active Repository

Archive
Alias Type Not Valid Before Not Valid After Actions

Public Certificates
aon.pending-trial-ss| g@ Apr 28, 2005 Jul 27, 2005 Show | Pending | Archive

Root Certificates
testing.pending-trial-ssl ‘5%‘ Apr 28, 2005 Jul 27, 2005 Show | Pending | Archive

Configuration
RowsPage| 10| [T Page| 1)1 [ 44 b M

& Key, = certificate

| Upload PKC5#12 | | MPKI Keypair | | Self-Signed Keypair | | SSL Certificate | | Import Keystore |

On the screen that loads, click the Next button to display the Install SSL Digital Certificate page, as
shown in Figure 5-16.
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Figure 5-16 Install SSL Digital Certificate

Metwork Properties Deploy Monitor Keystores m

Keypairs Keystores > Keypairs > Active Repository > Pending > Next

¥ Active Repository
Archive \/griSign'

Public Certificates Install SSL Digital Certificate

Root Certificates Copy the S5L Server ID you received from VeriSign into the text box below and click Submit.

Configuration

Baseb4 Certificate: [jmesFnjGheWEZABgNVHSMEGDAW ~]
gBQAFRYjUeCKAV+izdCsPighFrCbSDBGBgNVHRSEPzAIMDug
OaA3hjVodHRwOiBvd3d3LmNp
c2MvLmMvbS9zZWHN1cmlleS9wa2ly 3JsLONBUC1SVFAIMDAZ
LmMhybDBETBggrBgEFBQcBAQRH

MEUwCwY IKwYBBQUHMAKGNZh0dHABLY93d3cuY 21z 28uY 2
HLINIY IVyaXRELIBraS9jZ¥J0

cyIDAVAIUIRQLTAWMySZXwPwY JKwYBBAGCHNxQCBDIeMAB
JAFAAUWBFAEMASQBUAHQAZ OBy

AGIAZOBKAGKAY QBIAGUATWBmMAGY AbABpAGAAZTANBgkg|
hkiGIwIBAQUFAACCAQEACTRF+du
kim302+MN4NTdey/nPxBMhjbSshvHzgt+QyPhkiY pZgAHtxU1afQ |
WWWBT3zUig5FdpEvi0ASo
pGZDJTPD4LEY3HZ2hnkSpTPMEWILVZLxpiTF/siorUtedxBiwlar

Y DMN+yK2c016TmRhG4

WLENWRQ2eYYbs11JTWEgE5gfQk+uXTs 1pxeuMCrvoBIMESF
MfukmaZ3uoAXu1d1grxZe95/6
hLng2yeVILTrABC4dsOyFPNRe/TVDgfEPasSakQuhOHVEdRF

¥ 3C0lanhLRDYHUBWqGIY +Mi2 J
N+arBriCaHvKrGE0exYWAIXyndZKSryGCXgWhYRFu3JZw== [

= Back Submit

Actions to Take
Paste the certificate you received from Verisign and click the Submit button.

Import a Keypair or Keystore

You can import an existing keystore that contains your public and private certificates.

How to Get There
e Keystores > Keypairs > Active Repository > Import Keystore.

¢ Keystores > Public Certificates > Active Repository > Import Keystore
¢ Keystores > Root Certificates > Active Repository > Import Keystore

See Figure 5-17.

Figure 5-17 Import Keystore

Hetwork Properties Deploy Monitor Keystores m

Keypairs Keystores > Keypairs > Active Repository > Import Keystore

¥ Active Repository Import Keystore

Archive

Public Certificates

File: I Browse... |

Keystore Password: I

Root Certificates

Configuration

Keystore password different from key alias passwords? ' vyes & g

Submit Cancel
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Data to Enter

The Import Keystore page includes the entries described in Table 5-6.

Table 5-6 Import Keystore Entries

Entry Description

File Full path and filename. Click the Browse button to locate the file to be imported. The
file must be a Java 1.4 JKS format keystore file

Keystore Password used to secure this keystore.

password

Actions to Take
After completing the entries, you can take one of the following actions:

¢ Click Submit to save your changes.

¢ Click Cancel to discard your changes and return to the previous screen.

Manage Public Certificates or Root Certificates

The procedure for managing public certificates and root certificates are identical. This section covers the
following functions:

e Add a Certificate, page 5-18
e Import a Keystore, page 5-20

Add a Certificate

The Add Certificate page enables you to retrieve, upload, or paste a digital certificate.

How to Get There
Navigate one of the following paths:
¢ Keystores > Public Certificates > Active Repository > Add Certificate
¢ Keystores > Root Certificates > Active Repository > Add Certificate.
See Figure 5-18.
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Figure 5-18 Add Certificate

Keypairs Keystores > Root Certificates > Active Repository > Add Certificate

Public Certificates  Add Certificate

Root Certificates  Upload a file, retrieve certificates from via an SSL connection, or paste a digital certificate,
F Active Repository

Archive

Alias:

Configuration ot 5 . e
Choose a name {lower case characters only) that will identify this certificate.

@& Getfrom SSL Connection

URL: Must start with https://

The root certificate presented by the server will be added.

" Upload

File: Browse... |

" Cut and Paste Digital Certificate

Basetd Certificate: ;I

[

Digital certificate example:

----- BEGIMN CERTIFICATE-----
MIIBFiCCASQCEQCghAI3rOtEBwboca10rkngMADGCSgE5Ib30 QEBBALUAMELxCzA]

CGpZ+RY0GIE2INggOSNDmMEATIMHMU/ S W X rmaP A7 ocQwaaY3QzLeKRYZYmGa3uwd
ULe=

Submit Cancel

Data to Enter

The Add Certificate page includes the entries described in Table 5-7.

Table 5-7 Add Certificate Entries

Entry Description

Alias Name of your choosing for this certificate.

URL URL from which AMC can retrieve the certificate. Click the Get from SSL
connection radio button to use this entry.

File Full path and file name. Click the Browse button to locate the file to be imported.
Click the Upload radio button to use this entry.

Base64 Paste the certificate in this entry. Click the Cut and paste digital certificate radio

certificate button to use this entry.

AON Installation and Administration Guide
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Actions to Take
After completing the entries, you can take one of the following actions:

¢ Click Submit to save your changes.

¢ Click Cancel to discard your changes and return to the previous screen.

Import a Keystore

You can retrieve a certificate by importing an existing keystore. See the “Import a Keypair or Keystore”
section on page 5-17 for detailed instructions.

Configuring Security Properties

These properties enable you to configure the security settings of individual nodes. This section covers
the following sections:

e Endpoint SSLID Property, page 5-21
e SSL Configuration Property, page 5-22
e SSL Binding Property, page 5-23

AON Installation and Administration Guide
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Endpoint SSLID Property

The Endpoint SSLID property is used to specify the keypair alias to be used by a node for SSL.

How to Get There
Go to Properties > AON Security > Node > Endpoint SSLID > New. Figure 5-19 shows the SSLID
property page.

Figure 5-19 Endpoint SSSLID Property

Hetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > AON Security > Node > Edit Properties > New

Application Endpoint SSLId: Add New Property Set

Authentication &
Authorization

* Marme: |S55LIOM
IMS

Monitoring Hext > Cancel

ADN Security
» Node

Node Management Security

Service Profiles

Data to Enter

Enter a name for the Endpoint SSLID property, then click the Next button. This loads a page on which
you can choose a keypair to associate with this property. Figure 5-20 shows this page.

Figure 5-20 Key Alias

Adapter Properties > AON Security > Node > Edit Properties > New > Next
Application Key Alias
Authentication & # Alias Type Not Valid Before Mot Valid After
Authorization
1 ¢ amc-test E2  Apri, 2005 Apr 1, 2015
IMS
Romxsa’PageI 10 Pagel 11 44 0 M
Monitoring m m
AON Security (%) Key, ._] Certificate
» Node
Submit Cancel

Node Management Security

Service Profiles
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SSL Configuration Property

SSL Configuration Property specifies SSL-related parameters to be used by a node. Figure 5-21 shows
the SSLID Property page.

How to Get There
Go to Properties > AON Security > Node > SSL Configuration

Note  Before configuring the SSL Configuration Property, you must configure SSLID. See the “Endpoint
SSLID Property” section on page 5-21 for details.

Figure 5-21 SSL Configuration Property

Adapter Properties > AON Security > Node > Edit Properties > Edit

Application SSL Configuration: Edit Property Set

Authentication &
Authorization

* Wame: Default SSL Policy

IMS
e Endpoint Identity: ISSSLID1 j
AON Security S5l Protocol Version: ISSL_V23 j
R Extract Peer Certificate: InD j
Node Management Security
Submit Cancel

Service Profiles

Data to Enter
The Security Property page includes the entries described in Table 5-8.

Table 5-8 Security Property Entries

Entry Description

Name Name of your choosing for this property.

Endpoint Identity Choose an available SecurityID from the drop-down list.

SSL Protocol Version Drop-down list of available versions of SSL. Choose either TLS_v1 or
SSL_v23.

Extract Peer Specifies whether peer certificate extraction is to be used. If PEPs are to use

Certificate the extracted certificate, this option must be set to yes.

Actions to Take

After completing the entries, you can take one of the following actions:
¢ Click Submit to save your changes.

¢ Click Cancel to discard your changes and return to the previous screen.

AON Installation and Administration Guide
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SSL Binding Property

Note

The SSL Binding property enables you to bind a message’s source IP, destination IP, and destination port
to an SSL property. Figure 5-22 shows the SSL Binding Property page.

How to Get There
Go to Properties > AON Security > Node > SSL Binding

Before configuring SSL Binding, you must configure SecurityID and Security Property. See the
“Endpoint SSLID Property” section on page 5-21 and the “SSL Configuration Property” section on
page 5-22 for details.

Figure 5-22 SSL Binding Property

Hetwork Properties Deploy Monitor Keystores Admin

Adapter Properties > AON Security > Node > Edit Properties > New

Application SSL Binding: Add New Property Set

Authentication &
Authorization

Source IP Address: |1D.1.1.1D
IMS

Destination IP Address: |1D.1.1.11
Monitoring

AON Security Destination Port: ISD

ikl Inbound SSL Policy: | Default SSL Policy |
e et S ey Outbound SSL Policy: [Default S5L Falicy =l
LA Inbound Pesr Verifisation: [no =
Outbound Peer Verification: [yes |
Submit Cancel
Data to Enter
The SSL Binding property page includes the entries described in Table 5-9.
Table 5-9 SSL Binding Property Entries
Entry Description
Source IP Address IP address of source.
Destination IP IP address of destination.
Address
Destination Port Port on which outbound peer is listening for SSL traffic.
Inbound SSL Select an available SSL property from the drop-down list.
Property
Outbound SSL Select an available SSL property from the drop-down list.
Property
Inbound Peer Select yes or no to specify whether inbound peer verification is to be used.

Verification
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Table 5-9 SSL Binding Property Entries (continued)

Entry Description

Outbound Peer Select yes or no to specify whether outbound peer verification is to be used.
Verification

Actions to Take
After completing the entries, you can take one of the following actions:

¢ Click Submit to save your changes.

¢ Click Cancel to discard your changes and return to the previous screen.

Configuring Authentication and Authorization Properties

This section covers the following properties:
e Configuring LDAP, page 5-24
e Configuring Kerberos, page 5-26

Configuring LDAP

Lightweight Directory Access Protocol (LDAP) is a protocol for accessing online directory services.
This property can be configured at the node or global levels. After configuring this property, nodes in
your AON network are able to access an LDAP directory for authentication and authorization.

How to Get There
¢ Properties > Authentication & Authorization > Global > LDAP

¢ Properties > Authentication & Authorization > Node > Edit Properties

AON Installation and Administration Guide
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Figure 5-23 shows the LDAP Property page.

Figure 5-23 LDAP Property

Adapter

Application

Authentication &
Authorization

* Global
Node

IMS

Monitoring

ADN Security

Node Management Security

Service Profiles

Data to Enter

This information varies from site to site. Contact your LDAP administrator for proper configuration data.

Actions to Take

Properties Deploy Monitor Keystores Admin

Properties > Authentication & Authorization > Global > New

LDAP: Add New Property Set

* Name: [LDAP1

Primary LDAP Server: |1D.1D.1D.1D

Backup LDAP Server: |1D.1D.1D.11

Connection Maxirnum Retry: |2

Connection Timeout {in seconds): |3

Server Port: |389

Authentication Type: ISimpIe j

Connect DR |cn:Administrat0r, cn=users, de=security, de=aon

Connect Password: quu.

UID Attribute: |AccountName

Base DN: |cc:security, de=aon

User Object Class: |user

User Membership Attribute Name: ImemberOf

Submit

After completing the entries, you can take one of the following actions:

¢ Click Submit to save your changes.

¢ Click Cancel to discard your changes and return to the previous screen.
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Configuring Kerberos

Step 1

Step 2

Kerberos is an authentication protocol that enables entities communicating over an insecure network to
prove their identities to each other. In so doing, Kerberos provides detection of modification and the
prevention of eavesdropping.

Kerberos configuration is controlled by three properties, which must be configured in the following
order:

1. Kerberos Services.
2. Kerberos Realms.
3. Kerberos Info.

In order to complete this configuration, you need specific data from the Kerberos service running on your
network.

Go to Properties > Authentication & Authorization > Node > Kerberos Services. This page is shown
in Figure 5-24.

Figure 5-24 Kerberos Services Property
Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Authentication & Authorization > Node > Edit Properties > New
Application Kerberos Services: Add New Property Set

Authentication &
Authorization

Global * Name: |
* Node

Service URL: I

IMS

Service Principal Mame: I

Monitoring

Service Password: I
ADN Security

Submit Cancel

MNode Management Security

Service Profiles

Data to Enter

This information varies from site to site. Contact your Kerberos administrator for appropriate values.

Go to Properties > Authentication & Authorization > Node > Kerberos Realms. Figure 5-26 shows
the Kerberos Realms property page.
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Figure 5-25 Kerberos Realms Property

Adapter Properties > Authentication & Authorization > Node > Edit Properties > New

Application Kerberos Realms: Add New Property Set

Authentication &
Authorization

Global * Name: |
* Node

Realm Name: I

IMS )
Primary KDC Server: I

Monitoring

Secondary KDC Server: I

ADN Security

Kerberos Services: Edit List
Node Management Security

Service Profiles Submit Cancel

Data to Enter

This information varies from site to site. Contact your Kerberos administrator for appropriate values.
Click the Edit List button and select the Kerberos Services property you created.

Go to Properties > Authentication & Authorization > Node > Kerberos Info. Figure 5-26 shows the
Kerberos Info property page.

Figure 5-26 Kerberos Info Property

Hetwork Properties Deploy Monitor Keystores Admin
Adapter Properties > Authentication & Authorization > Node > Edit Properties > New
Application Kerberos Info: Add New Property Set
Authentication &
Authorization
Global * Name: |

» Nod ] :
Shids KDC Server Connection Timeout: |1D

IMS
Kerberos Realms: Edit List

Monitoring

ADN Security Submit Cancel

MNode Management Security

Service Profiles

Data to Enter

This information varies from site to site. Contact your Kerberos administrator for appropriate values.

Click the Edit List button and select the Kerberos Realms property you created.
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CHAPTER

AMC Administration

This chapter covers the Admin portion of AMC. It includes the following sections:

AMC Diagnostics, page 6-1

AON Licensing, page 6-2

Managing AON Users, page 6-2
Managing AMC Certificates, page 6-11
Managing Extensions, page 6-11

AMC Diagnostics

AMC Diagnostics enable you to set the log reporting level of various AON functions. For each of the
given functions, you can set one of the following log levels:

TRACE
DEBUG
INFO
WARN
ERROR
FATAL

AMC displays the current logging level for each category. New logging level take effect as soon as you
click the Save button. There is no need to restart the system, and the logging levels survive subsequent
restarts of AMC.

Only administrators have the ability to change log levels.
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AON Licensing

AMC provides the ability to upload licenses that enable additional features and functionality. Contact
your Cisco representative to obtain more information about licensing.

How to Get There
Go to Admin > Licensing, then click the Add button.

Figure 6-1 shows the licensing page.

Figure 6-1 AMC Licensing
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Licensing > Add
Users Upload License File

AMC Security Filename: IC:'tciSCD.Iic Browse... |

Extensions

Upload Cancel

Mode Migration

Actions to Take

Click the Browse button to navigate to the location on your PC where the license file is stored, then click
the Upload button to send the file to the AMC.

Managing AON Users

AMC users fall into one of the following categories:
e Local users—these users are created and managed within AMC.

e External users—these users are created on and managed by an external LDAP server.

Note A new installation of AMC includes five local users with aonsadmin as their default password. To
ensure that only authorized personnel have access to the AMC, change the default passwords or delete
unneeded users.

Managing Local Users

Local users are created and managed by the AMC. You can use this page add to perform the following
tasks:

e Add and delete users
¢ Display information about users
e Edit a user’s information, including privileges.

e Change a user’s password
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How to Get There
Go to Admin > Users > Manage Local Users. Figure 6-2 shows this page

Figure 6-2 Manage AMC Local Users
- - h| o
Licensing Admin > Users > Manage Local Users
Users Manage Local Users

* Manage Local Users _ 0

# Login ID First Name Last Name
Manage External Users
1 @ acnsadmin AONS Adrministrator
AMLC Security
2 designer ACNS Designer
Extensions o = &
Node Migration 3 ¢ netadmin ACNS Netddmin
4 e secadmin AONS SecurityAdmin
5 e appadmin AONS AppAdmin
RewsPage| 10 [E Page[ 171 [ 4 4 p M
Hew Show Edit Password Delete

Actions to Take

Click one of the following buttons:
e New—creates a new users. See Creating New Users, page 6-4
e Show—displays information on the selected user. See Displaying Information on Users, page 6-5
¢ Edit—changes information about the selected user. See Editing Users, page 6-6
e Password—changes the password of the selected user.

¢ Delete—removes the selected user from the system.

AONS Administrator Guide B



Chapter 6  AMC Administration |

I  Managing AON Users

Creating New Users

AMC enables you to create new local users.

How to Get There
Go to Admin > Users > Manage Local Users, then click the New button. Figure 6-3 shows the New
User page.
Figure 6-3 New User
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage Local Users > New
Users Mew User

* Manage Local Users

Manage External Users

Login ID: |U88r1
AMC Security

E— First Mame: IUser

Node Migration Last Mame: |User

Email Address: |user@c0mpanv.c0m

Password: quu

Confirm Password: I......l

Roles: [ipplicationAdministrator

ApplicationDesigner

Submit Cancel

Actions to Take

Enter the appropriate information for the user and select a role. Use Control+click to select multiple
roles. For description of available roles, see Assigning Roles to Users, page 6-6.

After completing the fields, click the Submit button to save your changes.
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You can use AMC to display information on a selected user, including name, email address, and roles

assigned.

How to Get There

Go to Admin > Users > Manage Local Users, then select a user. Click the Show button to display the
information. Figure 6-4 shows the Show User Details page.

Figure 6-4 Show User Details
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage Local Users = Show
Users Show User Details
* Manage Local Users
Manage External Users
AMC Security Login ID: aonsadmin
Extensions First Mame: ACQNS
Node Migration Last Mame: Administrater

Email Address:

Roles:

Created:

Last Modified:

Applicationadministrator
ApplicationDesigner
MetworkAdministrator
SecurityAdministrator

wed Feb 16 15:49:20 PST 2005

wed Feb 16 15:49:20 PST 2005

< Back
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Editing Users

AMC provides the ability to edit the properties of local users.

How to Get There

Go to Admin > Users > Manage Local Users, then select a user. Click the Edit button. Figure 6-5 shows
the Edit Local User page.

Figure 6-5 Edit Local User
_ Hetwork 1 Properties 1 Deploy T Monitor 1 Keystores Admin _
Licensing Admin > Users > Manage Local Users > Edit
Users Edit User

* Manage Local Users

Manage External Users

Login ID: aonsadmin
AMC Security

. First Name: IAONS
Extensions

Node Migration Last Name: IAdminiStratDr

Email Address: I

Roles:

Submit Cancel

Actions to Take

Make changes as necessary, then click the Submit button to save your changes.

Assigning Roles to Users

AMC users can be given roles based on their need to perform certain actions on AMC. Each role grants
specific privileges within AMC. For example, the Application Designer role can only upload extensions
to the AMC, however, a Network Administrator can access functions related to managing and monitoring
nodes. To give a user full access to AMC, assign all four roles to that user. Table 6-1 shows the roles
available in AMC, and the sections on each tab these roles can access.

Table 6-1 AMC User Roles
Role Network Tab Properties Tab Deploy Tab |Monitor Tab |Keystores Tab Admin Tab
Application — e Adapter e All e All — e All
Administrator « Application

e JMS

e Monitoring

e Service Profiles
Application — — — — — e Extensions
Designer
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Table 6-1 AMC User Roles (continued)
Role Network Tab Properties Tab Deploy Tab |Monitor Tab |Keystores Tab Admin Tab
Network e All e Monitoring — e All — —
Administrator
Security — ¢ Authentication — e Al e All e Users
Administrator and Authorization e AMC

e Security Security

To assign roles to a user, see one of the following sections:
e Creating New Users, page 6-4
e Editing Users, page 6-6

e Assigning Roles to External Users, page 6-9

Managing External Users

AMC provides the ability to use an existing LDAP server for user management. To do this, complete the
following tasks in the order specified:

1. Creating an LDAP Profile, page 6-7
2. Assigning Roles to External Users, page 6-9

3. Creating an Authentication Realm, page 6-10

Creating an LDAP Profile

An LDAP profile provides the information needed by AMC to retrieve user data from an existing LDAP
server.
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How to Get There

Go to Admin > Users > Manage Local Users > LDAP, then click the New button. Figure 6-6 shows the
LDAP page.

Figure 6-6 LDAP Property Set
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage External Users = New
Users LDAP: Add New Property Set

Manage Local Users

» Manage External Users

* Mame: I
AMLC Security

Extensions Primary LDAP Server: I

Node Migration Backup LDAP Server: I

Connection Maximurn Retry: I

Connection Timeout (in seconds): I

Server Port: I

Authentication Type: Isimple j

Connect DR I

Connect Password: I

UID Attribute: |

Base DM I

User Object Class: I

Submit Cancel

Actions to Take

Complete the fields as appropriate for the LDAP server being used. Contact your LDAP administrator
for details.
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Assigning Roles to External Users

How to Get There

Go to Admin > Users > Manage Local Users > Role Mapping, then click the New button. Figure 6-7
shows the Role Mapping page.

Figure 6-7 Role Mapping
Hetwork Properties Deploy Monitor Keystores Admin
Licensing Admin > Users > Manage External Users > New
Users Role Mapping: Add New Property Set

Manage Local Users

* Manage External Users

* Mame: I
AMC Security

) LDAP Attribute Name: |
Extensions

Node Migration Condition Operator: qu j

LDAP Attribute Value: |

Aszsign Roles: Edit List

Submit Cancel

Data to Enter
Table 6-2 shows the field of the Role Mapping page.

Table 6-2
Entry Description
Name Name of your choosing for this property set.

LDAP Attribute Name The LDAP attribute that is to be used to specify the AMC role.

Condition Operator Choose one of the following from the drop-down list:

e equals—information retrieved from LDAP server must match exactly
with LDAP attribute value specified below.

e contains—information retrieved from LDAP server must contain
LDAP attribute value specified below.

e defineRoles—information retrieved from LDAP will define the role of
the user.

LDAP Attribute Value The value for the attribute specified above.

Assign Roles Click the Edit List button to choose roles that are to be assigned to users
who match the LDAP attribute. See “AMC User Roles”

Actions to Take
After completing the fields, click the Submit button to save your changes.
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Creating an Authentication Realm

The LDAP Authentication Realm binds the LDAP information specified in the “Creating an LDAP
Profile” section on page 6-7 with the role mapping information specified in “Assigning Roles to External
Users” section on page 6-9.

How to Get There

Admin > Users > Manage Local Users > Authentication Realm, then click the New button. Figure 6-8
shows the Authentication Realm page.

Figure 6-8 Authentication Realm
Hetwork Properties Deploy Maonitor Keystores Admin
Licensing Admin > Users > Manage External Users > New
Users Authentication Realm: Add New Property Set

Manage Local Users

F Manage External Users

* Mame: I
AMLC Security

N Realm Mame: I
Extensions

MNode Migration LDAP Connection Profile: I j

Role Mapping Palicies; Edit List

Submit Cancel

Data to Enter
Table 6-3 shows the Authentication Realm page.

Table 6-3 Authentication Realm

Entry Description

Name Name of your choosing for this property set.

Realm Name Name of your choosing for the realm.

LDAP Connection Choose an available LDAP profile from the drop-down list. See the “Creating an
Profile LDAP Profile” section on page 6-7 to create a new profile.

Role Mapping Click the Edit List button to select from the available Role Mapping property sets.
Policies See the “Assigning Roles to External Users” section on page 6-9 to create a new

property set.

Actions to Take

After completing the fields, click the Submit button to save your changes. Once you completed this task,
the LDAP configuration appears in the drop-down list on the AMC log-in page.
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Managing AMC Certificates

The AMC Security Page enables you to manage the keypairs and certificates used by AMC for secure
communication.

e Keypairs—view, edit, or delete keypairs that have been assigned to AMC.
¢ Public Certificates—view, edit, or delete public certificates that have been assigned to AMC.
¢ Root Certificates—view, edit, or delete root certificates that have been assigned to AMC.

~

Note If no keypairs or certificates are present, you must use the Keystores tab to generate them.

Managing Extensions

The Extensions page enables you to upload custom software to adapt your AON environment to the
specific business needs of your network. This page provides the ability to upload the following:

e Adapter Packages

e Adapter Extension Packages
e JMS Resources

e Schema Packages

e Transform Packages

e Transform Parser Packages

~

Note  Before you can upload an extension with AMC, you must use AON Development Studio to package it.

For more information about developing and packaging extensions, see the AON Programming Guide.
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Note

APPENDIX A

Message Log Schemas

This appendix contains scripts that configure an Oracle or Sybase database for message log. For message
log configuration instructions, see the “Message Log Domain” section on page 5-17.

Before running either of these scripts, be sure to remove any earlier versions of the Message Log schema.

This information spans multiple pages, making it difficult to select and copy when this guide is viewed
in Adobe Acrobat. For best results, go to Cisco.com to view this information on a single page:

Log in to SQLPlus as the user created for Message Log, then run this script to configure an Oracle
database.

CREATE TABLE MESSAGE_LOG_INSTANCE

( "USE_COUNT" number (18,0),
"ID" varchar2 (100),
"DESCRIPTION" varchar2(256),
"VERSION" varchar2 (100)

)

INSERT INTO MESSAGE_LOG_INSTANCE (ID,USE_COUNT,VERSION,DESCRIPTION) VALUES
('AONS-MLOG-001', 0, '1.0', 'Database for storing AONS message logs');

CREATE TABLE MESSAGE_LOG
(

"LOGID" number (28,0) not null primary key,
"HOSTNAME" varchar2 (64),
"SOURCE_NODE_ID" number (10, 0),
"ENTRY_TIME" timestamp,

"CREATION_TIME" timestamp not null,
"MESSAGE_ID" varchar2 (100) not null,
"SESSION_ID" varchar2 (100),
"DESTINATION" varchar2 (256) ,
"NEXT_HOP" varchar2 (256) ,
"SOURCE" varchar2(256),
"SENDING_NODE" varchar2 (256) ,
"FLOW_ID" wvarchar2(100),

"BLADELET_ ID" varchar2 (32),
"FLOW_NAME" varchar2 (100),
"BLADELET_NAME" varchar2(100),
"CONTENT_TYPE" varchar2 (64),
"PAYLOAD_ TYPE" varchar2 (32),
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"MESSAGE_TYPE"
"MESSAGE_CLASS"

varchar2 (32),
varchar2 (64),

"PROTOCOL" varchar2 (32),
"LOG_VERSION" varchar2 (10),
"LOG_TYPE" varchar2 (32),
"LOG_LEVEL" number (5) ,
"SOAP_OPERATION" +varchar2(256),
"STATUS" number (10) ,
"REASON" varchar2 (100),

"PROTOCOL_HEADER"

"CUSTOM_STRING1"
"CUSTOM_STRING2"
"CUSTOM_STRING3"
"CUSTOM_STRING4"
"CUSTOM_STRING5"

raw(2000) ,
varchar2 (32),

varchar2 (64),

varchar2 (128),
varchar2 (256) ,
varchar2 (1024),

"CUSTOM_NUMBER1" number(5,0),
"CUSTOM_NUMBER2" number(10,0),
"CUSTOM_NUMBER3" number (18,2)

)

CREATE INDEX "MESSAGE_ID_IDX" ON "MESSAGE_LOG" ("MESSAGE_ID") ;
CREATE INDEX "MESSAGE_DESTINATION_IDX" ON "MESSAGE_LOG" ("DESTINATION") ;
CREATE INDEX "MESSAGE_SOURCE_IDX" ON "MESSAGE_LOG" ("SOURCE") ;
CREATE TABLE SOURCE_NODE
(
ID NUMBER(10) NOT NULL PRIMARY KEY,
DN VARCHAR2 (256) NOT NULL,

CREATED_TIME NUMBER(18) NOT NULL,
NODE_ID NUMBER(10),
AMC_TIP VARCHAR2 (64),
AMC_HOST_NAME VARCHAR2 (256),
AMC_ID VARCHAR2 (256),
AMC_VERSION VARCHAR2 (64),
VIRTUAL_NODE_ID NUMBER(10),
VIRTUAL_NODE_NAME VARCHAR2 (64)

)i

create table MESSAGE_CONTENTS (
LOGID number(28,0) not null,
CONTENT_TYPE varchar2 (64),
NAME varchar2 (64),
CONTENT long raw,
EXPRESSION varchar2(256),
CONTENT_LENGTH number (10,0)
)

CREATE TABLE FLOW_VARIABLES
(

"LOGID" number (28,0) NOT NULL,
"NAME" wvarchar2(100),

"VALUE" long raw,

"TYPE" varchar2(100)

)

CREATE SEQUENCE LOGID_SEQ
START WITH 1

INCREMENT BY 50000
NOMAXVALUE;

CREATE OR REPLACE PROCEDURE GET_LOGID_BLOCK (
blockSize out int,
beginValue out number

)
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as
begin

select LOGID_SEQ.nextval INTO beginValue from dual;
select INCREMENT_BY INTO blockSize from USER_SEQUENCES;

beginvalue :=
return;

end;

/

beginvalue - blockSize;

select LOGID_SEQ.nextval from dual;

Sybase W

Log in to SQLAdvantage as the user created for Message Log, then run this script to configure a Sybase

database.

CREATE TABLE MESSAGE_LOG_INSTANCE

(
USE_COUNT
ID
DESCRIPTION
VERSION

go

INSERT INTO MESSAGE_LOG_INSTANCE

('AONS-MLOG-001",

go

numeric (18)
varchar (100
varchar (256
varchar (100

0, '1.0",

create table MESSAGE_LOG (

LOGID

HOSTNAME

SOURCE_NODE_ID

ENTRY_TIME

CREATION_TIME

MESSAGE_ID
SESSION_ID
DESTINATION
NEXT_HOP
SOURCE
SENDING_NODE
FLOW_ID
BLADELET_ID
FLOW_NAME

BLADELET_NAME

CONTENT_TYPE
PAYLOAD_TYPE
MESSAGE_TYPE

MESSAGE_CLASS

PROTOCOL
LOG_VERSION
LOG_TYPE
LOG_LEVEL

SOAP_OPERATION

STATUS
REASON

PROTOCOL_HEADER

)
)
)

’

’

(ID,USE_COUNT, VERSION, DESCRIPTION)

VALUES

'Database for storing AONS message logs')

numeric(28,0)

varchar (64)
numeric (10, 0)
datetime
datetime
varchar (100)
varchar (100)
varchar (256)
varchar (256)
varchar (256)
varchar (256)
varchar (100)
varchar (32)
varchar (100)
varchar (100)
varchar (64)
varchar (32)
varchar (32)
varchar (64)
varchar (32)
varchar (10)
varchar (32)
numeric(5,0)
varchar (256)
int

not null primary key

null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null
null

not
not

varchar (100)

varbinary (2000)

null

7

’

null

7

’
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CUSTOM_STRING1 varchar(32) null ,
CUSTOM_STRING2 varchar (64) null
CUSTOM_STRING3 varchar(128) null
CUSTOM_STRING4 varchar (256) null ,
CUSTOM_STRING5 varchar(1024) null ,
CUSTOM_NUMBER1 numeric(5,0) null ,
CUSTOM_NUMBER2 numeric(10,0) null
CUSTOM_NUMBER3 numeric(18,2) null

go

CREATE INDEX MESSAGE_ID_IDX ON MESSAGE_LOG (MESSAGE_ID)

go

CREATE INDEX MESSAGE_DESTINATION_IDX ON MESSAGE_LOG (DESTINATION)

go

CREATE INDEX MESSAGE_SOURCE_IDX ON MESSAGE_LOG (SOURCE)

go

CREATE TABLE SOURCE_NODE
(

ID numeric(10,0) not null primary key,

DN varchar (256) not null,
CREATED_TIME numeric(18,0) not null,
NODE_ID numeric(10,0) null,

AMC_TIP varchar(64) null,
AMC_HOST_NAME varchar (256) null,
AMC_TID varchar (256) null,
AMC_VERSION varchar(64) null,
VIRTUAL_NODE_ID numeric(10,0) null,
VIRTUAL_NODE_NAME varchar(64) null

go

create table MESSAGE_CONTENTS (
LOGID numeric(28,0) not null,
CONTENT_TYPE varchar (64) null,
NAME varchar (64) null,
CONTENT image null,
EXPRESSION varchar(256) null,
CONTENT_LENGTH int null

go

create table FLOW_VARIABLES (

LOGID numeric (28,0) not null
NAME varchar (100) null ,
TYPE varchar (100) null ,
VALUE image null

go

create table LOGID_KEY (

’
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ID numeric(28,0) not null

go

insert into LOGID_KEY values (1)

go

CREATE PROCEDURE GET_LOGID_BLOCK
@blockSize int output,
@beginvValue numeric(28,0) output

AS
BEGIN
select @beginvValue=ID from LOGID_KEY
select @blockSize = 50000
update LOGID_KEY set ID = @beginvValue + @blockSize
END
go

sp_procxmode 'GET_LOGID_BLOCK', chained
go
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AbstractCustomBladelet

ACK

AccessDB

AccessHTTP

Adapter

Adapter Package

Administrator

ADS

AES128/192/256

Algorithm

Alias

AMC

GLOSSARY

Basic custom bladelet class. It implements the CustomBladelet interface and must be included
in all new custom bladelets. See Custom Bladelet API, page -6.

Short message that acknowledges receipt of a message.

Security bladelet that makes JDBC callouts to external databases. This bladelet can execute
basic SQL queries against Oracle/Sybase databases. It outputs the query results in case of
select queries and the update count in case of insert/update/delete queries. See Bladelet, page
-3.

Security bladelet that makes HTTP GET/POST callouts to HTTP servers. With a similar
function, Send is the preferred bladelet for sending out HTTP requests. See Bladelet, page -3.

Adapters process a variety of network traffic including industry standard and custom
protocols. AON has a set of built-in adapters to handle these formats. In addition, you can use
the Custom Adapter API to create a custom adapter.

Package, included in Custom Adapter API, whose interfaces provide definitions for all
constants (adapter request, response, protocol, and so on) used by the adapter, get the adapter
context, define adapter types (such as embedded, standalone, and start up model), define the
adapter manager, listen for events, obtain connection information (ConnectionID, Reader,
SourcelP, SourcePort, Writer, and SSLCertificate), define the connection receiver, return the
DeliveryContext, define the outbound delivery group, and so on. For more information, see
package, page -12 and Custom Adapter API, page -5. Also, see “Custom Adapter API
Specification” in Chapter 4. Custom Adapters of the AON Programming Guide.

Super user of the AON Management Console.

AON Development Studio (ADS) is the graphical user interface used to create (and update)
PEPs for upload to AMC. The main components of the ADS are the PEP Explorer, Navigator,
PEP Developer, Problems, and the Repository.

Advanced Encryption Standard (AES) is a encryption algorithm that secures information as it
passes over a network. 128, 192, and 256 indicates the number of bits used by the key.

An algorithm is a set of predefined rules or processes for solving a problem or performing a
specific task. For examples, see DSA, page -7, RSA, page -14, and SHA1, page -15.

Typically, an alias is a user friendly name for an item such as a program component for
function. AON incorporates many aliases. For example, message protocols are sometimes
identified by aliases (see “Protocol Alias” in the AON Programming Guide).

A Web-based application, AON Management Console (AMC) is used to manage the AON
installation, upgrade, and operation.
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A
ANT
AON

AONSCommon

AON-SM
AON node
AON-NM

AONSTransformer

AONSTransformerFactory

API

Asynchronous message

Ant is a scripting tool that is used to compile and run Java programs.
Application Oriented Network.

AONSCommon software is in conjunction with the Custom Bladelet API, Custom Adapter
APIs, External Service API, XSLT Transformation SDK, and Schema Validation SDK. This
key file includes the following packages:

Exception Package, page -7
External Services API, page -8
PEP Package, page -13

Log Package, page -10

Message Package, page -11

Net Package, page -12

Utilities Package, page -17
XPath Engine Package, page -18

For more information, see Appendix A. AONSCommon Specification in the AON
Programming Guide.

AON service module for Catalyst 6500 Series Switches.
A switch or router running configured to perform application-oriented networking.
AON network module for Cisco 2600, Cisco 2800, Cisco 3700, and Cisco 3800 series routers.

An External Services API interface that defines a transformer object in AON to perform
transformation services. The interface takes XML data as input (SAXSource or DOMSource)
and puts the transformed result in the target result object. AONSTransformer is implemented
in the AON transformation service that provides XSLT based transformation in AON. An AON
transformer object is created by AONSTransformerFactory. See External Services API, page
-8and “APIs” in Chapter 5. Transformation of the AON Programming Guide.

An External Services API class that defines a factory for an AONSTransformer object. Each
type of transformation implements this interface to provide a specific transformer object
factory. The Transformation bladelet is included in message PEPs to provide transformation
services. See External Services API, page -8.

Application programming interface. AON is supplied with many Java-coded APIs such as the
custom bladelet and custom adapter APIs. The AON Programming Guide describes the APIs
supplied with AON.

An asynchronous message is transmitted intermittently instead of in a steady stream. For
example, a one way message is usually asynchronous because it may occur unpredictably and
does not require a response.
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Authenticate Security bladelet that authenticates various credentials from the Identity bladelet. An HTTP
header or SOAP message are among the variety of sources that the Authenticate bladelet can obtain
identities from. See Bladelet, page -3.

Authentication A process that checks user credentials. Authentication is also an External Services API class
that authenticates given user credentials. See External Services API, page -8.

Authorize Security bladelet that computes authorization decisions and enforces authorization decisions
on incoming message. Authorize supports three different authorization mechanisms: SAML
based, LDAP group based, and rule based authorization.

Balance Load Routing bladelet that uses one of four different algorithms to decide which particular end point
should receive the next message. It updates the destination URI of the message based on the
algorithm. The Send bladelet that follows the BalanceL.oad bladelet sends the message to the
chosen destination. See Bladelet, page -3.

BAR Bladelet archive file. This file (.bar) contains metadata about a bladelet. See SCAR, page -14.

Bladelet A bladelet is a piece of software that performs a specific message handling function. Bladelets
are combined together into PEPs. The ADS is used to combine bladelets into PEPs. You can
create a custom bladelet by following directions in the AON Programming Guide. AON is
supplied with the bladelets grouped by type and listed below.

PEP Markers—Exception PEP Marker and Response Marker
External Access—AccessDB and AccessHTTP
General—Log, Cache Data, and Retrieve Cache
Logic—Find and Branch

Message Handling—Validate, Build Composite Content, Discard, Create Message, Update
Message, Create Content, Extract Composite Content, and Create Response.

Routing—Distribute, Set Destination, Send and Balance Load.

Security—Authorize, Encrypt, Verify Signature, Sign, Bladelet, Identity, Authenticate, and
Verify Identity.

Transformation—Transform.
For more information, see the “AON Bladelet Reference” in AON Development Studio Guide.

bladelet archive file AON bladelets are defined in bladelet archive (.bar) files. This file stores meta-data about one
or more bladelets. When a message PEP is constructed, the ADS uses information in the
bladelet archive file to generate user interface and other code. The bar file is also used at
runtime to load the bladelet name and class name.
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bladelet parameters

bladelet-info.xml

Branch

Build Composite Content

C

Cache Data

CacheService

Caching

Certificate

Class

Compression

Content-based routing

ContentLookup

AON bladelet parameters are displayed in the ADS by right-clicking on a bladelet icon
(displayed in the PEP developer) and selecting Bladelet Properties. The resulting window
displays parameter information and enables you to change some of them.The display is
partially determined by the bladelet-info.xml file. In the file, parameters are grouped
hierarchically by <configuration-group>, <configuration-subgroup>, <parameter-group>, and
<parameter>.

Provided with AON, the bladelet-info.xml contains definitions of all supplied bladelets.

Logic bladelet that evaluates a set of conditions and activates the bladelet's output port
corresponding to the rule that evaluates to true. This should be used to implement if-then-else
structure within a PEP. See Bladelet, page -3.

Message Handling bladelet that creates a multipart content from the given input message and the
parts that need to be added, deleted, or overwritten. See Bladelet, page -3.

General purpose bladelet that sets data into the named caches configured on an AON node.
The named caches are “response” and “variable”. The response cache caches server responses.
The variable cache caches PEP variables. Data from the named caches can be retrieved using
the RetrieveCache bladelet. In addition, data from the variable cache can be retrieved using
the Caching Service API exposed to Custom Bladelets. See Bladelet, page -3.

An External Services API interface that puts the object into a cache, gets the object from the
cache, and removes the object from the cache. The object cache (local to each blade) is shared
across PEPs and PEP instances and uses the LRU replacement algorithm. See External
Services API, page -8.

The ability of an AON node to store frequently-used content locally and make it available for
future requests.

The public half of an asymmetric key algorithm key pair (the “public key”), together with
identity information such as a person's name, email address, title, phone number, an so forth.
A certificate is digitally signed by a person or entity, binding the public key to the entity
described by the attributes.

A class is a category of objects such as program elements. A class is not an object; instead, it
is used to create (instantiate) object instances of itself. AON classes are grouped together into
packages. The properties and operations of a class instance are largely determined by its
methods. For more information, see the descriptions of exposed AON packages and classes in
the AON Programming Guide.

An External Services API interface that compresses and decompresses input data. See
External Services API, page -8.

The process for determining the destination of a message based on its content.

An External Services API interface that evaluates regular expressions on the given content and
produces a collection of objects. See External Services API, page -8.
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Content Parser A content parser plug-in extension that parses input data and converts it to an equivalent XML
format on which AON XSLT transformation can be applied.

ContentValidation An External Services API that validates the input document with the given XML schema or
DTD (document type definition). Schema-DTD meta data is stored in the AON network node
profile as domain (property) sets. AON parses XML grammar, already stored in cache. Policies
are stored in attribute domain files as com.cisco.aons.policies.validation.ContentValidation.
See External Services API, page -8.

Create Content Message Handling bladelet that updates an existing AON message in the PEP. You can use this
bladelet to update the destination, content or the headers of the message. Create Content can update
the payload of the incoming message or modify header information as it is forwarded on to an
end-point or to the client. See Bladelet, page -3.

Create Message Message Handling bladelet that creates a new AON message in a PEP. Typically, adapters create
messages at input and output points. See Bladelet, page -3.

Create Response Message Handling bladelet that tags an existing AON message in a PEP as the response message
that has to be sent back to the client. Ordinarily, response messages by a Send or Distribute bladelet
in a PEP. You can also use Create Message to handcraft response messages without involving an
end point. RetrieveCache can put a response message into the PEP that was previously cached
by the CacheData bladelet. In PEPs that do not involve Send and Distribute, Create Response
is used to mark a particular message as the response message. See Bladelet, page -3.

Credentials Information that identifies a user, message component, or program element. For example, the
AON Authentication interface verifies given user credentials.

custom adapter AON Custom Adapter Software Development Kit (SDK).

Custom Adapter API APISs that are used to develop embedded or standalone custom adapters. This set includes the
following packages:

Adapter Package, page -1

10 Package, page -9

Message Package, page -11
Utilities Package, page -17
Exception Package, page -7
Utilities Pool Package, page -17

For more information, see “Custom Adapter API Specification” in Chapter 3. Custom
Adapters of the AON Programming Guide.

Custom Bladelet The AONS custom bladelet SDK is used to create new bladelets (“custom bladelets”) that may
be included in PEPs. Custom bladelets are uploaded to the AMC during synchronization.

Also, part of the CustomBladelet API. This basic custom bladelet interface must be included
in all new custom bladelets. It accesses PEP variables via methods that get and set context data.
See Custom Bladelet API, page -6.
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C

Custom Bladelet API

CustomBladeletContext

D

data type

Decrypt

Decryption

DES

Discard

Distribute

DNS

A package that may be used by developers to create new bladelets. The package includes the
following components:

AbstractCustomBladelet, page -1
Custom Bladelet, page -5
CustomBladeletContext, page -6
PEPData, page -13

For detailed information, see “Custom Bladelet API Specification, in Chapter 2. Custom
Bladelets of the AON Programming Guide.

Part of the Custom Bladelet API. This interface provides context to the custom bladelet. It
passes variables, gets PEP details, sets output path and logs messages.

Defines the type of data. A variety of data types are used in AON including AON-specific
(AONSubject, Content, MessageTypelnfo, PlatformInfo, SecurityContext, and so on) and
Java-standard data types (for example, boolean). The DataType.xml file defines all data types
used in AON. AON-specific data type are described in Appendix B. AON Data Types in the
AON Programming Guide.

Security bladelet that decrypts encrypted XML, SOAP or non-XML messages as well as
attachments. See Bladelet, page -3.

Decryption reverses Encryption action, decrypting a previously encrypted message making it
human-readable. See External Services API, page -8.

Data Encryption Standard. Cryptographic algorithm developed by the U.S. National Bureau of
Standards.

Message Handling bladelet that informs AON when PEP processing should stop and the
connection to the client be closed. This bladelet should not be used after Send or Distribute.
This is useful mainly with a CreateMessage or RetrieveCache. It may also be used when the
PEP has multiple Sends and based on some logic, one of the replies needs to be picked. See
Bladelet, page -3.

Routing bladelet that sends the same message over to multiple end-points. Distribute is a terminal
bladelet. In a PEP, no bladelet can follow Distribute. For request-response PEPs, it gathers the
responses, chooses one based on a selection criteria, and sets it as the response message. See
Bladelet, page -3.

Domain Name System. This is the system used on the Internet to translate names of network
nodes into addresses.
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DSA Digital signature algorithm.

DTD Document type definition. AON can be configured to validate only those incoming XML
messages that contain a DTD (.dtd file) declaration or schema reference or both. The DTD or
schema meta data is stored in the AON network node profile as domain (property) sets.

Embedded Adapter An adapter that is tightly integrated with the AON framework and may use all AON resources.
An embedded adapter opens a socket and reads a stream of data off it. See Standalone Adapter,
page -16.

Encrypt Security bladelet that encrypts either parts of or the entire input message to maintain data integrity.
Parts of an XML or SOAP message can be encrypted by specifying the XPath locations of the
elements to be encrypted in the message. AON can encrypt XML, SOAP and non-XML messages
and their attachments. See Bladelet, page -3.

Encryption Encryption obscures information, making it unreadable without special knowledge. The
External Services API Encryption encrypts message input and decrypts previously encrypted
documents. See External Services API, page -8.

Exception Package A Custom Adapter API interface that gets the exception type, provides exception services,
provides runtime exception services, and identifies exception conditions to be caught. See
Custom Adapter API, page -5.

Also, an AONSCommon Exception package that includes a class that return the exception type
and the following exceptions:

AONSException—Exception returns AONSException, get arguments, get error codes, and so
on.

AONSRuntimeException—Exception that handles AON runtime exceptions.
AONSRuntimeException inherits methods from java.lang and has a set of constructors.

ExtServiceException—Exception that indicates conditions that service clients are expected to
catch. ExtServiceException inherits methods from java.lang and has a set of constructors.

InitializationException—Exception that handles exceptions that occur during AON
initialization. InitializationException inherits methods from java.lang and has a set of
constructors.

NoSuchVariable—Exception that handles calls to non-existent PEP variables.

See AONSCommon, page -2 and “Exception Package” in Appendix A. AONSCommon
Specification in the AON Programming Guide.

Exception PEP Marker PEP Marker bladelet that tracks and records exceptions in the PEP. It is a good way to create
instances that can be stored as database records to audit exceptions as information is routed
through the PEP. See Bladelet, page -3.
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Explicit mode

External Services API

Extensibility

Extract Composite Content

ExtService

A deployment in which an AON node processes messages exchanged by two entities with the
knowledge of those entities. The sender and receiver of a message are configured to
communicate with the AON nodes.

Each AON service operates through a set of APIs. Customers and partners can expand existing
AON service functions by creating custom bladelets that operate in a message Policy
Execution Plan (PEP). The External Services APIs can be incorporated into custom bladelets
and adapters to provide these extended services. The AON External Services package
incorporates the following Java-coded interfaces:

AONSTransformer, page -2
AONSTransformerFactory, page -2
Authentication, page -3
CacheService, page -4
Compression, page -4
ContentLookup, page -4
ContentValidation, page -5
Encryption, page -7
ExtService, page -8
ExtServiceContent, page -9
ExtServiceProfile, page -9
MessageLog, page -10
MIME, page -12
ServiceFactory, page -15
Signature, page -15
Transform, page -16

Although the External Services API is part of the AONSCommon, it is separately discussed in
the AON Programming Guide in the “External Services API Specification” in Chapter 4.
External Services.

You can enhance AON capabilities by creating several types of extensions: custom bladelets,
custom adapters, XSLT transformations, and schema validations. Extensions are packaged in
ADS and uploaded to AMC for use at AON nodes. See External Services API, page -8.

Message Handling bladelet that extracts the contents from a multipart content message. See
Bladelet, page -3.

An External Services API interface that gets the name and profile of a service. See External
Services API, page -8.
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Find

Identity

Interface
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10 Package

J

Jar file

JDBC

Glossary W

An External Services API interface that gets message context name, attribute information, and
set attributes. See External Services API, page -8.

An External Services API interface that sets the context and get the profile name, service
names, contexts defined in the profile, and current context. See External Services API, page -8.

Logic bladelet that queries an XML message and extracts all nodes identified by regular (for regular
expressions, the message type does not need to be in XML format) and XPath expressions from the
message currently being processed by the PEP. After regular and common XPath expressions are evaluated
by this bladelet, they may be used by other bladelets. See Bladelet, page -3.

AON messages can use several types of claims or proof of identity. These items are generically referred to
as “subjects.” This Security bladelet can extract all subjects of specified types from the message being
processed by the PEP. See Bladelet, page -3.

AON has user and software interfaces. The AMC and ADS are managed through GUI user interfaces.
AON software interfaces (also generally referred to as APIs) are used by programs or applications to
connect to other pieces of internal or external software or hardware and exchange data updates (such
as synchronization), message requests and responses, notifications, pings, and so forth.

Input-output.

Package in the Custom Adapter API. This package has components for defining the adapter reader for
reading and writing data, encapsulating the native buffers, defining the adapter buffer manager, and
defining a read-only view of the IAONSBuffer. For more information, see “Custom Adapter API
Specification” in Chapter 3. AON Programming Guide. Also, see Custom Adapter API, page -5.

Java archive files. You can open JAR files with a standard ZIP application (such as WinZIP).

Java Database Connectivity.
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LDAP

Log

Log Package

MDS

message

Messagelog

Light Weight Directory Access Protocol (LDAP) is used to access information
directories. LDAP supports TCP/IP. The AON LDAP Group Based Policy Rules defines
Authorization policies based on the subject's group membership in an LDAP directory.
See Authorize, page -3.

General purpose bladelet that provides logging services to capture information about the message and
PEP that includes properties of the message, contents of the message and PEP variables. See Bladelet, page
-3.

AONSCommon package that contains a class (Log) to handle AON logging activities. See
AONSCommon, page -2 and “Log Package” in Appendix A. AONSCommon Specification in the AON
Programming Guide.

Message Delivery Semantics. AON uses MDS to guarantee reliable and/or ordered delivery of
messages based on user-defined message types.

A document that is exchanged between applications. Within a message, the data fields are enclosed
by headers that describe the field context and content. The target server interprets the received
message content, extracts the relevant fields, and invokes the needed application process.

An External Services API interface that provides database backed logging with predefined schema. In
addition to attributes of the request/response message, users can select message contents by XPath.
Users can also log Java objects that have appropriate String representation. In addition, message
logging can be synchronous or asynchronous. Users can choose a destination from a pre-configured
set of data sources configured on AMC. See External Services API, page -8.
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Message Package  Package in t he Custom Adapter API. This package has components that create each type of content,
decode and encode content, stream content, define a message handler, and implement objects that are
attached to IMessageHandler. See Custom Adapter API, page -5.

Message is also an AONSCommon package that contains the following interfaces:
TAONSMessage—Interface serves as a canonical container for representing messages.

ICloseable—Interface that is implemented by classes whose instances are to be tracked in PEP
execution and closed at the end of the PEP.

IContent—Top level interface for all content types.

IContentAttachment—Interface that releases any resources held by the attachment.
IContentVisitable—Interface that accepts a content visitor.

IContentVisitor—Interface that visits IContent subtypes.

IContentSerializable—Generic generic interface for serialization of AON message context.
IDeliveryContext—Interface that holds the contextual information of an AONS message.

IEncodingConstants—Interface that handles standard encoded constants where the content is
chunked, content-encoded, transfer-encoded, or gzipped.

IMapContent—Interface that maps message content, representing data as name-value pairs.
IMessageBuilder—Interface that builds AON messages.

IMessageConstants—Interface that defines a variety of message constants remote_host, session_id,
HTTP_query_string, control message, error message, and so on.

IMessageContext—Interface that maintains the contextual information of a message.
IMessageDeliveryContext—Interface that holds contextual information of an AONS message.
IMessageHeaders—Interface that is a container for message headers.

IMIMEContext—Interface that handles MIME content.

IMsgAttachment—Interface that handles message attachments.

INullContent—Interface that represents all null content.

IRNContent—Interface that gets the signature associated with an envelope and get and set the version.
ISOAPContent—Interface that represents SOAP XML content.

IStreamContent—Interface that represents stream content.

IXMLContent—Interface that creates a container representing an XML document.

See AONSCommon, page -2 and “Message Package” in Appendix A. AONSCommon Specification
in the AON Programming Guide.
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method

MIME

Navigator

Net Package

Network filter

Node

Non-repudiation

P

package

packaging

PEP

A method is a procedure that executes when an object receives a message. Methods are associated with
classes.

Multipurpose Internet Mail Extensions specification. MIME prescribes formatting for non-ASCII
messages (for example, graphics, audio, and video files) that enables them to be transmitted over the
Internet. MIME.

MIME is also an External Services API interface that performs add, update, delete, extract operations
on MIMEContent. See External Services API, page -8.

In the ADS, the Navigator is a map of your current policy execution plan (PEP). It illustrates the portion
of the entire PEP that the PEP Developer window represents and allows you to navigate across different
parts of the entire PEP quickly and easily. This is useful when you are creating PEPs that are large and
complex because it indicates where you are in the PEP. See ADS, page -1.

AONSCommon package that defines the Date Format Cache, help to avoid unnecessary list creation,
define a multi valued map, define a map like class of strings, provide fast string utilities, provide static
utility methods for manipulating types and their string representations, assist with encoding and
decoding or HTTP URIs, handles encoding and decoding of MIME “x-www-form-urlencoded” for
either the query string of a URL or the content of a POST HTTP request. See AONSCommon, page
-2 and “Net Package” in Appendix A. AONSCommon Specification in the AON Programming Guide.

Combination of source IP, source port, destination IP, destination port, and protocol. These elements
are used by AON to filter messages and enforce policies.

A switch or router running configured to perform application-oriented networking.

For digital security, non-repudiation indicates that a transferred message has been sent and received
by the correct points.

An AONpackage is a set of software that provides a specific type of functionality. AONS is supplied
with many packages including the Log Package, Message Package, Net Package, Utilities Package,
Exception Package, and others. The ADS is used to create new packages containing all files for a
custom bladelet, adapter, schema validation, or transformation (content parser or transform) and
upload them. ADS is also used to upload packages to AMC, making them available in AON.

The ADS is used to properly aggregate (package) all the software components of a custom bladelet,
adapter, transform, or schema validation so that it can be recognized by AON. The components are
collected together into an archive file (for example, a .scar file for a custom bladelet) and subsequently
uploaded to AON.

Policy execution plan. A PEP is a sequence of bladelets that determine how a message is processed in
AON. ADS is used to create and update PEPs.
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P

PEPData Part of the Custom Bladelet API. This class is used to obtain meta information (name, ID, and so forth)
about a PEP. See Custom Bladelet API, page -6.

PEP Developer In the ADS, the PEP Developer is used to create PEPs. Bladelets are placed onto the PEP Developer
window where they can be connected to other bladelets to create the PEP. The bladelets are
represented graphically to provide an easy-to-use design environment. At any given time, multiple
PEPs can be displayed. Each PEP appears in the form of a tabbed view in the PEP Developer window.
See Bladelet, page -3 and ADS, page -1.

PEP Explorer In the ADS, the PEP Explorer (in the lower left) displays a macro-level view of the PEPs and message
types in your current ADS directory. The available PEPs in the PEP Explorer are listed so that you can
easily see your current PEP type structure. See ADS, page -1.

PEP Package AONSCommon package that contains an interface (PEPData) to generates meta information about a
PEP. See AONSCommon, page -2 and “PEP Package” in Appendix A. AONSCommon Specification
in the AON Programming Guide.

PEP Variable When a new PEP is created, the PEP Properties window pops up with fields for PEP information
including the PEP Variables, Msg_Type, Platform, Request_Message, and System. See PEP, page -12.

policy In AON, a policy is a user-defined or automatic rule or set of rules that narrowly limit specific
operations or determine exactly how they will occur. For example, a policy could determine how an
adapter connects to an external message queue.

Problems In the ADS, the Problems area is located directly under the PEP Developer window. The Problems area
displays alerts that indicate what PEP components need attention. A successful PEP depends on the
resolution of these tasks before the PEP can be synchronized to an AMC or saved as a template for future
PEP development. See ADS, page -1.

provisioning The process of sending message PEPs and polices from AMC to an AON node.

R

RAM Random access memory.

Repository In the ADS, the Repository is section on the right from which various bladelets can be dragged and
dropped onto the PEP Developer window. It display functionally similar bladelets in the same group. See
Bladelet, page -3 and ADS, page -1.

Request PEP A PEP that contains bladelets for processing request messages. See PEP, page -12 and Bladelet, page

-3.

Response Marker PEP Marker bladelet that marks a point (in a PEP) for responding to a particular action that a message
has undergone. It is a useful way to record information based on actual actions within a PEP. See
Bladelet, page -3.

Response PEP A PEP that contains bladelets for processing response messages. See PEP, page -12 and Bladelet, page
-3.

AON Administration Guide
| =



M Glossary

Retrieve Cache

Reverse proxy
caching

Round-robin

RSA

rule

SAML

sandbox

SCAR

schema package

schema validation

SDK

General purpose bladelet that retrieves data from two named caches configured on an AON node. The
named caches are “response” and “variable”. The response cache caches server responses. The variable
cache caches PEP variables. These named caches can be populated using the Cache Data bladelet. In
addition, the variable cache can be populated using the Custom Adapter API exposed to custom bladelets.
SeeBladelet, page -3.

An AON cache engine that can be used as a proxy cache or reverse proxy cache depending on the
cache placement and associated administrative domain. The device-level AMC Caching Property
screen (accessed at AMC > Properties > Application > Node and Global) is used to configure the
cache engine. This device-level screen is used with PEPs that include the CacheData and
RetrieveCache bladelets.

A policy that determines how to distribute incoming messages. This policy (in ADS, a type of
configuration group) sends messages to destinations identified on a list, one after the other. In ADS,
BalanceLoad Properties screens are used to set message distribution to round robin. See Weighted
round-robin.

Rural service (or statistical) area.

A rule prescribes how an activity will occur. In AON, you can create a variety of rules. For example,
when a PEP is constructed in ADS, a Validator rule (part of the bladelet archive file) validates user
inputs of parameter values. The rule denies invalid inputs (generally showing an error message) and
accepts valid ones. See Authorize, page -3.

Security assertion markup language. XML standard that allows a user to log on once for affiliated but
separate Web sites. See Authorize, page -3.

A sandbox is a mechanism for isolating a piece of software, an application, or an entire system from
unwanted access or inputs. The AON sandbox feature enables uses to open up various permissions by
default and restrict customizable permissions for custom bladelets. At the same time, it protects AON
by restricting certain permissions from customization.

Custom bladelet archive file. This file (.scar) contains the metadata needed to build PEPs and execute
a custom bladelet. See BAR, page -3.

A schema package includes the package name, version, vendor name, description, package properties,
and one or more schema files, XML schema (.xsd), or Document Type Definition (.dtd) files. The
schemas-info.xml file, in the package, defines metadata for schema extensions. For detailed
information, see Chapter 6. Schema Validation in the AON Programming Guide.

A way to validate incoming XML messages by comparing them with predefined schemas or DTDs.
For detailed information, see Chapter 6. Schema Validation in the AON Programming Guide.Also, see
ContentValidation, page -5.

Software development kit. You can use these kits to create custom bladelets, adapters, external service
extensions, XSLT transformations, and schema validations. See the AON Programming Guide for
more details.
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Set Destination

SHA1

Sign
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SMTP

SOAP
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SSL
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Routing bladelet that sends a message to a selected destination. This bladelet performs protocol translation
if the destination URI of the message to be sent out has to go out via an adapter that is different from the
one which received the message. See Bladelet, page -3.

An external Services API interface that gets the current service. See External Services API, page -8.

A platform and language-independent framework which enables enterprise-wide application
communications across systems

Service Oriented Architecture (SOA) is an architectural approach to integration. This architecture is
defined as a collection of standard software services, available to other applications across the
network, and accessible using a standard interface.

A set of attributes that describe a service. Each service has one profile. A profile contains multiple
named contexts. AMC screens are used to create named contexts.

The Service API is used to access a context. A supplied interface is used to obtain the attributes of a
given context from the profile. A profile is associated with an attribute domain; a context is associated
with a property set.

Routing bladelet that routes the given message to a destination based on rule evaluation. It updates the
input message's destination to be the corresponding to the first rule that evaluates to true. See Bladelet,
page -3.

Secure hash algorithm version 1.

Security bladelet that creates a digital signature on partial or entire SOAP/XML documents. This bladelet
is capable of signing non-XML and multi-part messages. See Bladelet, page -3.

An External Services API interface that signs the input XML document. See External Services API,
page -8.

Simple mail transport protocol.

Simple Object Access Protocol (SOAP) enables an application on a computer to communicate with an
application on another computer, regardless of the operating systems involved. SOAP specifies how
the contents of the HTTP header and XML file used in these communications.

Structured query language. This language is used to interact (request information, update d tables, and
so on) with databases.

Secure sockets layer. Protocol used for managing the security of a message transmission on the
Internet.
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S

Standalone Adapter A standalone adapter uses few or none of the resources provided by the adapter framework. When the

synchronization

TCP

Transform

Transparent mode

Triple DES

tunnel

standalone adapter has received enough information to transform the incoming message into an AON
message, it dispatches the AON message. A standalone adapter is well-suited to handle integration
with data sources such as databases, message-oriented middleware, and native libraries. See
Embedded Adapter, page -7.

A mechanism for bringing the AMC and ADS into component agreement. Synchronization occurs

automatically when you first start ADS. You can also manually select Synchronize on the ADS. The
synchronization process downloads PEPs (created on other ADSs) from the AMC to the current ADS.
It also uploads newly created PEPs from the current ADS to AMC, making them available for AON.

Transmission Control Protocol. Connection-oriented transport layer protocol that provides reliable
full-duplex data transmission. TCP is part of the TCP/IP protocol stack

Security bladelet that transforms AON message content. It can transform an XML message content to
an XML or Non-XML content using XSLT Based Transformation mechanism. Further, Non-XML
message content can also be transformed to XML or Non-XML message content by providing a
content parser extension. See Bladelet, page -3.

Also, an External Services API interface that defines an input source document with the given profile.
The interface is implemented by the default transformer in the AON transformation service that
provides XSL Transformation (XSLT) based transformation. An AONSTranformer object is created
by a com.cisco.aons.service.transform. AONSTransformerFactory. The caller gets an instance of a
specific transformer using the particular transformer factory object. Before this service is used, the
transform policy must be setup. See External Services API, page -8.

A deployment in which an AON node processes messages exchanged by two entities without the
knowledge of those entities. The sender and receiver of a message are configured to communicate with
each other, however, the AON node is configured to intercept the message for processing.

Triple data encryption standard. More secure version of DES. Uses three stages of encryption. Also
known as 3DES.

Tunneling is the transmission of data intended for use only within a private, usually corporate network
through a public network in such a way that the routing nodes in the public network are unaware that
the transmission is part of a private network. Tunneling is generally done by encapsulating the private
network data and protocol information within the public network transmission units so that the private
network protocol information appears to the public network as data.
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Message Handling bladelet that updates an existing AON message in the PEP. You can use the bladelet
to update the destination, content or the headers of the message. Update Message can be used to update the
payload of the incoming message or modify header information as it is forwarded on to an end-point or to
the client. See Bladelet, page -3.

A URI (Uniform Resource Identifier) is the way you identify any content in the Internet space,
whether it be a page of text, a video or sound clip, a still or animated image, or a program. The most
common form of URI is the Web page address, which is a particular form or subset of URI called a
Uniform Resource Locator (URL). A URI typically describes:

2 mechanism used to access the resource
2 gpecific computer that the resource is housed in
2 specific name of the resource (a file name) on the computer.

URL (Uniform Resource Locator) is the unique Internet address for a file. The URL contains the name
of the protocol to be used to access the file resource, a domain name that identifies a specific computer
on the Internet, and a pathname, a hierarchical description that specifies the location of a file in that
computer.

Package in the Custom Adapter API that defines a byte buffer input stream, the byte buffer output
stream, and the byte buffer array writer. See Custom Adapter API, page -5.

Also, an AONSCommon package that gets domain information and defines exceptions used by the
DomainReader. See AONSCommon, page -2 and “Utilities Package” in Appendix A. AONSCommon
Specification in the AON Programming Guide.

Package in the Custom Adapter API that has a class to pool jobs. See Custom Adapter API, page -5.

Message Handling bladelet that validates XML messages based on a schema (XSD) or DTD. The schema
referred by the XML message should have been pre-loaded into AON in an appropriate Schema Extension
package using AMC. See Bladelet, page -3.

Security bladelet that determines whether or not identities are trusted by the AON node. See Bladelet,
page -3.

Security bladelet that verifies the digital signature contained in XML/SOAP/non-XML message. See
Bladelet, page -3.

A set of AON nodes that is temporarily grouped together. All members of the virtual cluster are treated
identically in certain operations (for example, updates). You create virtual clusters in AMC.
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Web Cache Communication Protocol. WCCP. A protocol for communication between routers and Web
caches.

This policy adds weighting to specific addresses in the message distribution list. When a message is
transmitted, it is sent to a weighted address instead of the next address in the list. In ADS,
BalanceLoad Properties screens are used to set message distribution to weighted round robin. See
Round-robin.

The Web Services Description Language (WSDL) is an XML-based language used to describe the
services a business offers and to provide a way for individuals and other businesses to access those
services electronically.

Web services intermediary

WS-Security (Web Services Security) is a proposed IT industry standard that addresses security when
data is exchanged as part of a Web service.

A certificate that is compliant with the X.509 ITU-T standard for public key infrastructure.

The XML Key Management Specification (WKMS) is proposed standard from the World Wide Wed
Consortium (W3C). It specifies protocols for distributing and registering public keys.

XSLT Transformation (Transform and Content Parser) enables AON to transform a message or part
of a message to fit the requirements at the sending end, receiving end, or both. This feature can be
used to transform a XML message to HTML, non-XML to XML, and so forth.

XML (Extensible Markup Language) is a flexible way to create common information formats and
share both the format and the data on the World Wide Web, intranets, and elsewhere. XML, a formal
recommendation from the World Wide Web Consortium (W3C), is similar to the language of today's
Web pages, the Hypertext Markup Language (HTML). Both XML and HTML contain markup
symbols to describe the contents of a page or file. HTML, however, describes the content of a Web
page (mainly text and graphic images) only in terms of how it is to be displayed and interacted with.
For example, the letter “p” placed within markup tags starts a new paragraph. XML describes the

content in terms of what data is being described.

XML path language is a syntax for addressing portions of an XML document.

AONSCommon package for XPath engine processing. Contains interfaces that define a raw stream
buffer and an XPath processor. See AONSCommon, page -2 and “XPath Package” in Appendix A.
AONSCommon Specification in the AON Programming Guide.

XSLTransformation (XSLT) is a standard way to transform (change) the structure of an XML
(Extensible Markup Language) document into an XML document with a different structure. XSLT is
a recommendation of the World Wide Web Consortium (W3C).
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ZIP ZIP is a popular file compression algorithm that reduces it in size but the reverse of the algorithm will
return it to its original form without loss of data.
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